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Technical Specifications

Windows

e Windows Server 2003+ / Windows XP / Windows Vista / Windows 7/ 8/ 10
e Intemet Information Senices 5.1+
e Microsoft .NET Framework \ersion 4.5+

Linux

e Red Hat Enterprise Linux 7+ / SLES 12+ / CentOS 7+ / Fedora 21+ / Debian 8+ / Ubuntu 14+
e Apache HTTP Sener 2.4+

e Mono 3.12; 4.0 - 4.2.4 are recommended. 4.4+ are not supported.

e mod-mono 3.2.8+

e mono-basic (optional support for VB.NET)

e any basic font or font package

e SELinux is not supported

Data Sources
Database seners:

e Microsoft SQL Server 2000+
e PostgreSQL 7.1+

e Oracle Version 9i+

o MySQL 5.0+

e |IBM DB2

¢ |IBM Informix

e MongoDB

e SAP Sybase

e Apache Cassandra

o OLAP*

Database APIs:

e ODBC
e \Web Senices
o NET Assembly Methods

Files:

o XML
o Excel

Supported Browsers

o Firefox 3+

o Internet Explorer 10+ / Edge
e Google Chrome

o Apple Safari

Desktop or mobile (no additional plugins).

Types of Objects

o Database Tables

e Database Views

o Stored Procedures

e Database Functions

o Parameterized SQL Statements
e \Web Senice Methods

.NET Assembly Methods

AJAX Enabled

e .NET APl and REST Web Senice API for communication between Exago and host application

System Requirements
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Configuring IIS for Exago

Disclaimer: This document describes the baseline hardware recommended to operate Exago in a typical production
environment. These recommendations should be taken as general advice, not as strict rules. Additional users, higher
request frequency, and more complex data may increase the necessary processing power and memory. Administrators
should conduct performance benchmarks for CPU and RAM utilization in order to determine an appropriate hardware

lewel.

Minimum specifications:
Intel Xeon Multi-Core Processor, or equivalent
16GB RAM
200MB storage space
+ approx 85MB per scheduler application

+ approx 100MB per additional host application

Recommended specifications:

2 Intel Xeon Multi-Core Processors, or equivalent
64GB RAM
700MB storage space

+ approx 85MB per scheduler application

+ approx 100MB per additional host application

An additional 500MB of disk space is required to use Google Mapping.

Configuring IIS for Exago

This guide covers the IIS configuration details necessary in order to install Exago. First-time users are highly encouraged
to use this guide during their installation process. Following these steps in order will reduce the amount of

troubleshooting necessary to get Exago running.

Install Prerequisites

Install Exago

Set the Application Pool

Set Folder Paths and Permissions
Check that the Web Site is Running
Open the Admin Console

ook~

Install Prerequisites

Exago runs on Intermet Information Senvices (lIS) version 5.1 or later, and requires Microsoft .NET Framework version 4.5
or later. In addition, Exago requires the following Windows Features to be installed:

o Intemet Information Senices
o Web Management Tools
= |IS Management Console
o World Wide Web Senices
= Application Dewvelopment Features
= NET Extensibility
= ASP.NET
= |SAPI Extensions
= [SAPI Filters
= Common HTTP Features
= WebDAV Publishing

Before installing Exago, please ensure that these features are present on your system. To \erify, access the Windows
Features panel via Control Panel > Programs > Programs and Features, and click Turn Windows features on or

off.

Tech Guide
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gl Programs and Features

P——
Gl‘h)v @ + Control Panel = Programs = Programs and Features

Control Panel Home Uninstall or change a prog

view installed updates To uninstall a program, select il

@' Turn Windows features on or l:n"'f)

Organize ~

Marme -

@ pTaorrent

[H2] 7-7ip 16,02 (x64)

[0 Ace Stream Media 3.1.12.1

In the Windows Features dialog, expand Internet Information Services and ensure that the prerequisite features are
selected. If any are not installed, check the relevant boxes, press OK, then restart the sener.

These features are necessary in order for the proper Application Pools to be available.

Install Exago

At this point, Exago can be installed.

Run the installer and follow the instructions for installing the Exago Host Application.

We do not recommend installing Exago in a managed directory such as the Program Files, Windows, or Users folders.

Using one of these file paths can cause permissions conflicts.
Take note of the web site which Exago is installed, and the virtual path.

For a more detailed walkthrough, see Installing Exago on Windows.

Set the Application Pool

Next, verify that Exago is using a valid application pool.

Open IIS via Control Panel > Administrative Tools > Internet Information Services (IIS) Manager.

In the left-most Connections pane, select the Exago application.

> |
E...ﬂj ALEX-PC (Alex-PC\Administrator
[} Application Pools
B8] Sites
=43 Default Web Site
B~ | aspret_dient
[H-(F Exala¥ApiTestBed

In the right-most Actions pane, click on Advanced Settings...

Manage Application £
Browse Application

Browse *:80 (http)
Advanced[ﬁ_etﬁngs. -

= a3

In this menu, click on the [...] button to the right of the Application Pool.

B (General)
Application Poal ASP.NET v4.0
Physical Path C:\Exago\,
Physical Path Credentials
Physical Path Credentials Logon Type | ClearText

Virtual Path [Exago/
E Behavior
Enabled Protocols http

In the Select Application Pool menu, determine which of the app pools has the properties:

o .Net Framework Version: 4.0

Tech Guide
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o Pipeline mode: Integrated

Advanced Settings 7 x|
B (General)
Application | e e 7]
Physical Pat 2\
Physical Pat Application pool:
Physical Pat w0
Virtual Path )
Properties:
E Behavior

Enabled Pro Net Framework Version: 4.0
Pipeline mode: Integrated

Application

[applicationPoc oK I cancel | tion pool.

OK | Cancel |

4

Select this app pool, then press OK to close the App Pool menu, and then OK to close the Settings menu.

Next, ensure that the app pool is running. In the left-most Connections pane, select Application Pools.

¥ |
=% ALEX-PC (Alex-PC\Administrator
3 Applicatic

on Pools
= g Sites k‘
=403 Default Web Site

Check the Status column for your selected app pool.

qé! Application Pools

This page lets you view and manage the list of application pools on the server. Application pools are assodated with worker
processes, contain one or mare applications, and provide isolation among different applications.

Filter: T e Go - % Show All | Group by: Mo Grouping -

If does not say Started, select the app pool and in the right-most Actions pane, press Start.

Application Pool Tasks

B st

-~ Recyde...

Set Folder Paths and Permissions

Exago uses Temp and Reports folders to store working data and the reports file system, respectively. Create these
folders in locations suitable to your environment.

The Reports folder should not be within the Exago application directory. This could cause timeout errors while using the
application.

The Temp folder may contain sensitive report and database information. It should be in a secure location, inaccessible by
web users.

Seweral Exago folders require you to set additional permissions for the application pool user. First, determine the

user: Open IS to the Application Pools pane, and look at the app pool which is running Exago. The Identity property
indicates the application user:

9§l Application Pools

This page lets you view and manage the list of application pools on the server. Application poaols are associated with worker processes,
contain one or more applications, and provide isolation among different applications.

Filter: ~ [fco ~ (gshow Al | Groupby: Mo Grouping >

MName =

pplications

(£} ASP.NET v4.0 Classic Started  w4.0 Classic applicationPoolldentity D

L P T NP | [T S Y i

PO FRTII PR | PRI .

Tech Guide
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By default, this is set to ApplicationPoolldentity. This corresponds with the built-in user /IS_IUSRS. If this is a different
user, then set permissions for that user account instead.

The following folders require the app pool user to have read/write permissions:

o Config

e Temp
MapCache
Reports

NOTE. This process may differ slightly depending on your version of Windows.

First, right-click on the folder and select Properties.

| ApplicationThemes

J Bin
m Open I
i MapCa Open in new window
J NetHelp )
Add to archive...
) Temp
Sh ith »
| Themes are

Restore previous versions
@ Admin.: Scan Config

\"] appset]

Send to k
| eWebR
@ . " Cut
Xago Copy
@ Execute
Create shortout
\"] Precom|

Delete
¢ web.col  Rename

Properties

Open the Security tab. Then click the Edit... button.

ﬂ
General I Sharing  Security | Previous Versions I Customize I
Object name: C:\Exago“eWebReports'builds'w2016.3.0"Corfig

|:3I'0IJ|3| Qr User names:
82 Autherticated Users
2, SYSTEM

g{_ NETWORK SERVICE
B2 Administratore (Bley-PC Sdministrat o)
i

To change permissions, click Edit.

E"uu;

Permissions for Authenticated

If the application pool user is not available to select, you need to add it. Press the Add... button.

x
Security |
Object name:  C:\Bxago‘eWebRepors'builds'w2016.3.0VConfig

Group or user names:
82 Autherticated Users
42 SYSTEM
52 NETWORK SERVICE
Q?J;'-‘«dministlatnrs (Alex-PCh\Administrators)
!??J Users (Alex-PCUsers)

Md& I Remove |

Then enter the usemame in the dialog box, and press OK (the default app pool user is IIS_IUSRS).

Permizsions for Authenticated
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Select this object type:

IUsers, Groups, or Built4n securty principals

From this location:

|ﬁLEX—PC

Enter the object names to select ([examplas):

IIS_IUSRS|

Cbject Types...

Locations...

Checl Names

FiE

Advanced... | oK I Cancel

P

With the user selected, check the box for Allow Full control. Then press OK.

Security |
Object name:  C:\Bxago'eWebReports'builds w2016 3 0MCorfig

Group or user names:
.:E_:’-\.Lrlherrticated Users
n IS_IUSRS [Alex-PCHIS_IUSRS)
82 5YSTEM
Q.i_ NETWORK SERVICE
.:E_Administlatnrs {Alex-PChAdministrators)
Qi__ Users (Alex-PCh\Jzers)

Permissions for [IS_IUSRS

Full control

Modify

Read & execute
List folder contents
Read

X

Leam about access control and permissions

ok | cancel |  Appy

Repeat this process for every folder listed above.

Check that the Web Site is Running

Before starting Exago, ensure that the Web Site is running. Open IIS, and in the left-most Connections pane, locate and

select the web sener under which Exago was installed

C\Administrator]

(@] Sites
=43 Default Web Site

| aspnet_dient

5 B0

“¥ ExagoApiTestBed

Verify in the right-most Actions pane that the Start button is greyed out, and the Restart and Stop buttons are available.

If the Start button is not greyed out, press it to start the web sener.

Manage Server

% Restart

S e

B Stop

View Application Pools

Next, in the left-most Connections pane, locate and select the web site under which Exago was installed.

Tech Guide
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:’-‘:
E..

3 ALEX-PC (Alex-PC\Administrator
,;* Application Pools
E-[&] Sites
=)
B[ | aspriet_client
:‘F Exago

[+-[c¥ ExagoApiTestBed

Verify in the right-most Actions pane that the Start button is greyed out, and the Restart and Stop buttons are available.
If the Start button is not greyed out, press it to start the web site.

Manage Web Site -~
= Restart

B Stop

Open the Admin Console

You're almost done! To \erify that Exago was installed correctly, open a web browser and navigate to
http://[YourServerAddress]/[YourExagoVirtualPath)/Admin.aspx

If you see the Exago Administration Console, then your installation was successful.

In the Admin Console General Settings, set your Temp and Reports paths to the folders you previously created. Then
press OK.

Then navigate to http://[YourServerAddress]/[YourExagoVirtualPath]/ExagoHome.aspx
If you can see the Exago Ul, and you have an empty folder/reports tree, then you've set your paths correctly.

Congratulations! You've completed your first Exago installation.

Additional Notes

We highly recommend Setting up a State Sener to handle Exago sessions.

If you are experiencing problems that aren't detailed in this guide, please file a support ticket, and a representative will
be happy to help you get set up.

Application Pool Settings

When installing Exago on certain Windows configurations using .NET Framework 4.5 or higher, an additional step may
be necessary.

By default the Exago installer will create a website in Intemet Information Senvices (IIS) using the ASP .NET v4.0 app
pool. In some configurations of .NET 4.5+, this app pool may be called by a different name, such as .NET v4.5 or .NET
v4.6. In such cases, the app pool must be set manually.

Selecting the Correct App Pool

After you've installed the Exago Application, Web Senice, or Scheduler, open your lIS configuration by going to the
Control Panel, opening Administrative Tools, and opening Internet Information Services (1IS) Manager.

In the left sidebar, select the application you've just installed. Click on Advanced Settings... in the right sidebar. In
this menu, click on the [...] button next to Application Pool. In the menu that opens, determine which of the app
pools is correct by looking at the Properties box.

The correct app pool may hawe different names, but it will be using .Net Framework Version: 4.0, Pipeline Mode:
Integrated.
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Advanced Settings i 3
B (General)
Application F R —————— K
Physical Pat 2\
Physical Pat  Application pool:
Physical Pat | SR LY
Virtual Path Propes e
El Behavior
Enabled Pro .Met Framework Version: 4.0
Pipeline mode: Integrated
Application F

[applicationPoc oK I Canicel | tion poal,

Once you'\e selected the correct app pool, select 'OK' to confirm your choice.

If you cannot locate an app pool with the comrect configuration, please file a Support Ticket.

Ensuring the App Pool is Running

Once you'\e selected the correct app pool, you should ensure that it is running. In the IS Manager, select
the Application Pools page in the left column. Check the Status column next to the selected app pooal. If does not say
Started, select the app pool and click Start in the right column.

@) Application Pools - .

L =y Add Applicati

) } ) - — ) ) Set Applicatic

This page lets you view and manage the list of application pools on the server, Application pools are assodated with worker

processes, contain one or more applications, and provide isolation among different applications. Application
Filter: - [ico ~ {5k Show All | Group by: Mo Grouping . P Start
ineli i B Stop

Integrated Applicatic [Identi & Recyde...

If you are still running into issues, please file a Support Ticket.

Installing Exago on Windows

Exago runs on the web sener application Microsoft Intemet Information Senvices (IIS). The following sections walk through
the installation process for Windows based systems.

See Linux Installation or Installing Exago on Azure for altemative operating systems.

Prerequisites
See System Requirements to ensure that you have sufficient hardware to run Exago.

Before installing Exago, ensure that IIS is installed and configured correctly. See Configuring IS for Exago for details.
Please refer back to this guide for necessary configuration settings.

Installation

IMPORTANT. If you are upgrading an existing Exago installation, please ensure that the file eWebReportsManifest.txt
is present in the install directory. Otherwise, the installer will overwrite any custom config or styling you've applied.

Download the Exago installer from our Downloads page.

Run the installer as an administrator. The installation menu will appear with three downloadable applications. Click the
top icon to install the Exago Web Application, as pictured below.

Tech Guide

20 of 168



Installing Exago on Windows Tech Guide

Welcome to the Exago G)(aoo
=]

Setup Application

Follow the steps in the wizard to install Exago. You may optionally choose to install the Scheduler and the Web Senice
from this wizard.

Even though the installer has finished, Exago will most likely not function at this point. You must continue with some
additional configuration.

Create the Directory Structure

After the installation is complete, configure Exago using the following steps. (See Configuring IS for Exago for a more
detailed walkthrough).

1. Set permissions for the Config folder:
Right click on the folder named "Config" and click Properties.
In the security tab click "Edit" then "Add." Enter the IIS application pool user (default IIS_IUSRS).
In the "Permissions for Config" window select the user that was just created and select "Modify" or "Full
Control" permissions.
Repeat this process for the MapCache folder.

2. Create a folder for storing reports. This folder needs to be accessible from the web sener, but is not required to be
on the web sener. It can reside on any sener accessible by Exago via direct UNC or virtual path created in IIS.

IMPORTANT. Do not create the reports folder within the Exago application structure. Doing so will cause
ASP.NET sessions to crash when report folders are created or deleted within the Exago application.

Give the Report Folder full control privileges for the IIS application pool user. Below are three examples of report
paths to the folder \ReportsRepository:

C:\ReportsRepository — Folder is on a file system.

\\Server Name\ReportsRepository — Physical folder is on a separate sener.

IReportsRepository — Assumes an IIS virtual directory called 'ReportsRepository' has been created to point to
the folder.

3. Create a folder for storing temporary data. By default this is a sub-folder of Exago called Temp'. Howe\er it is
recommended to not use the install path's temp folder in production environments.

Give the Temp folder full control privileges for the IIS application pool user.
4. Point your browser to the Administration Console. By default this is http://<YourServer>/Exago/Admin.aspx

Specify the location of the Report Folder in the 'Report Path' setting.
Specify the location of the Temp Folder in the Temp Path' setting.

What's Next

Point your browser to the Home Page to \erify that your installation was successful. By default this
is http://<YourServer>/Exago/ExagoHome.aspx

If you encounter problems at any point, please see Installation Troubleshooting for some potential solutions. If you cannot
resolve your problem, please file a Support Ticket.

At this point you will need to set up your data sources in order to use Exago. See Administration Console Setup to get
started.

If you would like to set up Google Maps, GeoCharts, and/or any downloadable Application Themes, please see Installing
Optional Features for more information.

Resources
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o System Requirements - Baseline hardware requirements.

o Configuring IS for Exago - Necessary config details for IIS.

o Installing the Scheduler Senice - Scheduler config info.

¢ Install and Configure the Web Senice - Web senice config info.

o Installation Troubleshooting - Common install problems & their solutions.

o Administration Console Setup - Initial data sources setup guide.

o Installing Optional Features - How to set up GoogleMaps, GeoCharts, and Application Themes.

Installing Exago on Linux

The following sections walk through the installation process for Linux based systems.

(Follow this link for Windows Installation)

Supported distros

e Red Hat Enterprise Linux 7+

e SUSE Linux Enterprise Sener 12+
o CentOS 7+

e Fedora 21+

o Debian 8+

o Ubuntu 14+

Requirements

e Apache 2.4+ or Nginx

e mono 4.0+

e mod-mono (for Apache)

o mono-fastcgi-senver4 (for Nginx)
e any basic font or font package

The Exago installer can automatically download and install supported versions of mono and mod-mono. Apache or Nginx
must be installed prior to Exago.

Optional:
e mono-basic, which provides support for VB.NET

WARNING. Exago is incompatible with SELinux.
Apache

Installer Application

The Exago Linux Setup Application can be used to install the Exago Web Application, Web Senice API, and Scheduler
Senice. The installer can also install mono and mod-mono. Use the following steps to install Exago on Linux.

Navigate to the Downloads page, select a build, and then use the Linux Download option. Decompress the download.
Run installExago.sh as root. The install script can be run as a guided installation or silently with parameters.

Silent Installation with Parameters
Apache must be installed prior to installing Exago.

Usage:

[-d <install path>] [-m <TRUE|FALSE>] [-i <WEBAPP|WEBAPI |SCHEDULER>] [-y] [-h]

-d <install path> Set the install location to use

-m <TRUE'|/FALSE"> Set whether or not to install Mono

-i <\WEBAPP|WEBAPI|SCHEDULER> Set the component to install

-a <Web App Apache Alias> Default is set to /Exago’

-s <WebSenice Apache Alias> Default is set to /ExagoWebApi'

-y Do not prompt for final \erification before installing
-h Show this help screen

Guided Installation

Tech Guide
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Apache must be installed prior to installing Exago.

The installer will attempt to detect system information such as OS and Apache versions. If it cannot detect something it
will prompt for the information.

Specify an install path when prompted. If a path is not specified, the installer will default to /opt /Exago.

IMPORTANT. In order for Exago to function it is necessary to install Mono when prompted. If Mono is already installed,
this option will have no effect.

Install the Exago Web Application by entering 1 in the field.

1. Web Application
2. Web Senice API
3. Scheduler Senice

Note. It is possible to install any of these components at a later time by running installExago.sh again.

The installer will detect the Apache installation and generate a default configuration file called exago . conf in the
Apache site path.

The installer will automatically set read/write permissions for the current Apache user on the install paths.

Config - Permissions and path set automatically
Temp - Requires read and write permissions
Reports - Requires read and write permissions
MapCache - Requires read and write permissions

Folder Configuration

The Config sub-folder of the Exago installation has read and write permissions set by default and the default
path /opt/Exago/Config is preferred.

Create a folder for storing reports. This folder needs to be accessible from the web sener, but is not required to be on the
web sener. The report folder can reside on any sener accessible by Exago, provided a mount point is accessible on the
Exago sener.

IMPORTANT. Do not create the reports folder within the Exago application structure. Doing so can cause ASP.NET
sessions to crash when report folders are created or deleted within Exago.

1. Set the Report folder’s read and write permissions for the Apache user to 775.
2. Set the default ownership to the specific <apache user>:<apache group>
3. Specify the location of the Report Folder in the “Report Path” setting of the Administration Console.

The group ownership on the reports directory is not mandatory, and can be changed to have other group ownership as
needed for access outside of Exago.

Default UMASK for files written by Exago is 027 and can be changed by updating the MonoUnixUmask option in the
generated exago . conf apache configuration file.

The recommended path for the Temp folder is /opt /Exago/Temp.

1. Set the Temp folder's read and write permissions for the Apache user to 775.
2. Set the default ownership to <apache user>:root
3. Specify the location of the Temp Folder in the Temp Path setting of the Administration Console.

Set the MonitoringService folder's read and write permissions for the Apache user to 775, and set the default ownership
to <apache user>:root.

Continue the installation process in the Admin Console.
Nginx
Installer Application

The Exago Linux Setup Application can be used to configure Nginx for use with Exago.

Navigate to the Downloads page, select a build, and then use the Linux Download option. Decompress the download.
Run installExago.sh as root.

Nginx must be installed prior to installing Exago.
Usage:

<Install Dir> <Config>:<Alias> [<Config>:<Alias>]
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<Install Dir> Exago Installation Directory
<Config>:<Alias> ex. WEB:Exago, WEBSERVICE:ExagoWebApi

Nginx proxies incoming and outgoing requests to a running instance of Exago using a fastcgi module that is installed
during the installation process.

Two Exago scripts created during installation need to be started manually or configured to run automatically:

<Web App Install Dir>/bin/startExago.sh
<WebService Install Dir>/bin/startWebService.sh

The required configuration is created in a separate site file located at /etc/nginx/sites-available/exago. The
site file is not enabled by default. The location definitions for the web app and/or web senice API need to be manually
copied into an appropriate site file for the system.

Example

server {
listen 80;
listen [::]:80;
server name _;
root /var/www;

location /<Web App Alias>/ {
include /etc/nginx/fastcgi params;
root <Web App Install Dir>;
access_log /var/log/nginx/exago.log;
fastcgi param SERVER NAME Shost;
fastcgi param SCRIPT FILENAME $document root$fastcgi script name;
fastcgi param PATH INFO "";
fastcgi pass 127.0.0.1:9000;

Installing Exago on Azure

Microsoft® Azure™is a cloud infrastructure for hosting files, databases, \irtual machines, and web applications. Exago
supports various forms of integration with Azure.

Apps: The Exago core and .NET API apps can be hosted as native Azure web apps.

VM: Exago can be hosted on a Windows-based \irtual machine on Azure.

Files: Exago live data can be stored and accessed from Azure storage containers.

These methods can be implemented independent of each other. However, Web App integration and VM integration are
usually redundant with each other, and most Web App solutions should also implement Azure file storage. This guide will
walk through how to set up each of these solutions.

Web Application

Exago can run as a native Azure web application. This is necessary in order to run a custom .NET API application in
Azure. The following Azure resources are required:

P App Senice plan

App Senice (Web app)

‘ NOTE. You may require a Storage Account to run Exago as a scalable app. See File Storage for details.

This section is divided into two parts: Hosting Exago as a Web app and Using the Exago API with Azure. If you are
not implementing a custom API application, you can ignore the second part.

Hosting Exago as a Web app

NOTE. This walkthrough requires a local Exago installation. If you need to set this up, see the Exago Installation
Guide. The Exago Scheduler is currently unsupported.

In your Azure Dashboard, begin by creating a new Web app container or navigating to an existing one.

Tech Guide
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exagotestbed
WEE APP

Stopped

. exagotestbed

£ X 4 [ ] O i 4 0

Settings Tools Browse Stop Delete Get Reset
publish ... publish ...

Essentials ~ O

In the Web app, navigate to L] Setti ngs > L& Deployment credentials. Create or ensure that you've created a deployment
credential. This will allow you to FTP into your web app to transfer files.

Navigate to HH Settings > == Application settings. Set and save the following settings:
.NET Framework version: v4.0 or Later
Managed Pipeline Version: Integrated

Next, you'l need an FTP app. and are popular free apps. After running your app of choice, open a
connection with your Azure app using the deployment credential you just created.

Copy your local Exago install directory to a directory in the path "/site/wwwroot/".

] Exago Test Bed Lﬁ’ New Session |
B L [ <root=
- ) site J | I ! I

E | wwwroot Bin Config Css Images MetHelp
E| | exago
&l B | | @ O
- |y Config ) )
| Css Temp Themes Admin.aspx  appSetting... eWebRepa.

—— | ® & g ¢

), Temp ExagoHom... EwxecuteExp... Precompiled... web.config

iww | Themes

Finally, in the Web app, navigate to tH Settings > == Application settings.

Under Virtual applications and directories create a \irtual directory path for "site\wwwroot\your\exago\directory" and
check the box for Application.

Virtual applications and directories

fexago sitehwnwwroot\exago +| Application ven

Test your installation by navigating a web browser to "your/app/path/virtual/path/Admin.aspx"”.
Make sure to configure your Config file, Reports and Temp paths.

Additional configuration may be necessary depending on your individual setup. For assistance, please file a support
ticket.

Using the Exago API with Azure

Exago .NET applications must be compiled locally before being uploaded to the Azure app container. References to the
WebReports dll libraries should be updated manually, and the program recompiled, when upgrading to a new Exago
version.

Set your API constructor to use the previously set Exago virtual path:

Api myRpi = new Api (@"/exago/virtual/path");

NOTE. Exago API apps can only access virtual paths (and not URL paths). Therefore they must be located in the same
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| Web app container as the Exago host app.

File Storage

Exago can be integrated with Azure cloud storage for storage and live access to reports, templates, config, and other
data files. The following Azure resources are required:

= Storage account

1 Blob storage

The following Azure resource is optional:
Files storage

Blob storage is a "flat" file system, which stores every file at the root level. To make use of this system, Exago
emulates a directory structure using file names.

File storage is a directory-based system. Files are placed into directories, which can have sub-directories.

Reports can be stored in File storage or Blob storage. Config files, templates, themes, and temp files can only be stored
in blob storage.

In your Azure Dashboard, begin by creating a new Storage account or navigating to an existing one.

exagotest

- exagotest

" i

Settings Delete

Available Essentials ~ éf_’] AR 0

This section is divided into three parts: Config file storage, Reports storage, and Temporary files storage (which
includes themes and templates). If you are implementing Exago as a scalable app, you must set all three to static
locations.

Config File

An Exago installation contains a configuration file, usually called WebReports.xml, which tells the application where to
store Reports and Temp files.

First, in the Storage account, navigate to é:] Keys. Take down the account name and one of the two access keys.

You'll need an app which can give you direct access to the blob. The is a free web-based
app. Use the app to upload the config file xml to a container in the blob.

Now you'll need to take down your Azure Credentials Connection String.

Azure Credentials Connection String

An Azure Credentials Connection String is a formatted string which contains your Azure account name and a unique
alphanumeric key. It is used to give applications access to your storage account. The string uses the following format:

DefaultEndpointsProtocol=https;AccountName=acctName; AccountKey=encryptedalphanumerickey;

NOTE. See for more information on Azure connection strings. (This website is an
independent resource, unaffiliated with Exago Inc.).

To obtain a connection string, in your Storage account, navigate to Keys. Then press the ellipsis (...) to the right of one
of the two keys and select View Connection String:
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View connection string

DefaultEndpointsProtocol=https:AccountMame= JAccountKey
=1545/k+0O/RnqUOUDD3tmFnnmuHoKervGENIMImXX5gweljiKr2evXjxH
DMyAGNG7TTRMwt40HC3C0O5a0515zA==

Next, there are two ways which you can specify to Exago the location of the configuration file:

1. Afile in the Exago install directory called appSettings.config.
2. Ifyou're using a .NET APl app, a parameter in the API constructor method.

appSettings.config

Exago contains an xml file called appSettings.config in the root folder of the install directory. If it does not exist, create
it as a text file with the following content:

<?xml version="1.0"?2>
<appSettings>

</appSettings>

This file is used for custom app settings which are automatically imported into Web.config during runtime.

NOTE. Do not edit the Web.config file directly. It is automatically generated by Exago, and any changes to it will be
owerridden.

To set the config file location, place the following key in the appSettings.config file:

<add key="ExagoConfigPath" value="pathtype=azure;credentials='My Azure Credentials Connection Strin
4 ‘ ﬂ

credentials: Your Azure Credentials Connection String.

storagekey: The prefix of the blob container used to store the config file.

API

Exago API apps cannot access the appSettings.config file. Instead, you must use one of the following two methods to
specify a config file location:

1. Place the config key within the host application's web.config or app.config.
2. Or pass the connection string in the API constructor method:

Api myApi = new Api ("/exago/virtual/path", "WebReports.xml", "pathtype=azure;credentials='My Azure
1] ﬂ

storagekey: The prefix of the blob container used to store the config file.

WebReports.xml: The name of the config file.

Reports Storage

To use an Azure storage resource for report and folder management, input a formatted connection string in the Report
Path field in your config file.

Report Path pathtype=azure;credentials="DefaultEndpointsProtoccl=https, AccountMame=acctMame; AccountKey=encryptedalphan

‘ NOTE. This is different from (but contains) an Azure Credentials Connection String. ‘

The connection string uses the following format:

pathtype=azure;credentials="'Defaul tEndpointsProtocol=https;AccountName=acctName; AccountKey=encrypte
4 ‘ ﬂ

credentials: Your Azure Credentials Connection String.

storagekey: The prefix of the container used to store report files. Reports are stored in "storagekey-reports”, templates in
"storagek ey-templates”, and themes in "storagekey-themes". This key is optional and defaults to "wreports".

usefilestorage: If true, Reports are stored in File storage. If false, Blob storage is used. Templates and themes always
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use blob storage. This key is optional and defaults to false.

NOTE. Templates are automatically stored in blobs when the template upload button is used in Exago. Themes need to
be manually uploaded to blob storage.

Temporary Files Storage

Azure allows a Web app to be scaled up to multiple instances on separate seners. If you are implementing this
configuration, you must take the following safeguards in order to prevent loss of user data.

Each instance of Exago has its own local temp directory, whose path you can (optionally) specify in the Temp Path
setting in the config file (defaults to %INSTALLDIRY\Temp).

Temp Path lexagotemp
This is Exago's working directory — setup data for most user activity is stored and queried from here.

In a scalable configuration, initial user calls will reach one instance of Exago, storing temp files on that sener, but
subsequent calls may reach a separate instance, which will not have those temp files in its local directory. There are two
solutions to resolve this issue: Temp Cloud Service and Azure Affinity Cookie.

Temp Cloud Service

This is Exago's built-in solution for handling multiple instances. Specifying a Temp Cloud Service causes each instance
to push its temp files a shared Blob container whenever necessary. Then if a subsequent user call reaches a separate
instance, that instance will pull the relevant files from the blob to its local temp directory.

To set up an Azure storage resource for temporary files, input a formatted connection string in the Temp Cloud Service
field in your config file.

Temp Cloud Service type=azure,credentials="DefautEndpointsProtoccl=hitps; AccountM ame=accthl ame; AccountKey=encryptedalphanums:

NOTE. This is different from a Report Path string. This is different from (but contains) an Azure Credentials Connection
String.

The connection string uses the following format:

type=azure;credentials="'DefaultEndpointsProtocol=https;AccountName=acctName; AccountKey=encryptedalp
‘| | il

The Temp files container name defaults to "wtemp". Currently this cannot be changed. Temp files can only be stored in
blob storage.

Azure Affinity Cookie

WARNING. This solution is UNTESTED. You should implement Temp Cloud Senice as a backup.

NOTE. Your users must enable cookies.

Azure supports setting Affinity Cookies, which track which sener instance each user is connected to and cause all calls
within the session to reach the same instance.

In your Web app, navigate to H Settings > == Application settings. Toggle ARR Affinity to On.

ARR Affinity Off “

Virtual Machine

Exago can be hosted on a Windows-based Azure Virtual Machine. Installing Exago on a VM differs only marginally from
installing it on a local machine. Therefore, this guide will not go into depth on this method. For a full installation and setup
guide, see the Exago Installation Guide.

You can interact with a VM using either a remote desktop application or a command shell application.
Using a Remote Desktop application:

1. Using Remote Desktop Connection or another remote desktop application, view your VM as a desktop
environment.

2. Use a Web Browser to download the Exago Installer from our support site.

Run the installer as Administrator and install Exago.

4. Configure Exago (see Install and Configure).

w

Using a command shell:
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1. On alocal machine, use the abowe steps 2-4 to create a temporary Exago installation.
2. Remote into your VM using Windows PowerShell or another command shell application.
3. Copy the Exago directory to a directory on your VM.

4. Configure Windows and IIS (see Manual Application Installation).

After configuring IS, open up the Exago port using a Windows Firewall inbound exception rule. You can then access
Exago through the VM's IP address. Set up DNS and data security as desired.

Installing Optional Features

Seweral features require some additional configuration before they can be used. This may entail downloading some
additional files.

Legacy Maps (GeoCharts)

The GeoCharts feature which was present since v2013.2 has an additional requirement for use if you are enabling it for
the first time, or if you are implementing your application under a new domain name.

Our mapping features use the . Historically, this was a free solution. However, in June 2016, Google
began to require paid licenses for commercial usage.

If you had GeoCharts enabled prior to June 2016, and you have not since changed the domain name of your application,
this section does not affect you because you have been grandfathered in.

If you are a new user in need of mapping, we strongly suggest implementing the new Google Maps feature instead of
GeoCharts.

If you intend to implement GeoCharts under a new domain name, then you must acquire a Google Maps API License in
order to use this feature. See for details. Your license must include the Google Maps Javascript API.

For help with API keys, see

To install your license file, place your license key in the following setting in the Admin Console:

( Feature/Ul Settings Geochart Map Key ) <geochartmapkey>

Google Maps
There are additional steps needed in order to enable the new Google Maps Wizard introduced in v2016.3.

First, you need to download and install a polygon file. This is a free download located on our support site. The file is
named 'MapPolygonDataBase.sqlite’. Once you've obtained this file, place it in the following location in your install path (if
the folder does not exist, create it):

"Application root"\MapCache
Next, if you're using Windows, you must give the IIS instance user full control permissions for this folder.

¢ Right click on the folder and click Properties.
o In the security tab click “Edit” then “Add."
o Enter “iis_iusrs’ then click “Ok.”
o In the “Pemissions for Config” window select the IIS_IUSRS that was just created and check the box for Allow
Full Control. Then click “Ok.”

If you're using Linux, you must give the Apache instance user read and write permissions for this folder.

chown S$apacheUserID MapCache
chmod -R utwr MapCache

The new wizard uses the , Which requires a paid license for commercial use. You must acquire a
Google Maps API License in order to enable this feature. See for details. Your license must include the
Google Maps Javascript APl and the Google Maps Geocoding API.

For help with API keys, see

To install your license file, first toggle the following setting to True:
( Feature/Ul Settings Show Google Maps Wizard ) <showgooglemapwizard>
Then place your license key in the following setting in the Admin Console:

( Feature/Ul Settings Google Map Key ) <googlemapkey>
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Application Themes

Application themes are customizations that change the look of the Exago UIl. App themes are applied for all users of the
application. These are not included in the installer, and must instead be downloaded from our support site. All app
themes can be fully customized using CSS and image editing. We will periodically introduce new ones ower time.

App themes are provided as compressed folders. To add an app theme to Exago, uncompress the folder into the following
location in your install path:

"Application root"\ApplicationThemes
There should be separate folders for each app theme (the default is "Basic").
Then, use the Admin Console to select the app theme from the following dropdown:

( Feature/Ul Settings Application Theme Selection ) <csstheme>

Install and Configure the Web Service

Web Services API

Use the following steps to install the Web Senice API on Windows:

o Download the latest Windows or Linux installers here.
o Make sure your antivirus software is disabled and run the installation wizard as an Administrator.

For Windows

o Click the Web Senvice button.

e Click Next to bring up the ‘Select Installation Location” menu.

¢ In this menu specify the web site, virtual directory and physical directory where you want Exago installed. Click
Next.

NOTE. The Web Senice API must be installed on the same server and web site as the Exago Application.

e Confirm your location selections by clicking Next.
o Monitor the installation and click Finish when it is complete.

For Linux

e Run " installExago.sh " as root.
o Enter 2 for the Web Senices API

NOTE. If you elect to install the Web Senice API the installer will create the sub directory "WebServiceApi* in your
previously specified install path.

o Follow the prompts

Configuring Web Services API

To configure the Web Senice API edit the file ‘WebReportsApi.xml” which is located in the Config sub-folder where the
Web Senice APl is installed. The location of the Config sub-folder is determined when the Web Senice APl is installed.
Set the following items:

o apppath — file path to the Exago web application. E.g. "C:\Exago"

o throwexceptiononerror — set to true if you want to catch exceptions in your application thrown by Exago.

o writelog — set to true to write a log file (WebReportsApiLog.txt in the Config sub-folder) of any exceptions thrown.
Write permissions for the Config sub-folder must be given to the ASP.NET user.

Installing the Scheduler Service

The version and build number of the Scheduler Senice must match that of the Web Application.

You may hawe different installations of Exago with different versions/builds on separate seners. The Scheduler Senice
installation wizard allows you to install multiple Schedulers to maintain corresponding version/builds with the Web
Application.

Use the following steps to install the Scheduler Senice on Windows:

e Download the latest Windows or Linux installers here.
o Make sure your antivirus is software disabled and run the installation wizard as an Administrator.
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For Windows

o Click the Scheduler button.

o Click Next to bring up the ‘Select Installation Location” menu.

o Specify if you want to create a new senice or if you want to update an existing one.

o To create a new senice set a name and location.

o Select to who the Exago Scheduler Windows Senice will be installed. By default, “Everyone” is selected. Click
Next.

o Confirm your location selections by clicking Next

o Monitor the installation and click Finish when it is complete.

As of version 2016.2. 12, schedulers take system resources into account when assigning remote execution jobs. This
requires that the senices have read access to the system registry.

This can be done by adding the senices to the Performance Monitor Users group.

See (MSDN) for details.

For Linux

e Run " installExago.sh " as root.
e Enter 3 for the Scheduler Senice

If you elect to install the Scheduler Senice, the installer will create the sub directory "Scheduler™ in your previously
specified install path.

o Follow the prompts

To configure the Scheduler Senice, continue to this article.

Saving Schedules to a Repository

About this Guide

This guide will walk administrators through the process of saving schedules to a repository rather than emailing them
Initial Setup
Set a Report Path

Navigate to the scheduler install path and locate a configuration file called “"eWebReportsScheduler.xml".

Note: This xml must be configured properly before the scheduler senice will function. For more on configuring your
scheduler see configuring the Scheduler

(working_directory>[INSTALLDIR]working(fworking_directory>
<defaalt_job_timeout>3SUD</defaalt_job_timeout>
<sleep time>15</sleep time>
<simultanecus_job max>l</simultaneous_job max>
<loggingron</logging>
<flush time>-1</flush time>
<5ync_flash_time>0<f5ync_flu5h_time>
<email addendum></email addendum>
<external interface»</external interface>
I <report path>C:\Reports\schdunled report repo=sitory</report path> I
<abend_upon_repoIt_errDr>true<fabend_apon_report_error>
<ip_address»</ip address>
<encrypt_schedule files»false</encrypt_ schedule files>
(max_tenp_file_age>144D<!max_tenp_file_age>
<emai1_Ietry_time>1U<femail_retry_time>
-</elebReportSchedulers

In the eWebReportsScheduler.xml file set a repository for the "report Path" parameter.

For this example, a local directory is set

After configuring the scheduler navigate to the admin console.
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Parameter Value

Scheduler Settings

Enable Report Scheduling False ~

Show Report Scheduling Option False v

Show Email Report Options False »

Show Schedule Reports Manager False v

Show Schedule No End Date Option True »

Show Schedule Intraday Recurrence Option True hd
Scheduler Manager User View Level Current User v
Email Scheduled Reports N False » |
Show Schedule Delivery Type Options i False »

Schedule Remoting Host

Enable Remote Report Execution False -
Enable Access to Data Sources Remotely False ~
Remote Execution Remoting Host

Custom Cueue Service

Delete Schedules upon Report Deletion False ~
Default Email Subject

Default Email Body

Password Requirements (for pdf and excel decuments)

Custom Scheduler Recipient Window

In the Admin Console set the "Email Scheduled Reports' parameter is set to False.

Note: Enabling "Show Schedule Delivery Options™ will allow users to select per scheduler whether to send the report to
a repository or to email it.

From here, schedule a report and instead of receiving it as an email the output will be saved to the set directory.

For more on scheduling reports see our scheduling a report guide.

Installation Troubleshooting

These are some common issues that may arise during an installation of Exago and some solutions for resolving them. If
you are encountering problems that are not listed below, please file a support ticket.

e An error has occurred. Please contact your administrator.

e HTTP Error 500.19 - Intemal Server Error

e HTTP Error 403.14 - Forbidden

o ERR CONNECTION_REFUSED

e Ermor: Access to the path 'C:\[Exago]\Config\WebReports.xml' is denied.

o Object reference not set to an instance of an object.

e Exception occured configuring logdnet: Access to the path 'C:\[Exago]\Temp' is denied.
o Folder or Virtual Directory not found: path=[path], mappedPath=[path]

e Ermor saving report. Please contact your administrator.

e Session has timed out; browser page will need to be reloaded or browser restarted

An error has occurred. Please contact your administrator.

Append "?ShowErrorDetail=true" to the end of the URL, and try to replicate the behavior which caused the error. This will
allow you to identify the error in more detail and search for a solution.

HTTP Error 500.19 - Internal Server Error
The configuration section 'standardEndpoints' cannot be read because it is missing a section declaration.
Most likely problem: Incorrect or missing Application Pool.

Solution: Select the correct Application Pool.

HTTP Error 403.14 - Forbidden

The Web server is configured to not list the contents of this directory.
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Most likely problem: You're connecting to "http://[Exago]/" without specifying the home page or admin console.

Solution: Connect to "http://[Exago]/Admin.aspx" or "http://[Exago]/ExagoHome.aspx". OR set the IIS Default Document
to "ExagoHome.aspx".

ERR_CONNECTION_REFUSED
Unable to connect.
Most likely problem: The Exago server or website is not running or the port is not open.

Solution: Restart the sener and website. AND/OR add a firewall rule for the inbound http port.

Error: Access to the path 'C:\[Exago]\Config\WebReports.xml' is denied.
Most likely problem: Permissions are not set on the config folder.

Solution: Set the lIS user permissions to Full Control on the config folder.

Object reference not set to an instance of an object.
Most likely problem: Config file is missing or corrupt, or permissions are not set on the config folder.

Solution: Load the Admin console to generate a blank config file. If you continue to encounter the error, set the IIS user
permissions to Full Control on the config folder.

Exception occured configuring logdnet: Access to the path 'C:\[Exago]\Temp' is denied.
Most likely problem: Permissions are not set on the temp folder.

Solution: Set the lIS user permissions to Full Control on the temp folder.

Folder or Virtual Directory not found: path=[path], mappedPath=[path]
Most likely problem: Report folder path is wrong or permissions are not set on the report folder.

Solution: Verify the report path is set correctly in the Admin Console. Set the lIS user permissions to Full Control on the
report folder.

Error saving report. Please contact your administrator.
Most likely problem: Permissions are not set on the report folder.

Solution: Set the IS user permissions to Full Control on the report folder.

Session has timed out; browser page will need to be reloaded or browser restarted
Most likely problem: Exago is dropping sessions or web sener is restarting unexpectedly.

Solution: Make sure the reports folder is located outside the Exago filesystem. You may need to configure a state
senice. Check for any disruptions in your web sener's uptime.

My error is not listed above.

Please file a support ticket.

Administration Console Setup

Configuring the database metadata can be done within the Exago Administration Console. These bullets detail the terms
used in Exago that are consistently referred to in both the guides and the application.

o Data Source refers to a database or similar programmable file.
e Tables, views, functions, and procedures are stored as Data Objects (also called Entities) within Exago which
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can then be connected using Joins.
o Exago can automatically discover metadata from traditional databases (MsSQL, MySQL, etc.)

Data Sources
Add a data source by entering the Administration console http://<YourServer>/Exago/Admin.aspx

e In the Main Menu click the Data dropdown and select Sources.

Add a Data Source by clicking the Add button (+ )-

Give the source a name in the Name row.

Select the intended type of data source in the Type row. In addition to traditional db’s, Exago can consume data
from OBDC sources, Web senices, and .NET assembly files.

In the next row enter the Connection String. Connection strings vary according to database and data connector.
.NET assemblies, web senices, and files use the following connection strings:

Assemblies - Assembly=C:\PATH\DLL NAME.dll;class=ASSEMBLYNAME.NAMESPACE
Web Senices - ur=http://HOS TNAME/PATH/SERVICENAME.asmx?OPTIONALPARAM=VALUE
Files - File=C:\PATH\FILENAME; Type=FILETYPE where FILETYPE is 'excel', 'xml', or 'excelXml'.

» Verify the connection to the database using the green check, if the source is through a connection string or non-
RDBMS data source.
e Click OK to sawe these changes.

Building Metadata

Multiple Data Objects and joins can be created at once via Exago’s automated Discover Database Metadata function.

¢ In the Admin Console (http://<YourServer> /[Exago/Admin.aspx), select the desired Data Source to build
metadata.

Discover ObjectUoin Metadata
Add
Edit

X = + 0

Delete

Click either the Discover Database Metadata icon( Q ) or right click the source name and select Discover
Object/Join Metadata, as shown on left.

o The fields that appear with checkboxes associated to them (Tables, Views, Functions, Procedures, etc.)
represent all the Data Objects.

NOTE. ltems with a (&) next to their checkbox, are incomplete items.

e To add this metadata to the existing setup, use the Select All Objects button, Select Complete Objects button,
or manually check the desired items. Examples of these options are below.

Select All Complete Objects Select All Objects Clear Selections

Add Objects Add Objects and Joins Preview Only

o Finalize the selections with the Add Objects or Add Objects and Joins options.

NOTE. Incomplete items that are added to the Data Source will require completion of the fields before adding them.
If the data source does not have the metadata set, it is possible to complete this process manually, explained in
Manually Creating and Adjusting Metadata.
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Verifying the Report Path

¢ In the Main Menu open the General drop-down and double click Main Settings. The first parameter in Main
Settings is the Report Path.
o Make sure that the Report Path is pointing to the folder where read/write permissions were set earlier.

NOTE. If this step isn't complete, see Manually Creating and Adjusting Metadata.

e Check this connection by clicking the green checkmark.

* General
Parameter Value

Main Settings
Report Path C\Reports
Temp Path

Temp Cloud Senvice

Language File £n-us, en-us-getting-started, en-us-tooltips

Temp URL

Allow direct access to Exago (bypassing API) True ~

Allow Execution in Viewer True -

Allowed Export Types | Excel #| PDF ¥ RTF | C3V
Default Output Type POF v

Scheduler Configuration

To configure the Scheduler Senice AP, edit the file WebReportsScheduler.xml in the folder where the scheduler
senice was installed.

The following settings are available:

NOTE. Settings that can be true or false are case sensitive and should use lower case. Ex. encrypt_schedule files

will cause an error for True.

smtp server — The smtp server used to email reports.

smtp_enable ssl - Set to true to enable SSL.

smtp user id-The user id that is used to login into the smtp sener.

smtp_ password - The password that is used to login into the smtp sener.

smtp_from - The 'From' email address used in the report emails.

smtp from name - The 'From' name used in the report emails.

error_report_to - The email address to send error reports to.

channel type - tcp or http —must match the setting of the Remote Host in the Scheduler Settings admin config.

port - The port number of the .NET remoting object used to communicate with Exago; this should also be entered in the
Scheduler Settings of the admin config.

working directory - The directory where scheduled documents and temporary files are written. The default setting
[INSTALLDIR]working creates a working folder in the scheduler location.

default job timeout - The maximum number of seconds any report execution is allowed. If an execution reaches a
maximum number of seconds an email will be sent to the address specified under error report to.

report_path - A path to specify where to save reports when 'Email Scheduled Reports' is set to False in the admin
config. For more details see Saving Scheduled Reports to External Repository.

sleep time - The time intenval (in seconds) used for polling for scheduled reports to execute.

simultaneous_Jjob max - The maximum number of report executions that can occur simultaneously. This setting is
based on the resources available of the sener where the scheduler is installed.

logging - Logging is on by default. To tum logging off, set to OFF (in all-caps). To configure logging, edit the Logging
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Settings in the eWebReportsScheduler.exe.config file.

flush_ time - The number of hours that a completed, deleted, or aborted job will be saved for viewing in the schedule
reports manager. Set to 0 to flush jobs immediately upon completion. Set to -1 to disable automatic flushing.

sync_flush_time - The flush time for synchronous (non-scheduled remote) jobs.
email addendum - Text that will be added at the end of email body. Use \n to insert lines.

external interface - This is optional and overrides the value set in the admin config. The advantage of setting the
value here is that the existing scheduled reports that have a previous external interface value will take the new value. For
more details see External Interface.

abend upon_report error - This controls how the scheduling senice should proceed if an error occurs while loading
or executing a report. The default true will stop the running the schedule and set the status to 'Abended'. Set to False
to continue running the schedule and maintain the status as 'Ready".

ip address - Binding IP address for the Scheduling Senice. Most commonly used when the sener has multiple
Network Interface Cards (NICs).

encrypt schedule files - Set to true to encrypt the files created by the scheduling senvice. All existing
schedules will be encrypted the next time the senice is started.

max_temp file age - The number of minutes between each "flush” of the temp files created by the scheduling
senice. The default is 1440 minutes (24 hours).

NOTE. Making this value too low may result in errors as temp files are used during report execution and for interactive
HTML capabilities when using remote execution. It is not recommended setting this value any lower than 60 minutes.

email retry time -Inthe case an email fails to send, the number of minutes to wait before retrying to send the
email. After five failed attempts the schedule will set itself to 'Aborted'. The default is 10 minutes.

max_job execution minutes (v20716.2.12+)- Maximum amount of time (in minutes) to run an execution job before
timing out. If the job times out, the schedule will be marked as 'Aborted'.

secure channel (v2016.3+)- Set to true to allow receipt of encrypted data from hosts. The setting Use Secure
Scheduler Remoting Channel must be true in the admin config.

security protocol (v2016.3.4+) - Specify which security protocol(s) the scheduler should use. Possible
values: Ss13, Tls, Tlsll, Tlsl2, T1s13 (.NET v4.6+). Separate multiple values with commas (,).

service name tag - For manual installation of scheduler senices using Visual Studio , this field is
appended to the end of the senice name. Useful for installing multiple senices on the same sener. installutil.exe must be
in the same folder as the scheduler configuration file.

Starting and Changing Scheduler Services

The Windows Senice will have to be manually started for new installations of the Scheduler. Starting the senice will
create the working directory as set in working directory described above.

To start the scheduler open Windows Senvices. Double click on 'ExagoScheduler' and the Properties menu will appear.
Click Start.

If any changes are made to the configuration (detailed abowe) the senice must be stopped and restarted for the changes
to take effect.

Scheduler Queue

The 2016 release of Exago introduces a new powerful feature to the Report Scheduler: The Scheduler Queue. The
Queue is a custom-built application library that sits in between the Exago core application and any number of scheduler
instances and handles how schedule traffic is managed. The Queue is completely optional, but configurations with
multiple scheduler instances for which load balancing is a priority are ideally suited to making use of this feature.

Background

First, some background. The way in which Exago has historically handled report scheduling, and the default behavior
without using a queue, is the following.

NOTE. For this discussion, it's important to define some terms:

A Schedule is a term for all of the information that is set when creating a schedule in the Schedule Manager. This
information is usually stored as an xml file in a repository. Schedules can be accessed from the API using the
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ReportSchedule class.

Each Schedule contains some interpreted data that tells the schedulers when to run it. This information is called a Job.
Jobs can also be stored separately from schedules. Jobs can be accessed from the API using the QueueApiJob class.

The process whereby a scheduler runs a report at a specified time and emails or saves the information is called an
Execution.

Within the host application, all scheduler instances are listed in the configuration xml file:

| Schedule Remeting Host tepo/ischedulerHest1: 2001, tepiischedulerHost2:2001, tepi/schedulerHost3:2001

When a schedule is created in the Ul, the host application sends the job to schedulers starting with the first and moving
down the list ("round-robin" style). The queried scheduler stores the schedule xml in a local working directory. This acts
as a repository for the scheduler's unique set of jobs.

From this point, each scheduler acts independently. The host application has no idea what happens to schedules after
they are sent out successfully. Likewise, the schedulers have no more communication with the host application with
regard to report execution.

A word about the Schedule Manager: You can view and edit schedules from the Ul using the schedule manager, but
this is essentially a combined front-end for the schedulers' existing files. If a scheduler is offline you will simply not see
its schedules in the list (there will be a waming message). The schedule manager has no impact on the host
application.

Schedulers periodically scan their repository for job execute times. If a job is ready and the current time is equal to or
past the execute time, the scheduler knows to run the job. The scheduler will perform its duty and then alter the schedule
xml to indicate success or failure and the next execute time.

This default behavior may be adequate for most cases, but there can be issues. In particular, the scheduler queue sets
out to solve the following two issues that can arise in default configurations: Load Balancing and Unexpected
Outages.

Load Balancing issues: Ideally, unoccupied schedulers would receive new jobs. This way stacks of unexecuted data do
not build up on individual schedulers, leading to imbalanced load and potential time loss. But the host application has no
idea which schedulers will be busy when, and no idea how long jobs will take to run. The randomness of round-robin job
assignment could cause jobs to build up inordinately on one scheduler.

Outages: Once the host sends out a schedule, as far as it's concemed, it's finished. If a scheduler goes offline
unexpectedly the host has no recovery function. The job will simply be delayed until the scheduler is restarted, which, to
some extent, defeats the purpose of running jobs on a schedule. There is also no function to move schedules from one
scheduler to another.

How the Queue Works

The Scheduler Queue is a custom .NET or Web Senice library which aims to handle scheduling in a much more robust
manner. It's important to note that the queue is entirely customizable. You are only required to implement all the
applicable methods; how you do so is up to you. The following section will describe a typical setup which can improve
load balancing and help resolve some common issues with multiple schedulers. Later on, we provide a pre-built Example
that can be used as-is with minimal modifications, or altered as you see fit.

The queue sits in between the Exago host application and any number of scheduler senices and handles logic for all
scheduler requests and maintenance.
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The host and scheduler applications all make calls to the queue at certain points during their runtime. In particular,
schedulers will call the queue on three occasions: upon senice startup, periodically while running, and when a job's
status is changed. The host application calls the queue for various maintenance tasks related to schedule creation and
populating the Schedule Manager. For now, we'll focus on the relationship of schedulers to the queue and how it can aid
a typical multi-scheduler configuration.

When schedulers are configured to use the queue, their behavior changes somewhat.

Recall that in the default configuration, schedulers store their unique schedules in a local working directory, from which
jobs are queried for execution.

Now, schedulers periodically query the queue, which has instructions (GetNextExecuteJob) for assigning jobs. (The
query time defaults to 15 seconds, but is configurable). In a typical setup, the queue pulls from a central repository of
stored schedules. In order to prevent duplication, schedulers lock the queue so that only one may access it at a time.
Additionally the queue sets a job's status to "running” while it's active, so that other schedulers know to ignore it. (The
provided Example also saves a temporary file in the job repository to indicate which scheduler is handling a running job).

NOTE. Schedulers still use a local working directory for temporary files.

This has seweral advantages. First, schedulers are no longer responsible for a unique set of schedules. This prevents
outages from causing excessive missed executes. Only one job will ever be hung per scheduler, since a scheduler will be
responsible for only one job at a time. If a scheduler goes offline in the middle of a job, the queue can be used to
gracefully handle incomplete jobs (this is not present in the provided Example).

Next, jobs are now distributed much more evenly between the schedulers. We no longer have the problem where, due to
their independence, schedulers will build up excessive numbers of jobs. Jobs will only be assigned to available
schedulers.

Finally, since this allows us to control what data is being sent and received to the schedulers and the file system, we
could implement any custom load balancing solution we wanted.

Getting Set Up

Setting up the queue is a multi-part process which depends on your desired configuration. We'll discuss some constants
and some potential variations.

First we need to write the scheduler queue. This is discussed in more detail in the Example section. This can be a .NET
assembly or a web senice, and it can be part of another library. All the following methods must be implemented in the
queue interface:

public static string[] GetJoblList (string viewlLevel, string companyld, string userId)

Called from the Exago Ul to populate the jobs in the Schedule Manager.

public static string GetJobData (string jobId)

Called from the Exago Ul Schedule Manager to get the full job XML data for a job.
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public static void DeleteReport (string reportId)

Called from the Exago Ul when a report is deleted.

public static void RenameReport (string reportId, string reportName)
Called from the Exago Ul when a report is renamed.

public static void UpdateReport (string reportId, string reportXml)

Called from the Exago Ul when a report is updated.

public static void Flush(string viewLevel, string companyId, string userId)
Called from the Exago Ul Scheduler Manager in response to a click on the Flush button.
public static void Start (string serviceName)

Called from scheduler senices to indicate when a specific senice starts.

public static string GetNextExecuteJob (string serviceName)

Called from the scheduler senices to return the next job to execute.

public static void SaveJob (string jobXml)

Called from both the scheduler senices and the Exago Ul to save the job. This method is called when a schedule is
added, updated, completed, killed, etc.

The QueueApi and QueueApiJob helper classes have been added to the Api to facilitate writing the queue. Youl'l need
to reference the WebReports.Api.Scheduler namespace. QueueApiJob wraps a Job object and a variety of useful
methods for managing jobs. The QueueApiJob class will be used extensiwely in the following example.

The host application config and each scheduler config must contain the path to the scheduler queue assembly or web
senice class in the following format:

Assembly=Path\To\Assembly.dll;class=Namespace.Class

You can set the path in the host app by using the Admin Console and setting the following field in the Scheduler
Settings:

| Custom Queue Service Assembly=Path\To\Assembly dil.class=Scheduler SchedulerQueusClass

Or by setting the field <schedulerqueueservice> in the config file,

Or by setting the field Api.SetupData.General.SchedulerQueueService \ia the API at runtime.
In each scheduler application, set the field <queue_service> in the scheduler config file.

Next, determine how you'll be accessing your schedules. A common solution uses a database to optimize lookup speed.
The queue only needs to know the Job ID (filename), Next Execute Time, and the Running status to determine which
schedules to run.

Job ID Next Execute Time Running?

String DateTime Boolean

If you're using folder management, you can implement the those methods in the queue assembly (see Report and
Folder Storage/Management for more information).

Examples

We provide the following two examples for reference.

Basic Example

The first is a basic example designed to showcase how the Scheduler Queue works. It is not suited for use in
a production environment. However, it can be quickly compiled and used for testing, with minimal setup.

This example uses a directory for schedule storage and fully implements the Schedule Manager. It supports unlimited
scheduler senices, and implements simple versions of load balancing and error recovery.
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Download the example here. To compile, set the QueueDirectory global variable, rename the file with a .cs extension,
and add it to a Visual Studio project.

Production Example

The second example, generously provided by , is a full-fledged production-ready implementation of the
Scheduler Queue. This demonstrates how the Scheduler Queue can use a database for schedule storage, which has
significant performance advantages over using a file system.

This Queue generates schedule data dynamically and on-the-fly, implements advanced tenanting, and uses a Sener
Event to implement custom emailing behavior. Note that temporary execution files must still be written to the file system.

Download the example here. This example will require significant customization for your environment.

This code was originally created by Dawe Killough and SofterWare, Inc. SofterWare has released it for Exago customer
use in August 2017.

THE SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING
BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE
AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS, ORIGINAL COPYRIGHT HOLDERS,
OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE
USE OR OTHER DEALINGS IN THE SOFTWARE.

User Identification

Exago does not hawve native user authentication. User logins must be handled in a security layer in the embedding
application. After a user logs in, the application should pass identification parameters to the Exago API, which you can
use to set permissions.

userld and companyld

Exago has two built-in parameters which are used to store identifying information: userld and companyld. These
parameters are used in conjunction with the Schedule Manager and User Preferences, and they are automatically passed
to any extensions which may need to access authentication. Folder Management, External Interface, Scheduler Queue,
and any extension which can access sessioninfo (such as Assembly Data Sources or Sener Events) can retrieve these
parameters in relevant methods.

Often userld corresponds with a unique user or log-in, and companyld represents a group of users with shared
characteristics. Either parameter can be used without the other.

Setting the current user

The Id parameters are not instantiated by default, and must be created before use. They can be created in the Admin
console, config file, or in the API code. They must be created with the exact names of "userld" and "companyld" (which
are case sensitive), with data type "string". Since the values are set in the API, if you create the parameters in the Admin
Console or config, they should have blank default values.

Admin Console

As created in the Admin Console:

userld

Mame userld

Type string ~

Value

Hidden True -

Prompt Text

Parameter Dropdown Object - v oa X
companyld

MName companyld

Type string -

Value

Hidden True ~

Prompt Text

Parameter Dropdown Object - v oal X
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Config File
As created in the config file:

<parameter>

<id>userId</id>

<data type>string</data type>
<value />
<hidden>True</hidden>

<prompt text />

</parameter>

<parameter>

<id>companyId</id>

<data type>string</data type>
<value />
<hidden>True</hidden>

<prompt text />

</parameter>

.NET API

As created in the .NET API:

NOTE. "DataType" defaults to DataType.String, so the call is omitted.

Parameter userId = api.Parameters.NewParameter () ;
userId.Id = "userId";

userId.Value = "user 224";
Parameter companyld = api.Parameters.NewParameter () ;

companyld.Id = "companyId";
companyId.Value = "company 17";

REST API

As created in the REST API:

NOTE. "DataType" defaults to "String", so the call is omitted.

POST /parameters
{
"Id": "userId",
"Value": "user 224"
}
POST /parameters
{

"Id": "companyId",
"Value": "company 17"

Basic sandboxing

Setting the userld and companyld parameters has seweral effects in the Exago interface.

Schedule Manager

By default, the schedule manager will show only schedules belonging to the current userld. This can be changed by

modifying the following Admin Console setting:

( Scheduler Settings Scheduler Manager User View Lewel ) <schedulemanagerviewlevel>

e Current User (‘User'): Filters schedules by current userld parameter.
o All Users in Current Company (‘Company): Filters schedules by current companyld parameter.

o All Users in All Companies (‘All': No filtering.

This setting can also be overridden by a Role.
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Execution Cache

The userld and companyld parameters are used to set permissions for which users can view cached report data. Users
can choose whether a report cache is visible just for their userld, for everyone with the same companyld, or for all users.
The options that are available to a user depends on that user's Scheduler Manager User View Lewel setting.

User Preferences

User preferences, including Startup Reports and User Reports (live report customization), are set by userld, and will only
apply to that user.

Advanced permissions

userld and companyld can be used in many other application areas in order to handle security permissions.

Roles

Additional permissions are typically handled by Roles. A check can be made in the API which maps the current userld
and/or companyld to the role which it belongs. This must be handled manually via a lookup table or a similar data
structure. Then activate the role for the session.

.NET: api.Roles.GetRole("admin").Activate();
REST: PATCH /REST/Roles/admin?sid={sid} { "IsActive": true }

For more information, see Roles.

Tenanting
userld and companyld can be used as tenant parameters in your data objects.

If your data is set up such that each table, view and stored procedure has columns that indicate which user has access
to each row, then you can use userld and/or companyld to match these columns and act as data row filters. (For this
purpose, the parameters cannot be set to 'hidden’).

For more information, see Multi-Tenant Environment Integration.

Accessing lds in extensions

userld and companyld are passed to any custom extensions where relevant. For example, in an extemal interface
assembly, you may wish to access the userld in order to log user executions. You could do so by implementing the
ReportExecuteStart method, which passes the userld parameter.

public static void ReportExecuteStart (string companyId, string userId, string reportName)
{
string logText = string.Format ("{0}: Report '{1l}' executed by user '{2}'.", DateTime.Now, reportN

File.AppendAllText (logFile, logText + Environment.NewLine);
}

1] Atj

This would returmn the following text upon a report execution by userld "Alex":

‘ 2017-03-07 14:50:49: Report Test\Product Sales Report' executed by user 'Alex. ‘

Most extensions have methods which can access userld and companyld. In addition, the parameters are accessible
through sessioninfo. So any extensions which can access sessionInfo can also access userld and companyld, even if
methods do not explicitly implement them.

The following sener event automatically adds the userld to the description text whenever a report is saved.

Global Event Type: OnReportSaweStart, References: WebReports.Api.Reports

Report report = sessionInfo.Report;
string userId = sessionInfo.UserId;

if (!report.Description.EndsWith (userId)) { report.Description += ("\n" + userId); }

return null;
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Report execution can be balanced across seners to improve performance. As one execution is being processed
subsequent report execution calls will be sent to different seners. For each new job, Exago will prioritize the sener with
the lowest load (according to CPU and memory load) and ratio of running jobs to max jobs allowed. The number of jobs
on a sener will not exceed the value specified by the simultaneous_jobs_max setting.

NOTE. In versions prior to v2016.2.12, machine load is not taken into account, and jobs are sent to different seners in
the order that they are specified ("round-robin").

The following instructions provide an oveniew for setting up report execution on remote seners:
On each remote server:

o Install the Exago Scheduler Senice. For detailed instructions see: Scheduler Service Installation.
o The following conditions must be met:
o The Scheduler version must match the Exago Application version.
o The Scheduler’s language files and the Exago Application’s language files must match.
o Any custom assemblies must be present in the Scheduler directory.
o Configure the Exago Scheduler. For detailed instructions see: Configuring Scheduler Services.
o By default the execution host will pass the reports back to the Exago Application. In order to save reports
to an extemal repository, see: Saving Scheduled Reports to External Repository.

NOTE. Multiple scheduler senices can point to the same repository.

In the Exago Application:

1. Using the Admin Console, open the Scheduler Settings
o Set ‘Enable Remote Report Execution’ to True in the Report Scheduling Settings.
o In ‘Remote Execution Remoting Host’ list the senvers you want to use delineated by commas or
semicolons (ex. http://MyHttpSenver1:2001, tcp://MyTcpSener:2121). The senvers will be prioritized based
on the listed order.

NOTE. When multiple remote execution hosts are enabled, the Exago application will prioritize the one with the lowest
number of queued jobs.

NOTE. When an execution host is used for both scheduling and remote execution, the Exago application will place
immediate priority on Remote Execution tasks.

Set Up Exago in a Web Farm

One method for running Exago in a distributed environment is using a Web Farm to run multiple instances of the web
application. This may be desirable for load balancing purposes.

There are several guidelines for setup. Each will be discussed in detail in separate sections.

o Load Balancer A load balancer sener is required as the point of entry for client requests.

o State Preservation Since Exago is a stateful application, either a State Senver or sticky sessions (affinity cookie)
must be enabled to prevent data loss.

o Shared Folders Instances must have common temp & reports folders, either on a network share or on a cloud
drive. Config files must be mirrored or shared.

NOTE. A single Exago sener with multiple worker processes could also be considered a "web farm." In this guide welll
consider the general term "web farm" to be synonymous with "senver farm," but refer to that specific setup as a "single-
sener web farm."

A typical setup will look like the following diagram.
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The load balancer sener is the point of entry for most web farms. This sener receives and directs client traffic to available
application instances. Here, youll set the list of web farm seners, and set any custom options for load balancing.

Please refer to your software's documentation for the specifics on configuration.

It is good practice to have identical Exago installations, i.e. physical path, virtual path, port number, permissions, on each
web farm sener.

NOTE. If you're using a single-senver web farm, then a load balancer is not necessary, as the sener's CPU will handle
the load balancing.

State Preservation

Exago is a stateful application that presenves user information in a session, a temporary storage space for client-sener
communication. When a user enters the application, a session is created which persists while the application is in use.
A maximum timeout length can be set in the config file to unload sessions after a period of disuse (defaults to 24 hours).

In a web farm, it is important to manage sessions in order to prevent data loss. This can be done in two ways: State
Server (highly recommended), or Sticky Sessions.

State Server

A state sener is a sener which stores session data. This sener should be highly reliable, and we recommended setting
up a dedicated sener for this task. However, the load balancer sener can act as a state sener if necessary.

When a user opens a session, the load balancer routes the user to one of the web farm seners. That sener then creates
and stores the session data on the state sener and sets a browser cookie on the user's machine. On subsequent calls, if
a user is routed to a different web farm sener, that server will look for the cookie, and load the relevant session from the
state sener.

State senver applications are typically senices which listen on a port. Each web farm sener needs to be configured to
point to the state sener address.

IIS comes with a state sener called ASP.net State Senice. Please refer to your software's documentation for the
specifics on configuration.

NOTE. If you're using a single-sener web farm, then the state senice can run on the same sener.

Sticky Sessions

Using sticky sessions presenes user state in a different way. When a user opens a session, the load balancer routes the
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user to one of the web farm seners, which creates a local session. The load balancer then sets a cookie on the user's
machine that ensures that all further calls within that session will go to the same sener.

To set up sticky sessions, it's usually as simple as enabling the option on the load balancer application settings. Please
refer to your software's documentation for the specifics. It may also be called "affinity cookie."

We generally consider sticky sessions to be a less robust solution than using a state sener. Performance can be
reduced, and there is no recovery mechanism if a sener goes offline.

Shared Folders

A shared location for storing Report and Temp data is required for a web farm. This can be within the network, or at an
extemal location, such as a cloud sener. In addition, it is recommended to use a shared location for the WebReports.xml
config file. Otherwise, any changes to the config would have to be manually pushed to every single instance.

Report & Temp Folders

For each installation, either using the Admin Console or by editing the config file, use the following keys to set a shared
storage location:

Network share

( Main Settings > Report Path ) <reportpath>

‘ \\Path\to\reports ‘

( Main Settings Temp Path ) <temppath>

‘ \\Path\to\temp ‘

Cloud drive
(see the cloud setup doc for more information)

( Main Settings Report Path ) <reportpath>

| pathtype=azure;credentials="connection_string' l

( Main Settings Temp Path ) <temppath>

| Local\temp\path l

( Main Settings Temp Cloud Senice ) <tempcloudsenice>

| type=azure;credentials='connection_string' l

Config File
The config setting <webfarmsupport> must be set to True. This is only accessible by editing the config file manually.

The config file xml needs to be mirrored across installations, either manually by copying the file when you change it, or
by setting a config cloud path.

Each installation contains a file called appSettings.config in the install directory. To set a cloud path, use the following
key in the appSettings.config file for each instance:

Cloud drive

(see the cloud setup doc for more information)

<add key="ExagoConfigPath" value="pathtype=azure;credentials="connection_string';storagekey=config"/>

Additional Notes

Keep in mind that the information in this guide may not apply to every single configuration.

For assistance in getting set up, please consider filing a support ticket on our support site. Our staff will be happy to
give additional tips or to help walkthrough some of the steps.

Setting up a State Server

45 of 168



Setting up a State Server

We highly recommend using a state sener to manage Exago sessions. Often, the cause of timeout problems is related

to not properly managing session state.

You can create a state senice on the same sener as the Exago application, or on a different one. This guide will explain
how to do so using the ASP.NET State Senice which is built into Windows.

Setup ASP.NET State Service

First, enable the State Senice. On your state sener, press Start > Run, type services.msc, and press OK.

CIEEE— x|

=== Typethe name of a pregram, folder, document, or Internet
resource, and Windows will open it for you.

Open: I services.msc| v|

'@ This task will be created with administrative privileges.

QK I Cancel Browse... |

Locate the ASP.NET State Senice and check the Startup Type property. Ifit is not set to Automatic or Automatic

(Delayed Start) then you hawe to enable the senice.

Right-click on it, and select Properties.

# 3 ASP.NET State Servi

Stark
L Avast Antivirus
o dinteligent’ - -
o Badf.gr?un. Inte |F|ent PaLse
.:/. Bfaseietenn_g Engine Resume
L BitLocker Drive Encrypt Restart

Lé.Block Llevel BackupEng —
. Bluetooth Support Sery Al Tasks »
£+, Bonjour Service

. Refresh
L BranchCache

S Certificate Propagation [ =y = k‘
5 Chrome Remote Desktc

Hel
54 CNG Key Isolation =

- 4 m A m O am g =

Change the Startup Type to Automatic, and press Apply. Then press Start.

ASP.NET State Service Properties (Local Computer) x|

General | Log On | Recovery | Dependencies |

Service name: aspnet_state

Display name: ASP NET State Service

Tt Provides support for out-of process session states for a
Ssciption }ASP.NI:—I'. If this service is stopped, out-of-process j

Path to executable:
C:A\Windows \Microsoft NET Framework64 w4 030315 aspnet_state exe

et e 1 (T |

Help me configure service startup options.

Service status:  Stopped

3 Start Stop | Fauze Fesume

You can specify the start parameters that apply when you start the service
from here.

Start parameters: I

2
ok | cancel | Acpy I

If your state sener is on a network, make sure you have allowed inbound connections to the state senice on a port.

Configure the Web Server
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To configure your web sener to use the state senice, open IIS, then in the left-most Connections pane, locate and

select your Exago application.

2 |
E...ﬂj ALEX-PC (Alex-PC\Administrator
[} Application Pools
B8] Sites
=43 Default Web Site
-] aspret_dlient

5
[ Exals¥ApiTestBed

Double-click on Session State.

L &
:;;d%sm

Select the State Senver setting, and input the senver port and a desired timeout value.

£ Session State
LE]

Session State Mode Settings
Mot enabled

 In process

 Custom

fTJ\\SSIﬁte Server

Connection string:

Itq:lip =loopback: 42424 j Create... |
Time-out {in seconds):

10

5L Server
Connection string:

Idata spurce=localhost;Integrated Security =55P1 j Create... |

Time-out (in seconds):
|33

[T Enable custom database

Then in the right-most Actions pane, press Apply.

& y
Sy Caniel

@' Help

Online Help

That's it! You should be all set.

Additional Info

For more information about out-of-process session state, see the following external links:

e Configure a State Server to Maintain Session State (IS 7.0)
¢ Configuring Step 2: Configure ASP.NET Settings

For personalized assistance, please file a support ticket.

Deploying to Production

This guide describes the considerations you should take when deploying an Exago Bl installation to a production
environment. Suggested steps are listed in the order they should be taken. Best practices are recommended for each
step. However, every environment is different, so recommendations should be considered in the context of your desired

setup.

For personalized support, please file a support ticket.
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Installation

Since Exago Bl is an embedded application, it is up to you to decide which of your seners Exago is installed on. Exago
Bl supports nearly any type of deployment, including cloud, private seners or onsite at your clients.

It is recommended to deploy Exago Bl on the same sener as your application, and to deploy one or more scheduling
senices on separate seners to handle Remote Execution of reports. To use the .NET API, Exago Bl must be
accessible from the host application via a file system path. See API for more information.

The scheduling senices are capable of acting as standalone report execution applications. The best way to scale Exago
Bl for performance is to deploy additional scheduling seners, and offload report executions to them. This method, called
Remote Execution, also implements an automatic load balancing solution. The seners with the most available
resources are given execution priority in order to keep an even load distribution.

A QA/Staging environment is highly recommended as well. This allows dewvelopers to test API changes, config changes,
and Exago Bl version updates, before moving to production.

Also consider the following:

e Where do you want temp files and report definitions to reside for each sener?
o Where does the data source reside, relative to where Exago Bl will be deployed?
o Should Exago Bl reside in the same domain as your host application?

Data

It is critical to make the right choices in how to present your data to your users. Consider the technical level and reporting
experience of your users. You may need to senice different classes of users, from technical users like developers and
database administrators, to non-technical business analysts and project managers.

Exago Bl can manage data object permissions to many lewels of precision. Permissions can be set per-user and per-
group, for data objects, fields, rows, and even within field values. Data objects are easily restricted for classes of users
using Roles. Within a data object, fields can be hidden, and row access can be limited by matching a linked user ID with
the logged-in user. Roles can also provide filters for data values, in case some fields should be partially, but not fully
hidden from view.

It is also recommended to use aliasing, descriptions, categories, and metadata to control how your data objects
appear in the application. Categories are a way to separate data objects into folders, so you can group together
associated data. Aliasing allows you to show more user-friendly names for data objects, instead of how they are named
in the database. Descriptions provide additional information, and metadata can improve report performance.

Also consider the following:

¢ How normalized or de-normalized should the \isible data be?

e Should any data objects be available for some users and not for others?

o Within a data object are there row-level permissions or multi-tenant permissions per user?

o Will the underlying data objects change in the future? If so, add IDs to objects to prevent naming conflicts.

API

It is critical that Exago Bl is only exposed to users through the API. The API allows you to set security and permissions
settings, and tailor the reporting experience by user.

.NET environments can use the .NET API, which is the most flexible and extensible API. Non-.NET environments can
access a subset of API calls through either the REST or SOAP web senice APIs. REST is highly recommended over
SOAP, because it supports stronger security and a more modem feature set.

The most basic APl implementation begins by initializing a session, then sets the "userld" and "companyld”
parameters to identify the logged-in user, sets a user-specific Role to control permissions, and then launches Exago Bl
using the getUrlIParamString() method. Deelopers should write the API code robustly with checks for null retumn values
and exception handling.

Consider where you want Exago Bl to appear within your application, and how users should use it to access reporting.
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For example, should it be placed in an iFrame container, a redirected page, or a popup window?
Also consider the following:

¢ Do you want to provide a list of reports and dashboards to users and directly run them via the API?
o Are there other settings in Exago Bl you want to enable or disable based on the user?

Folders

By default, Exago can handle the storage and retrieval of reports on a local or cloud-based file system. However, it

is strongly recommend to use the Folder Management extensibility feature to customize where report definitions
reside. Using folder management can allow you to store reports in a database instead of on a file sener. This can make it
easier to control user access permissions, helps to scale your deployment, and provides additional benefits such as soft
deletes and report usage tracking.

Your custom folder management definitions are accessed from a custom assembly, so this does require some additional
dewelopment. This sample code can be downloaded and used as a guide or a starting point.

Also consider the following:

¢ How do you want the folder tree to appear for new users?
o Will you create common reports that are available for all users?
o Are there multiple lewvels of report permissions beyond individual users and published reports?

Integration

Exago Bl gives you full control over the CSS, icons, and language strings in the Ul. You can hawe seweral different
application themes if necessary, and select different ones for different classes of users. You can also build

custom themes for reports and visualizations. And you can make a custom start page that users will see when they first
enter the UL

For integration, we recommend the following best practices:
Home page

Copy the ExagoHome . aspx home page to a new page, and use that as the entry point for users going into the full Ul.
This copy can be styled at will.

Application theme

Make a new application theme by extracting a copy of our theme template into a new folder in the
ApplicationThemes directory. Enable the theme in the Admin Console, and add any custom styling if desired.

Getting Started page

Remowe the content from the default Getting Started page, since this is only intended to be a styling example. It is
recommended to add custom content, since users with access to the full Ul will see this page often. Clients have
used the Getting Started page to provide announcements, quick tips, helpful formulas, and links to other parts of the
application.

Also consider the following:

e Does your application support multiple languages?

Are there any text strings or tooltips you want to customize?

Do you want to customize the CSS or swap out any of the icons in Exago BI?

Do you want to customize the context-sensitive help to match your documentation?

Reports

By providing a folder of "canned" reports, you can show users Exago Bl's capabilities, and some useful examples of the
data that is available to them. This folder should be at the top level so it is easy to locate, and read-only so that users
cannot edit the reports. If they want to make changes or see how the reports are made, they can duplicate a report and
edit the copy.

Making these reports can be a good opportunity for your support, sales, and senices staff to become familiar with Exago
BI. The Exago Bl senices team can also assist your staff, either by basing your training on these reports, or by building
them for you.

Also consider the following:

e What questions can be answered by reporting?
o What data objects do you want to highlight?
o Avre there any specific Exago Bl features that you want to showcase?
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Deployment

Once the other steps are in place, lay out a plan for moving to production. We recommend keeping detailed notes of the
process so it can be replicated for future updates.

After installing in production, move the following files from your staging environment to production:

1. The encrypted configuration file: /Config/config.xml.enc

2. Any custom application themes folders: /ApplicationThemes/themeFolder

. Any custom language files: /Config/Languages/language.xml. These also need to be added to the
/Languages directories for each scheduler installation.

. Your custom Getting Started page: /Config/Languages/getting-started.xml

. Any other configuration files: /Config/Other/file.json, and /appSettings.config

. Your custom context-sensitive help, if you hawe one: /NetHelp

. Your custom home page: / home .aspx

. If you are not using folder management, any custom theme files: /Themes/ theme

. If you are using Google Maps, make sure the MapPolygonDataBase.sqglite file is present in the /MapCache
folder.

w
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We also recommend adding the non-encrypted config file (/Config/config.xml) to your version control after removing
any sensitive passwords or connection strings.

Disable the Admin Console. It should not be accessible in a production environment.
Also consider the following:

e Make sure all Exago Bl instances and Scheduler Senices are on the same version and build number.

o [f you are using the .NET API make sure the version of webReportsApi.dl1l matches the version and build
number of Exago BI. Do the same with any custom assemblies, such as Folder Management, Scheduler Queue,
or Sener and Action Events.

Security

IMPORTANT: Follow our Security Checklist before tuming on access to your application. It is highly recommended to
follow these steps to reduce the possibility of unauthorized access.

Security Checklist

There are a number of precautions that should be taken before running Exago in a production environment.

o Set an external temp path

o Disable direct access

e Set a config password

o Remove the plain-text config

¢ Remove the admin console

o Encrypt scheduler data (if applicable)

Set an external temp path

The Temp directory contains working data, and may contain sensitive information. If the Temp Path config parameter is
left blank, Exago will default to a Temp folder at the root of the install directory. This is not recommended because it
could expose your temporary data to web access.

The Temp Path should be set to a location outside of the Exago installation (and behind the sener’s firewall).

( Main Settings Temp Path ) <temppath>

Disable direct access

Access to Exago should be curated through the API so that user permissions can be set via Roles. Users should not be
able to access the home page directly, which would bypass role restrictions. To disable direct access to Exago, set the
following config setting to False:

( Main Settings Allow direct access to Exago (bypassing API) ) <allowhomedirect>

Set a config password

A User ID and Password should be set in the config file. This safeguards access to the Admin Console and REST API.
See REST API for information on accessing a password-protected web senice.

( Other Settings User ID ) <userid>
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( Other Settings Password ) <password>
( Other Settings Confirm Password )

Remove the plain-text config

The Admin console generates two copies of the configuration whenever the OK or Apply button is pressed: a plain-text
xml document, WebReports.xml by default, and an encrypted version, WebReports.xml.enc. Plain-text config files
may contain sensitive information, such as database connection strings, schemas, usemames, and passwords.

When your config settings have been finalized, the WebReports.xml file should be removed from the Config folder and
saved in a secure location.

NOTE. The Admin console cannot read the encrypted file, so if config changes are necessary, first reinstate the
WebReports.xml file.

Remove the Admin Console

The Admin Console should never be used in a production environment. Deleting the Admin.aspx page will not prevent
access. To permanently remove the Admin Console from your installation, remove the following file from the bin folder in
your install directory:

admin.aspx.cdcab7d2.compiled

Encrypt scheduler data (if applicable)

Each scheduler stores working data in a local temporary folder. If you're using scheduler senices, you should set them to
encrypt their data. For each scheduler, edit the WebReportsScheduler.xml file and set the following setting to True:

<encrypt_schedule_files>

Then restart the senice.

About the Admin Console

The Exago Administration Console senes as a user interface to set up and save administrative preferences. Using the
Administration Console you can create and modify:

o Data: Establish how to connect to databases and determine what data should be exposed to users.
o General: Modify global settings of Exago to enable/disable features.

¢ Roles: Create and modify security Roles for individuals or groups of users.

e Custom Functions: Create and modify custom functions to make calculations on reports.

o Server Events: Create and modify custom code that is run when reports execute.

e Custom Options: Create and modify custom options that can be set on reports.

The Administration Console creates two configuration files: an XML file called WebReports . xml and an encrypted XVIL
file called WebReports.xml .enc. These files are created and saved in the Config folder where Exago was installed.

Notice. A backup copy WebReports.xml.backup is no longer created.

Important Security Notes:

e Each time you sawve the Administration Console settings an encrypted copy of iebReports.xml, called
lebReports.xml.enc, is created. This copy cannot be edited with the Admin Console. It is recommended to
use this as the live version of the config in a production environment. Copy WebReports.xml to a secure
backup, and then delete WebReports . xml from the Config directory.

o Before deploying Exago into a production environment be sure to set a value for the Temp Path' in Main Settings
to a location that resides outside of your sener’s firewall/security system.

Creating Additional Configuration Files

As part of the integration of Exago you may want to create altemative configuration files in addition to WebReports.xml.
Additional configuration files can be utilized in two ways:

o [f entering Exago directly, the configuration file to be used is specified in the Custom Styling.
o When entering through the Api the configuration file to be used is specified in the Api Constructor Methods.

To create additional configuration files:

1. Navigate to the Administration Console in a browser.
2. Append “?configFn=NewConfigFile.xml’ to the URL replacing 'NewConfigFile' with the name you want to give

51 of 168



About the Admin Console

the configuration file.
3. Click in the URL bar and press enter.
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ADMINISTRATION CONSOLE

WebReports. xml EI
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Search...

I » [E] Data
» % General
» &% Roles
» [E] Extensions

Accessing the Administration Console

Once Exago is installed, navigate the browser to http://‘Your Server’/Exago/Admin.aspx.

IMPORTANT. In the Other Settings menu under the 'General Section' you can set a login and password to restrict
future access to the Admin Console.

Navigation

The Administration Console consists of two sections. On the left is the Main Menu and on the right are tabs that can
contain menus to create and modify Data Sources, Data Objects, Parameters, Roles, and other settings.

[=) 1 1
> Joins || E : x| |a
| WebReports xmi . | I Joins = Sources 3 General Geting Started
. . Parameter Value
+ K4 x £} Main Settings
X Report Path CaReports
Temp Path
<0 Data Temp Cloud Service:
= Sources
1 Northwind Language Fie en-us en-us-getting-started en-us-tooltips
» @ Objects romm
p URL
Parameters Allow direct access to Exago (bypassing AP1} True
¢ General Allovred Output Types # HTML ¥ Exwel @ PDF ¥ RTF ¥ csv
Main Settings
Default Cutput Type HTML

Culture Settings
Feature/UI Settings
Programmable Object Settings
Filter Settings
Database Settings
Scheduler Settings
User Seitings
{3 Other Settings
b & Roles
s [ Extensions “
F= Functions
» fo Filter Functions
[ Server Events
Action Events
[E Custom Options

=» Apply o OK

Main Menu
Through the main menu you can:

o Create Data Sources, Data Objects, Joins, Parameters, Roles, and Custom Functions.
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o Edit settings for: Data, Roles, Functions, and General features.
o Delete Data Sources, Data Objects, Joins, Parameters, Roles, and Functions.

L]
1

Click the arrows ( )to hide the main menu.

Tabs
The right section of Exago is made up of tabs containing menus to create and modify administrative settings.
To save the changes made in a tab click ‘Ok’ or press ‘Apply’.

Tabs can be closed without saving by clicking the X’ to the right of the tab name.

> Joins = Sources  General &

Parameter Close this tab '

Main Settings

Tabs can also be rearranged by clicking and dragging them as desired.
+ Joins General *3o0urces

Parameter

Main Settings

Main Settings

The main settings are the basic options for Exago. The following settings are available:

Report Path
The parent folder for all reports. The Report Path may be:

¢ Virtual Path

o Absolute Path — used to provide increased security (ex. C:\Reports)

o Web Service URL or .NET Assembly — using a Web Senice or .Net Assembly allows reports and folders to be
managed in a database. For more information see Report Folder Storage & Management

Temp Path
The location where temp files are stored. The Temp Path may be:

o Blank — All temp files and images will be saved to ./Temp.
o Virtual Path
o Absolute Path — Temp files will be saved to the absolute path and image files will be saved to ./Temp

IMPORTANT. Before deploying into a production environment be sure to set a Temp Path that resides behind your
sener’s firewall/security system.

Temp Cloud Service

Web Senice, .Net Assembly or Azure Authentication string used to integrate into a Cloud Environment. For more
information see Cloud Environment Integration.

Language File
List of the xml files that specify language strings. See Modifying Select Language Elements for more details.

Temp URL

Owerrides the portion of the temporary URL used to store images from HTML exports. Temp URL can owerride just the
scheme (i.e. https) or the full URL.

Allow Direct Access to Exago

Tech Guide

53 of 168



Culture Settings Tech Guide

A boolean setting:

o True —allows users direct access to Exago with no security.
o False — users must be authenticated by the host application to enter Exago. Users that try to directly access
Exago will receive a message saying ‘Access Denied.’

NOTE. We highly recommend setting this to False before deploying Exago in a production environment.

Allow Execution in Viewer

Enables or disables running reports in the Report Viewer.

Allowed Export Types

The available formats for exporting all reports. Check the box of the formats that should be available.
Default Output Type

The export format that appears when a new report is selected unless a specific export format is set in the Options Menu
of the Report Designer.

NOTE. The Default Output Type must be one of the available Allowed Output Types.

Report Tree Shortcut

(v2017.2+) Whether the report execute button in the report tree defaults to Run the report in the Report Viewer, or Export
the report to the default format.

Culture Settings

The culture settings give administrators control over formats and symbols that vary amongst geographic location (e.g. $ is
the currency symbol in the U.S.A but € is the symbol used in Europe). These settings can be overwritten for a specific
user or group of users by modifying the Role. For more information see Roles.

The following settings are available:

Date Format

The format of date values. May be any .NET standard (ex. MM/dd/yyyy).
Time Format

The format of time values. May be any .NET standard (ex. h:mm:ss tt).
DateTime Format

The format of date-time values. May be any .NET standard (ex. M/d/yy h:mm tt).

NOTE. For more details on .NET Date, Time and DateTime Format Strings please visit

Date Time Values Treated As

Choose to format DateTime as Date or DateTime values. To change this setting for specific columns see Column
Metadata.

Numeric Separator Symbol

Symbol used to separate 3 digit groups (ex. thousandths) in numeric values. The default is *,’.
Numeric Currency Symbol

Symbol prepended to numeric values to represent currency. The default is ‘$'.

Numeric Decimal Symbol

Symbol used for numeric decimal values. The default is *.".

Numeric Decimal Places

Default number of decimal places for numeric fields to show. Leave blank to keep variable by field.
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Currency Decimal Places
(v2016.3+) Default number of decimal places for currency fields to show. Leawve blank to keep variable by field.
Apply Numeric Decimal Places to General Cell Formatting

Set to true to apply the Numeric Decimal Places to any cell that has Cell Formatting set to General but contains a
number. Default value is false.

Apply General Currency Right Alignment
(v2016.3+) Set to true to cause currency values to appear right-aligned by default in report cells.

Server Time Zone Offset

Value that is used to convert sener to client time (the negation is used to conwert client to sener time). Leave blank to
use sener time, or to use External Interface to calculate value.

NOTE. This offset is NOT applied to data coming from Data Sources. It is utilized by the Exago Ul such as the
Scheduling Senice.

Feature/Ul Settings

The Feature/Ul settings allow administrators to hide various features in the user interface. As each heading indicates,
settings may apply to specific report types or the entire application.

Available Report Types

These settings enable/disable report types.

Allow Creation/Editing of Express Reports
Enables/Disables the Express Report Wizard.

Allow Creation/Editing of Advanced Reports
Enables/Disables the Advanced Report Wizard and Report Designer.
Allow Creation/Editing of Crosstabs

Enables/Disables the Crosstab Report Wizard and Insert Crosstab button in the Report Designer.
Allow Creation/Editing of Dashboards

Enables/Disables the Dashboard Designer.

Allow Creation/Editing of Chained Reports
Enables/Disables the Chained Report Wizard.

Allow Creation/Editing of ExpressViews

(v2016.3+) Enables/Disables the ExpressView designer.
ExpressView Settings
These settings only apply to the ExpressView Designer (v20716.3+).

Allow Editing ExpressView with Live Data

Allows users to make changes to ExpressViews while in Live Mode.

NOTE. We recommend setting this to False. Editing live ExpressViews will cause a large increase in database calls,
and may reduce performance.

Fields Enabled in Data Fields Tree

(v2017.1.2+) This setting controls whether users are allowed to add fields to an ExpressView that are not directly joinable
to another field on the report.

o All joinable fields (default) - Users can add any fields with a join path to existing report fields.
o Direct joins only - Users can only add fields with a direct join to an existing report field.
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Express Report Designer Settings

These settings only apply to the Express Report Wizard.

Show Styling Toolbar

Enables/Disables the styling tools in the Layout tab of the Express Report Wizard.
Show Themes

Enables/Disables the Theme dropdown in the Layout tab of the Express Report Wizard.
Show Grouping

Enables/Disables the grouping tools in the Layout tab of the Express Report Wizard.
Show Formula Button

Enables/Disables the formula editor button in the Layout tab of the Express Report Wizard.

Standard Report Designer Settings
These settings only apply to the Report Designer.
Show Chart Wizard

Enables/Disables the Insert Chart button in the Report Designer. Set to False to disable users from creating or editing
charts.

Chart Colors
Lists the values used for default chart colors. Hexadecimal values should be separated by commas (or semicolons).
Maximum Number of Chart Data Points

Upper limit on the number of data points Msible on a chart. If the limit is exceeded, a waming will be displayed to the
user. Charts with large numbers of data points could cause browser performance issues.

Default Chart Font

Specifies a default font for charts created in the Report Designer. This setting can be owverridden on a per-Report basis.
Does not apply to Data Visualizations.

Show Geochart Map Wizard

Enables/Disables the Geochart Maps button in the Report Designer. Set to False to disable users from creating or editing
Geochart maps.

NOTE. Geocharts refers to the legacy maps feature, which was available starting in V2013.2.

NOTE. The first time Show Map Wizard is set to true a dialog appears prompting you to accept the terms of using the
Google Charts Api. Type “l accept” in the first box and your full name in the second to accept the terms and enable

mapping.

Exago uses the Google Charts API to provide mapping functionality.

Please read through the terms available here:
https://developers. google. com/chart/terms#license

To indicate that you accept the terms, type "l accept” into the input box:

Your digital signature (full name):

OK X Cancel

Geochart Map Key

(v2016.3+) Optional Google Maps license key for geochart permissions. License must contain the Google Maps
Javascript API senice. See Legacy Maps (Geocharts) for more information.
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NOTE. Because of a change in Google's Maps API Terms of Senice, if geocharting was enabled after June 2016, or if
you had geocharting enabled before, but changed your host domain name after June 2016, you need a license key to
use this feature.

Geochart Map Colors

List the values used for default Geochart map colors. Hexadecimal values or css color names should be separated by
commas (or semicolons).

Show Google Map Wizard

(v2016.3+) Enables/Disables the Google Maps button in the Report Designer. Set to False to disable users from creating
or editing Google Maps.

NOTE. In order to use Google Maps, a license key must be obtained from Google, and a polygon file must be
downloaded from our support site. See Google Maps for more information.

Google Map Key

(v2016.3+) License key for Google Maps pemmissions. This is required to use the new Google Mapping feature. License
must contain the Google Maps Javacsript APl and Geocoding API senices. See Google Maps for more information.

Google Map Colors

(v2016.3+) List the values used for default Google map colors. Hexadecimal values or css color names should be
separated by commas (or semicolons).

Show Gauge Wizard

Enables/Disables the Insert Gauge button in the Report Designer. Set to False to disable users from creating or editing
gauges.

Gauge Colors

List the values used for default gauge colors. Hexadecimal values or css color names should be separated by commas
(or semicolons).

Show Document Template
Enables/Disables the Document Template Menu. Set to False to disable users from using the Document Template Menu.
Show Document Template Upload Button

Set to True to allow users to upload Document Templates to the Report Path. Set to False to prevent users from
uploading Document Templates.

Show Linked Report

Enables/Disables the Linked Report button in the Report Designer. Set to False to disable users from creating Linked
Reports.

Show Linked Report Fields

Enables/Disables the Fields selector tab in the Linked Report dialog.

Show Linked Report Formula

Enables/Disables the Formula editor tab in the Linked Report dialog.

Show Linked Action

Enables/Disables the Linked Action button.

Show Insert Image

Enables/Disables the Insert Image button in the Report Designer. Set to False to disable users from inserting images.
Show Joins Window

Enables/Disables the Joins Menu under Advanced. Set to False to disable users from modifying joins.
Show Advanced Joins

Enables/Disables additional options in the Joins Menu. Set to True to enable advanced users to create, delete, and
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modify joins.
Show Events Window

Enables/Disables the Events Menu under Advanced. Set to True to enable advanced users to apply Event Handlers for
the report. See Server Events for more information.

Show Linked Reports in New Tab

Specify how to display Linked Reports. Set to True to open Linked Reports in a new tab. Set to False to display Linked
Reports in a floating window above the parent report.

Allow Grouping on Non-Sorts

Enables/Disables the group formula button in the Group Header/Footer Menu. Enabling this will allow users to group on
non-sort formulas.

NOTE. Grouping on non-sort formulas is deprecated and unsupported.

Dashboard Report Designer Settings
These settings only apply to the Dashboard Designer. If ‘Show Dashboard Reports’ is false these settings will be ignored.
Prompt user for Parameters/Filters on Execution

Default setting indicating whether to prompt the user for filter and/or parameter values when executing a dashboard. The
option can be overridden on an individual dashboard in the Options menu.

Show URL Item Button

Display/Hide the New URL item in the Toolbox of the Dashboard Designer.

Allow Creation/Editing of Dashboard Visualizations

Display/Hide the New Data Visualization item in the Toolbox and the Data Fields of the Dashboard Designer.
Use Sample Data for Dashboard Visualization Design

Set to True to use sample data while creating and editing Dashboard Visualizations. This will reduce the number of calls
to the database. Set to False to query the Data Source for each change made while editing Dashboard Visualizations.

Visualization Database Row Limit

(pre-v2017.2) Maximum number of rows retumed on a queries made by Data Visualizations. This only applies to Tables,
Views and Functions. Set to ‘0’ to retum all rows.

Refresh Reports/Visualizations on Dashboards Silently

Set to True' to disable the refresh hourglass for timed automatic dashboard reloads.

Common Settings
Default Designer Font

Specifies a default font for reports created in the Standard Report Wizard, Express Report Wizard, Standard Report
Designer, and Dashboard Designer. This setting can be overridden on a per-Report basis. Does not apply to CrossTabs.

NOTE. End-users must hawe the selected font installed locally in order to display. Otherwise, Exago will default to Sans
Serif. We suggest using a font-face css tag in your custom home page to tell the browser to download the font
automatically:

@font-face {
font-family: 'Open Sans';
src: url ('myFonts/OpenSans.ttf');
}

Default Designer Font Size

Specifies a default font size for reports created in the Standard Report Wizard, Express Report Wizard, Standard Report
Designer, and Dashboard Designer. This setting can be overridden on a per-Report basis. Does not apply to CrossTabs.

Show Help Button

Tech Guide

58 of 168



Feature/Ul Settings Tech Guide

Enables/Disables the Help button in the top right comer of Exago. Set to False to disable users from accessing Context
Sensitive help.

Custom Help Source

Specifies the URL that contains custom Context Sensitive Help content. See Custom Context Sensitive Help for more
details.

Show Exports in Tab

Set to True to open PDF reports in a tab in Exago. Set to False to prompt the user to download the PDF.
Show IE Download Button

Set to True if Intemet Explorer is not automatically prompting users to download PDF, XS, RTF or CSV reports.
Show Join Fields

Enables/Disables any Data Fields that are used as Unique Keys or Joins. Set to False to hide all unique key and join
Data Fields from users. To hide specific Data Fields see Column Metadata.

Show Grid Lines in Report Viewer

Sets the default output to show grid lines. This can be modified in the Options Menu of the Report Designer.
Save on Report Execution

Set to False to disable automatic saving of reports when executing from the Report Designer.
Save on Finish Press

Set to False to disable automatic saving of reports when finish button is pressed in a wizard.
Enable Right-Click Menus

Set to False to disable right click menus.

Enable Reports Tree Drag and Drop

Set to False to disable the dragging of reports and folders in the Main Menu.

Show Report Upload/Download Options

Set to True to enable users to upload and download report files by right clicking on folders and reports. Default value is
False.

Allow interactivity in Report Viewer

Set to False to disable Interactive Report Viewer capabilities, including: changing column width, styling output, and
interactive filters.

Show Toolbar in Report Viewer
Specify if Report Viewer should display paging, search, and export options.

o Auto - Exago will detect if the report only displays a single plage of content from the Report Footer Section. If so
the HTML Toolbar will be hidden, otherwise it will show.

o Show — The toolbar will always show.

¢ Hide — The toolbar will never show.

Default interactive report viewer dock is open

Set to False to hawe the Interactive report Viewer Dock minimized by default.

Interactive report viewer default dock placement

Specify if the Interactive Report Viewer Dock should appear on the right or left of the default output.
Allow save to report design for report viewer

Set to False to prevent users from saving Interactive Report Viewer changes onto the report.
Maximum number of fields in a crosstab header or tabulation source

Specify the maximum allowed fields in a crosstab header or tabulation source. Note that adding a large number of data
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fields to a crosstab will significantly increase the execution time of the report.

Use SVG for Application Icons

(v2016.3+) Set to true to enable Exago to use SVG (scalable vector graphics) icons instead of the default PNG icons for

the Ul elements. SVG icons look nicer on high-pixel density screens, but they may not be compatible with older web
browsers.

Application Theme Selection
(v2016.3+) Choose from a selection of downloadable Ul themes. See Application Themes for more information.

Show Data Fields Search Box

(v2017.2+) Enables/Disables the data field search tools in the sidebar of the ExpressView and Dashboard designers.

NOTE. We highly recommend setting Column Metadata, and setting Schema Access Type to Metadata for all
available objects, before enabling this feature.

Programmable Object Settings

The Programmable Object Settings enable you to specify names for parameters that will be passed from Exago to stored
procedures, web senices, or .NET Assemblies. Using these parameters will allow filtering to be done before the data is
sent to Exago. This can increase performance and reduce sener resources when using Programmable Objects. For more

information on these types of Data Objects see Web Services & .NET Assemblies.

Note. If performance is a concem, especially for large data sets, database-joinable objects, such as tables, views, and

table-valued functions, are preferable to programmable objects.

Names for the following Parameters can be set:

Call Type Parameter Name

Integer that specifies what Exago needs at time of the call. There are three possible values.

e 0:Schema - retum a DataSet with no rows.
e 1: Data - retum a full DataSet.

e 2: Filter Dropdown Values — retums data for the filter dropdown list. The Data Field requested is passed in the

Column Parameter and the filter value is passed in the Filter Parameter (see below).
Column Parameter Name
Name of the column being requested by the user. Only this column needs to be retumed to Exago.
Filter Parameter Name

o CallType = 1: The filter string specific to the Data Object being called passed as standard SQL.
o CallType = 2: The current value of the filter whose dropdown is being requested.

Full Filter Parameter Name

o CallType = 1: The filter string for the entire report passed as standard SQL.
e CallType = 2: The Tenant and Row Leel filters passed as standard SQL.

Sort Parameter Name

The sort string for the report. This is for informational purposes only as Exago sorts data upon retum from stored
procedures and Web Senices.

Data Category Parameter Name
The Data Object’s Category. Can be used in conjunction with the Data Object ID Parameter.

Data Object ID Parameter Name

Id of Data Object being called. For more information see Calling a Single Web Service/.Net Assembly/Stored
Procedure.

Filter Settings

The Filter Settings provide control over what filter options are exposed to users and how the drop downs within filters
behawe.
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Names for the following Parameters can be set:
Show Group (Min/Max) Filters
Enables/Disables the Min/Max Filter menu. Set to 'False' to disable users from using Min/Max filters.
Show Top N Filters

(v2017.1+) Enables/Disables the Top/Bottom Filters menu in the ExpressView and Advanced Report designer. Top N
filters allow users to see the highest or lowest values for a data set. Set to 'False' to disable users from using Top N
filters.

Allow New Filters at Execution

Controls the creation of new filters when a user is prompted for a filter value at the time of report execution. Set to 'False'
to disable new filters from being created at execution.

Read Database for Filter Values

Enables/Disables filter drop downs to contain values from the database. Set to 'False' only if retrieving values for the drop
down will take more than a couple of seconds.

Allow Filter Dependencies

Causes filter drop downs to retrieve values dependent on the filters above them in the menu. Set to True to enable.

NOTE: This setting only works for Data Objects from databases and will not change drop downs from Web Senices,
.NET Assemblies, stored procedures, etc.

NOTE: Drop downs after an ‘OR’ filter will not be dependent on previous filters.

Show Filter Description

Enables/Disables reports to have a description text for the filters menu. The filter description is set in the Description tab
of the New Report Wizard or the Description Menu. A help button will appear in the Filters menu and display the filter
description when clicked.

Default Filter Execution Window
Species the type of filter execution window to new reports should use by default.

o Standard — New reports display the standard filter execution window.

o Simple with Operator — New reports display a simplified filter execution window that only allows the operator and
value to be changed.

o Simple without Operator — New reports display a simplified filter window that only allows the value to be
changed.

Allow User to Change Filter Window

Enables/Disables reports to change the type of filter execution window that is displayed.
Include Null Values for 'NOT' Filters

Indicates to include NULL values for filters with using the operators ‘not equal’ or ‘not one of.
Custom Filter Execution Window

Specifies a control or URL that contains Custom Filter Execution Window. See Custom Filter Execution Window for
more details.

Restore All Default Date Filter Functions

(v2016.3+) Restores the default Filter Functions to the Extensions menu.

Restore All Default Formula Functions

(v2017.2+) Restores the default Custom Functions to the Extensions menu.

Database Settings

The Database Settings allow administrators to adjust how Exago interfaces with databases. Additional type-specific
settings allow you to specify which driver to utilize when connecting to each data source.
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The following Database Settings are available:

Database Timeout

Maximum number of seconds for a single query to run.

NOTE. This setting will also control the maximum number of seconds that a \Web Senice Api method can run. If set to
‘0" the Web Senvice time out will be ‘infinite’.

Database Row Limit

Maximum number of rows retumed on an execution. This only applies to Tables, Views and Functions. Set to ‘0’ to retumn
all rows.

Row Limit Step Size

(v2017.2+) Maximum number of rows retumed on a query. Set to ‘0’ to return all rows. Set to > 0 to enable Incremental
Loading for Advanced Reports and ExpressViews. The value determines how many rows are retumed for each user-
initiated data query.

Disable Non-Joined Data Objects

If True users are not able to add Data Objects to a report that does not have a join path with at least one other Data
Object on the report. Set to False to disable this behavior.

Enable Special Cartesian Processing

If True any one-to-many Joins will cause special processing to awid data repeating on the report. Set to False to disable
this behavior.

Aggregate and Group in Database

(v2016.3+) If True, aggregate and grouping calculations will be done in the database when possible. This will provide a
performance boost for reports with group sections.

IMPORTANT. Before enabling this, you MUST ensure that all One-To-Many Joins in your environment are correctly
identified and set as One-To-Many in the Join options menu. If these joins are not properly identified, reports which
utilize them will retum incorrect aggregate datal See Database Aggregation for more information.

Type-Specific Database Settings
Each Type of Data Sources has the following settings available.
Data Provider

The name that can be used programmatically to refer to the data provider. This matches the InvariantName found as a
property of DbProviderFactories in the machine.config file. See for more information.

Table Schema Properties

Specifies how to retrieve the schema of tables.
View Schema Properties

Specifies how to retrieve the schema of views.
Function Schema Properties

Specifies how to retrieve the schema of Functions.
Procedure Schema Properties

Specifies how to retrieve the schema of Procedures.

NOTE. For any of the Schema Property settings you can dynamically refer to properties from the Data Source’s
connection string by surrounding the property name in @ symbols. Ex. "@database@" will be replaces with the
database name from the connection string of the Data Source being queried.

Scheduler Settings

Reports can be emailed or scheduled for recurring automated delivery to an email address. The Scheduler settings are
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used to configure these senices. Before adjusting the settings, ensure that the scheduler senice ‘ExagoScheduler’ is
installed, running, and set to automatically start. For more information see Installing Exago Scheduler.

The Remote Execution senice can be used to mowe processing to a different sener or to provide load balancing across
multiple seners. For more information see Load Balancing.

The following Scheduler Settings are available:
Enable Report Scheduling

If 'False' will override Show Report Scheduling Option, Show Email Report Options, & Show Schedule Manager
to False.

Enables/Disables the scheduler icon on the Main Menu. Set to 'False' to disable users from creating scheduled reports.
Show Report Scheduling Option

Enables/Disables the scheduler icon on the Main Menu. Set to False to disable users from creating scheduled reports.
Show Email Report Options

Enables/Disables the email report icon on the Main Menu. Set to 'False' to disable users from emailing reports.
Show Schedule Reports Manager

Enables/Disables the scheduler manager icon on the Main Menu. Set to 'False' to disable users from editing existing
schedules.

Show Schedule No End Date Option

Controls if users must set an end date for recurring report schedules. Set to 'False' to force users to set a limit to the
schedule.

Show Schedule Intraday Recurrence Option

Enables/Disables options in the Recurrence tab to have a schedule repeat throughout the day it is scheduled.

Scheduler Manager User View Level

Controls what information each user can see in the Schedule Manager. These lewels utilize the Parameters companyld
and userld. There are three possible values:

e Current User: Can only view and delete report jobs that have been created by that user. This setting will hide the
Host, User Id, and Company Id columns of the Schedule Manager.

e All Users in Current Company: User can only view and delete report schedules for their company. This setting
will hide the Host and User Id columns of the Schedule Manager.

o All Usersin All Companies: User can view and delete report schedules for all companies (administrator).

For more information, see User Identification.
Email Scheduled Reports

Set to 'False' to have the Scheduling Senice sawe reports to a repository instead of attaching them to emails. For more
details see Saving Scheduled Reports to an External Repository.

Enable Batch Reports

Set to True' to allow users to schedule reports which are filtered separately for each recipient user. Batch reporting
requires a table or other data structure containing email addresses for the intended recipients associated with a key used
to filter the reports. For more information see Scheduling Reports.

Show Schedule Delivery Type Options

Set to true to allow users to choose the output option (e.g. email or archiving) with each schedule. When enabled the
default value will reflect whatever is set in the 'Email Scheduled Reports' setting.

Use Secure Scheduler Remoting Channel

(v2016.3+) Set to true to cause data sent to remote schedulers to be encrypted. Each scheduler config file must also
have <secure_channel> set to true.

Schedule Remoting Host

Sets the sener and port for the ‘ExagoScheduler windows seniice.
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Enable Remote Report Execution
Permits report execution to be done on a different sener via the scheduler senice. Set to True' to enable this behavior.
Enable Execution Cache

(v2017.1+) Permits users to use an execution cache for specified reports. An execution cache refreshes report data on a
schedule, and report execution calls use the cached data instead of querying the database.

Enable Access to Data Sources Remotely

Permits all non-execution data base calls to be done on a different sener via the scheduler senice. Set to True' to enable
this behavior. Example calls include Filter value drop downs, Data Object Schema retrieval, and Data Source schemata
retrieval in the Administration Console.

Remote Execution Remoting Host

Specifies the sener(s) to use for remote execution. The Port is set in the schedule remoting configuration of the
scheduler. Separate multiple seners with commas or semicolons.

Ex. http://MyHttpSenver1:2001,tcp://MyTcpSenver:2001.

Custom Queue Service

Specifies the web or assembly queue senice for custom scheduler management and load balancing. See Scheduler
Queue for details.

Delete Schedules upon Report Deletion

When a report is deleted corresponding schedules can be deleted automatically by Exago. Set to True' to enable this
behavior.

Default Email Subject

Set a default subject that will be displayed in the schedule report wizard. Parameters such as @reportName@ may be
utilized in this area.

Default Email Body

Sets a default body that will be displayed in the schedule report wizard. Parameters such as @reportName@ may be
utilized in this area.

Password Requirement (for PDFs only)
Requires a password for PDF export. This parameter can be made up of the following values:

e A: requires an upper case letter for each ‘A’

e a:requires a lower case letter for each ‘a’.

e n: requires a numeric character for each ‘n’

4: password must have at least 4 characters

Ex. ‘AAnna6’ would require a password of at least six characters with 2 capitals, 1 lower case and 2 numeric
characters.

Custom Scheduler Recipient Window

Provides URL, height and width for custom Scheduler Recipient window. See Custom Scheduler Recipient Window for
more information.

Other Settings

Administrative options that do not fall into any of the previous categories are found in the "Other" category.
The following Other Settings are available:
Excel Export Target

Choose the type of Excel export you would like. Choosing 2003 will automatically split the workbook into multiple
worksheets when Excel’s row limit is reached.

NOTE. Linux does not support setting the Excel export target to 2003.
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External Interface

Provide a Web Senice URL or .NET Assembly to interface with the external module. For more information see External
Modules.

Enable Paging In the Report Viewer

Controls when data for Report Viewer output is sent to the client. Set to True' to send data as each page is requested.

NOTE. This will cause multiple hits to the sener.

Set to 'False' to send all the data to the client browser at once.

Renew Session Automatically

This setting is used to bypass the session timeout property set in web.config. Set to True' to send a sener side AJAX
callback every two minutes to keep the session from expiring.

NOTE. This will only work if the timeout period set in web.config is greater than two minutes.

Write Log File

(v2017.2+) Set the level of detail logged in the Exago log file. See Application Logging for information about the different
log lewels. This setting will be overridden by a 1og4net.config file.

(pre-v2017.2) Set to True' to write a log file for debugging purposes. For more information see Reading the Log File.
Enable Debugging

Set to True' to enable debugging. For more information see Manually Creating a Debug Package.

Max Report Execution Time

(v2016.2.12+) Specify how long reports should run before timing out. Default is 240 minutes (4 hours).

Maximum Age for Temp Files

Determines the maximum number of minutes a temp file can exist before Exago’s automatic cleanup of temp files will
remowe it.

IMPORTANT. Understand that setting the maximum age too low may cause an error, as users might spend some time
viewing a report executed in HTML, which uses AJAXto read temp paging files.

The default value is 1440 minutes (1 day). The minimum this value can be set to is 30 minutes.
Enable Web Service/Assembly Data Mapping

Allows Web Senice and .NET Assembly methods to replace Data Field names.

Limit Report to One Category

Limits reports to Data Objects within a single category. Set to True' to enable this behavior.
Cache External Services

Caches external Web Senices and .NET Assemblies. Setting to 'False' may reduce performance due to
loading/unloading of senices.

Global Schema Access Type

Specifies whether to query the Data Source for an Object’s schema or to read it from Column Metadata. See Retrieving
Data Object Schemas for more information.

Allow Multiple Sessions
Allows multiple sessions of Exago per user. Set to True' to enable this behavior.
Allow MD5 Hashing on FIPS Server

(v2016.3+) Allows a FIPS-complaint sener to encrypt PDF files by using an altemate MD5 library to the built-in
System.Cryptography.

‘Loadlmage’ Cell Function Parameter Prefix
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A string that is prepended to the Loadlmage Function when the report is run. This setting allows an administrator to hide
the report path of images on your sener. This field is ignored for images loaded from a database.

Ignore Inaccessible Report Folders

If 'False', Exago throws an error message if a folder has an accessibility issue. Set to True' to ignore the error and hide
the inaccessible folder.

User ID

Sets the User Id necessary to gain access to the Administration Console and REST API. Leawve blank to permit unverified
access to the Administration Console.

Password
Used in conjunction with User ID to gain access to the Administration Console and REST API.

Confirm Password

Used to confirm the value of “Password.”

Debug Password

A password that enables clients to send a debug package directly to Exago Inc. Leave blank to disable Debug
Extraction. When set to True', correct permissions must be set on the ./Debug Folder. For me details see Submitting a
Debug Package.

Exago Expiration Date

A date when users will no longer be able to access Exago.

Custom Code Supplied by Exago

Used for custom functionality.

Automatic Database Discovery

Automatic Database Discovery enables you to quickly and easily add many Data Objects and Joins from a single Data
Source. Discovery can only be performed on the following database types: mssq|, oracle, mysql, postgresql, db2, and
Informix.

To start using Database Discowery, select a Data Source and click the Discovery button ( Q ). This will open a
discowery tab for the Data Source.

In the discovery tab you can do the following:

o Select the Tables, Views, Functions, and Stored Procedures you would like to add by either checking individual
boxes or pressing 'Select All Objects’ or 'Select All Complete Objects'.

Note. Objects with identified unique key values will have a key icon ( s ) next to them and objects with
associated joins will have a join icon (**) next to them.

o Set any missing Unique Key fields by right clicking on an object.
e Check 'Preview Only' and then 'Add Objects' to preview the selected objects and joins.
o Add the selected Data Objects by pressing 'Add Objects'".

Note. If any selected Objects are missing unique key values they can be completed individually in a new tab
entitled 'Incomplete Objects".

¢ Add the selected Objects and any associated Joins by pressing 'Add Objects and Joins'.
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= Northwind_Active * | 4 Geting Started
[ Select All Complete Objects [ Select All Objects [[7) Clear Selections

=p Add Objects. =% Add Objects and Joins Preview Only

4 Northwind_Active
4 Tables
£ dbo.Categories
dbo. CustomerCustomerDemo
dbo.CustomerDemographics
dbo Customers
dbo Employees
dbo EmployeeTermitories
dbo. OrderDetails
dbo. Orders
dbo Products
dbo Region
dbo.Shippers Select i(elms on the left and choose "Add _Ohiec(s” or "An_‘]d Objects and
Joins”. A summary of the results will appear in this panel.

My Y Y Y Y Y o ¥

dbo.Suppliers
> dbo Teritories

v Views

» Functions

v Procedures

X Close

Customizing Data Discovery SQL

(v2016.3.6+) The SQL used for Automatic Database Discovery can be customized if necessary, in order to accommodate
non-standard key names.

To customize the discovery SQL, locate the file dbconfigs. json inthe Config/Other folder in the host application's
install directory, and open it in a text editor.

Locate the property for your data source type and edit the SQL for either or both primary and foreign keys. Sawe the file,

then run Database Discowery to see your changes.
J; 1,
"mysgl™:
= i
as tablename, COLUMN NAME as columnname FROM information schema.key column usage WHERE
table_ schema = schema () AND CONSTRAINT NAME = 'PRIMARY'",
10 "ForeignKey5gl":"SELECT TAELE SCHEMA As schemaname, TABELE NAME as tablename, COLUMN NAME as
columnname, REFERENCED TABLE SCHEMA as referencedschemaname, REFERENCED TAELE NAME as
referencedtablename, REFERENCED COLUMN NAME as referencedcolumnname FROM
inforl;lﬁation_schema.key_colu.rm_usage WHEERE table schema = schema () AND CONSTRAINT NAME Like
PFES "

]

oo

"PrimaryKeyS5gl":"SELECT CONSTRAINT NAME AS indexname, TABLE SCHEMA as schemaname, TAELE NAME

11 F b,

Note. Data discowery is not currently supported for ODBC data sources.

Data Sources

Data sources establish the connection between Exago and a database or a web senice. Although typically only one
database is used, Exago can join data from different sources into a single report.

NOTE. To utilize some types of Data Sources you may need to download and install the appropriate driver. Please see
Data Source Drivers for more information.

All existing Data Sources are listed in the Main Menu under 'Data’. All the Sources you are adding or editing will be
displayed in a Tab titled Data Sources.

To add a new Data Source click ‘Sources’ in the Main Menu then click the Add button.

To edit a Data Source either double click it or select the Data Source and click the Edit button.
To delete a Data Source select it and click the Delete button.

To sawe changes click the Ok button or press the Apply button.

Each Data Source must have the following:
Name
A name for the data source.

Type
The type of source being used. Valid types include:
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e mssql — Microsoft SQL Sener.

e mysql — MySQL.

e oracle — Oracle.

o postgres — PostgreSQL.

e db2 - IBM db2.

o informix — IBM Informix.

o webswc — Web Senice. For more information see Web Services.

e assembly - .NET Assembly dil. For more information see .NET Assemblies.
o file — XML or Excel file. For more information see Excel and XML Files.
e msolap — OLAP. For more information OLAP and MDX Queries.

e odbc — ODBC Driver. For more information see ODBC drivers.

Schema/Owner Name (blank for default)

Provide a default database schema for the data source.

NOTE. Only use this if you are using schema to provide Multi-Tenant security. For more details see Multi-Tenant
Environment Integration.

Connection String
The method that is used to connect to the data source. Connection strings vary by type:

e mssql, oracle, postgres, mysql and olap — Please refer to ConnectionStrings.com for database connection strings.
e webswc — Can take up to four parameters but only requires url.
o url — The url of the web senice.
o Authentication (optional) — Set to ‘basic’ to utilize basic authentication through IIS. This will send the userid
and password as clear text (unless https is used).
o uid (optional) — User id is passed to the web senice.
o pwd (optional) — Password is passed to the web senice
e assembly — Requires two parameters.
o assembly — The full path of the assembly name.
o class — The class name in the assembly where the static methods will be obtained.
o file — Requires the physical path to the excel or xml file and the file type. Ex. File=C:\example.xIs; Type=excel;

Click the green check mark to verify the connection succeeds.

Data Source Drivers
Below is a list and the associated links for recommended ADO.NET drivers for each type of Data Source.
e SQL Server - No extemal ADO.NET driver needed
e Oracle - ODAC1120320_x64 or newer — Oracle ODAC Connector -
o MySQL/MariaDB — dcmysdlfree.exe — Devart Connector -
o PostgreSQL — dcpostgresqlfree.exe — Devart Connector -

o DB2/Informix — 5.exe or newer — IBM Data Sener Driver Package —

Web Services and .NET Assemblies

Web Senices and .NET Assemblies can be used as Data Sources. This is possible when the Web Senice and .NET
Assemblies underlying methods are setup as Data Objects.

An advantage of doing this is being able to use high-level language to manipulate the data being reported on at run-time.
The main disadvantage is not being able to take advantage of the database to perform joins with other data objects; data
from methods can still be joined, but the work to do this is done within Exago. For more information see Note about
Cross Source Joins.

Parameters

Parameters are passed from Exago to Web Senices and .NET Assemblies. Three types of parameters can be passed
but only Call Type is required.
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Call Type (required)

Integer that specifies what Exago needs at the time of the call. There are three possible values. You may specify the
name of this parameter in the Programmable Object Settings of the General Section.

e 0:Schema - retums a DataSet with no rows.

o 1:Data - retums a full DataSet.

e 2: Filter Dropdown Values — retumns data for the filter dropdown list. The Data Field being requested is passed
in the column parameter. The filter type is passed in the filter parameter (see below).

Column, Filter and Sort Strings (optional)

To optimize performance Exago can pass user-specified sorts and filters to the Web Senice or .NET Assembly. This
process reduces the amount of data sent to Exago. If these parameters are not used, all of the data will be sent to Exago
to sort and filter. Column, filter and sort strings are sent as standard SQL. You may specify the name of these
parameters in the Programmable Object Settings of the General Section.

Custom Parameter Values (optional)

Additional parameters can be specified to be sent to individual methods in the Data Object Menu.

IMPORTANT. When a Web Senice or .NET Assembly is first accessed it is compiled and kept in an intemal cache
within Exago. This is done in order to increase performance. Due to this intemal cache, Exago will not be aware of any
changes within the Web Senice or .NET Assembly. If the senice or assembly is subsequently changed; Exago will
execute the prior compiled version. Thus, when you modify the Web Senice or .NET Assembly reset the intemnal
cache of Exago by clicking the green check mark of the Data Source () or by restarting IIS.

NOTE. If an Exago .NET API application needs to access reports which use an Assembly data source, it must include
a reference to the assembly WebReportsAsmi.dll.

Sessionlinfo (optional) (v20716.2+)

Session state variables. See Sessioninfo for more information.

NET Assemblies

It is important to note that when a connection string for .NET Assembly is set the class name must match the name of
the class where the static methods will be searched. UNC or absolute paths may be used. Make sure that the assembly
has read privileges for the IS user running Exago. Below is an example of a .NET Assembly connection string:

assembly=\\MyServerName\MyShareName\MyAssembly.dll;class=Main

.NET Assembly methods must be static. Below is an example of a .NET Assembly method.

public class Main
{
public static DataSet dotnet optionees(int callType, string columnStr, string filterStr, int myCu
{
switch (callType)
{
case 0:
// return schema
case 1:
// return data
case 2:
// return filter values for dropdown

}

4‘ Alj

Method signature using Sessioninfo (v2076.2+):
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public class Main

{
public static DataSet dotnet optionees (WebReports.Api.Common.SessionInfo sessionInfo, int callTyp

{
switch (callType)

}

4 ‘ ﬂ

Web Services

Web Senvices are accessed via SOAP. Below is an example of a Web Senice connection string:
url=http://MyServer/MyWebService.asmx

Web senices methods are similar to .NET Assembly methods with the following exceptions:

¢ Methods do not need to be static
e Methods must return a serialized XML string. The retumed XVIL must follow the structure used by the C# method
DataSet.GetXML. An example of XML format can be found in the following section.

Excel and XML Files

Exago can use Microsoft Excel and XML files as Data Sources. Remember though that Excel and XML files are not
databases. Simply put, these Data Sources do not offer the speed, performance, security or heawy lifting of a real
database. Using Excel and XVIL files is recommended only if your dataset is small or if the information is only available in
this format.

Excel

Each worksheet in the Excel file will be read as a separate table. Each worksheet’s name will be read as the table’s title.
The top row will be read as the column header, and the remaining cells will be read as the data. Do not leave any blank
rows or columns.

® 9
Home Insert Page Layout Farmulas Data Review View Acrobat Ti
_'_dj ‘K Cut Calibri -1 v A == S Wrap Text

Paste A copy B 7 === ] M
- < Format Painter === erge & Cente
Clipboard ] Faont ] Alignment
12 - fr|

A B C D E F G H |
1 |LastName FirstMame PatientlD S5N Age Gender Street City State
2 Chambers Janet 4321 333224444 32 f Main st. MNew Paltz  NY
3 Cherry  Randall 5678 530167036 44 m 474 Camd Poughkipsie NY
4 Tucker  Frederick 9876 263846521 38 m 4557 Stevi Kingston NY
5
7]
7
8

XML

The XML document must begin with the schema. After defining the schema the data must be placed into the appropriate
tags. For reference see the working example below:
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<?xml version="1.0" encoding="UTF-8"?>
<ExagoData>

<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema" xmlns:msdata="urn:schemas-microsoft-com:x

<xs:element name="ExagoData" msdata:IsDataSet="true" msdata:UseCurrentLocale="true">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element name="Call">
<xs:complexType>
<xs:sequence>
<xs:element name="CallID" type="xs:unsignedInt" minOccurs="0" />
<xs:element name="StaffID" type="xs:string" minOccurs="0" />
<xs:element name="VehicleUsed" type="xs:unsignedInt" minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="Staff">
<xs:complexType>
<xs:sequence>
<xs:element name="StaffID" type="xs:unsignedInt" minOccurs="0" />
<xs:element name="Rank" type="xs:string" minOccurs="0" />
<xs:element name="LastName" type="xs:string" minOccurs="0" />
<xs:element name="FirstName" type="xs:string" minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:choice>
</xs:complexType>
</xs:element>
</xs:schema>
<Call>
<CallID>890</CallID>
<StaffID>134</StaffID>
<VehicleUsed>12</VehicleUsed>
</Call>
<Call>
<CallID>965</CallID>
<StaffID>228</StaffID>
<VehicleUsed>4</VehicleUsed>
</Call>
<Call>
<CallID>740</CallID>
<StaffID>1849</StaffID>
<VehicleUsed>2</VehicleUsed>
</Call>
<Staff>
<StaffID>134</StaffID>
<Rank>Captain</Rank>
<LastName>Renolyds</LastName>
<FirstName>Malcom</FirstName>
</Staff>
<Staff>
<StaffID>228</StaffID>
<Rank>Lieutenant</Rank>
<LastName>Brown</LastName>
<FirstName>Bill</FirstName>
</Staff>
<Staff>
<StaffID>1849</StaffID>
<Rank>Sergeant</Rank>
<LastName>John</LastName>
<FirstName>Pepper</FirstName>
</Staff>
</ExagoData>
3

OLAP and MDX Queries

Exago can query OLAP Data Sources using MDX Queries. OLAP Data Sources and Objects are identical to a regular

data base type object, with the following exceptions.

Tech Guide

71 of 168



Data Objects Tech Guide

o OLAP Data Objects will always be MDX Queries written in the Custom SQL Object
o Data Objects must have Schema Access Type set to Metadata and must have Column Metadata set for all

fields.

ODBC Drivers

Exago can use ODBC drivers to connect to Data Sources. When connecting to an ODBC data source an extra option will
appear to set the Column Delimiter(s). The delimiter character depends on which type of data base you are connecting

to.

Examples

MySql
' (grave accent)

MsSql, OLAP
[1 (brackets)

DB2, Informix, Oracle, Postgres
" (quotation marks)

If you don't know which delimiter character to use, contact your database administrator.

Caution. If your data objects have spaces in their names, you must set the correct delimiter in order to access the data.
Otherwise, improper SQL will be generated and you will see errors or erroneous data.

New Data Source
Name
Type [odbc [

Column Delimiter{s)
Schema/Cwner Mame (blank for defaulf)
‘Connection String

Data Objects

Data Objects are the tables, views, methods, stored procedures, functions and custom SQL that you want to make
accessible for reports.

All existing Data Objects are listed in the Main Menu under Data. All Data Objects that are added or edited will be
displayed in a Tab entitled Objects.

o To add a new Data Object click ‘Objects’ in the Main Menu then click the 'Add' button.

NOTE. Data Objects can be added quickly using Automatic Database Discovery.

o To edit a Data Object either double click it or select it and click the 'Edit" button.
o To delete a Data Object select it and click the 'Delete’ button.
e To sawe changes click the 'OK' button or press the ‘Apply’ button.

Each Data Object has the following properties:

Name

Select the Data Object’s Source from the first drop-down. In the second drop-down select a Data Object.

NOTE. This will display all the of the Source’s tables, views, methods, stored procedures, and functions.

e To add custom SQL click the ‘Add Custom SQL’ button next to the Data Object drop-down. For more details see
Custom SQL Objects.

NOTE. The name of tables or views may not contain the following characters: { } (curly braces), [ ] (square brackets), *,'
(comma), *." (period/full stop).

Alias
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The user friendly name for the Data Object. The alias will be displayed to end-users.

NOTE. An alias may not contain the following characters: @ (at sign), { } (curly braces), [ ] (square brackets), ','
(comma), "' (period/full stop).

Unique Key Fields
The columns which uniquely identify a row.
Category

The ‘folder’ used to group related Data Objects. Sub-categories can be created by entering the category name followed
by a backslash then the sub-category name.

Ex. Sales\Clients

Id

A unique value for the Data Object. Ids are required when creating multiple Data Objects with that have the same name
but come from distinct Data Sources. Ids can also be used to optimize Web Senice and .Net Assembly calls. For more
information see Data Object Ids.

Parameters

Parameters that are passed to stored procedures, table functions, Web Senices or .NET assembly methods. Clicking in

the drop-down will bring up a menu. Click the add button (***) and select the parameter from the drop-down list. For more
information see Parameters, Stored Procedures and Web Services & .NET Assemblies.

o Parameter values are passed in the order in which they are listed in the Data Object. It is critical to ensure that the
order is correct.

Tenants Columns
Specify which columns contain tenant information and link the parameters accordingly.

o This setting is used to filter data when multiple users’ information is held within the same table or view and a
column(s) holds information identifying each user. Exago will only retrieve the rows where the column value(s)
matches the corresponding parameter(s).

Column Metadata

Specify any columns that should not be filterable, visible, or that should be read as a specific data type. See Column
Metadata for more information.

Schema Access Type
Specify how Exago should retrieve the schema for the Data Object. There are three possibilities:

o Default — Follow the global Schema Access Type setting in Other Settings.
o Datasource — Queries the Data Source for the schema.
o Metadata — Reads the schema from the stored metadata.

NOTE. For more information see Retrieving Data Object Schemas.

Filter Dropdown Object

Specify an altemative Data Object to be queried when a user clicks the value drop-down in the Filters Menu. This setting
is most likely to be used when the Data Object is a Stored Procedure, Web Senice, or .Net Assembly that takes more
than a few seconds to return data. In this scenario a table or view can be designated to increase performance.

NOTE. The Filter Drop-down Object must have a column with the same name as each column in the main Data
Objects.

Stored Procedures
Stored Procedures offer the ability to use high level code to modify the data set before it is sent to Exago.

Stored procedures must know what sorts and filters the user has set and whether to return the schema, a single column,
or the entire data set.

To accomplish this:

e Use the Call Type, Filter, Column and Sort Parameters in the Programmable Object Settings. These
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parameters will be passed from Exago to identically named parameters in the Stored Procedure.
o Additional parameters may be passed by setting them in the Data Object Tab.

Important Note for SQL Server:
SQL Sener has an attribute called ‘FMTONLY’ that must be handled by all stored procedures.
'FMTONLY" has two possible values:

e ON: The stored procedure will only return the column schema. However all IF conditional statements are ignored
and all of the code will be executed. This setting will fail if the stored procedure contains any temp tables.

e OFF: The stored procedure retums all of the data and the column schema. The stored procedure will correctly
execute IF conditions.

The 'ON' setting will cause problems if there are IF conditions in the procedure; However, only using the 'OFF" setting will
hurt performance if the Call Type Parameter in the Programmable Object Settings is not used.

The following example demonstrates how to use the Call Type, Column, Filter and Sort Parameters to maintain efficiency.

NOTE. For SQL Seners, FMTONLY is set to OFF.

ALTER PROCEDURE [dbo].[sp webrpt person]

@callType INT, —--optional but should be implemented for efficiency

and dropdown support

@columnStr varchar (1000), --optional; used for limiting data for efficiency
@filterStr varchar (1000), --optional; used for limiting data for efficiency
@fullFilterStr varchar (1000), --optional; used for limiting data for efficiency
@sortStr varchar (1000) -optional; may improve performance a bit if used

AS

SET NOCOUNT ON --for performance reasons

SET EMIONLY OFF --force procedure to return data and process IF conditions

declare @sgl varchar (2000)
declare @columnInfo varchar (1000)
if QcallType = 0 —-return schema; don't need to return any rows
begin
set @sgl = 'select * from vw webrpt person where 0 = 1'
end
else
if QcallType = 1 —-return all data for execution
begin
set @sgl = 'select' + @QcolumnStr + ' from vw webrpt person where ' + @filterStr + ' order by '
end
else
if QcallType = 2 --return filter dropdown values; limit # rows to some value

begin
set QcolumnInfo = '[' + QcolumnStr + ']'
set @sgl = 'select top 100 ' + QcolumnInfo + ' from vw webrpt person where ' + @QcolumnInfo + '
end
exec (@sql)
4‘ Atj

Table Value Functions

Table Value Functions can be used as Data Objects. Any available table value functions of a Data Source will be
displayed in the Data Object menu under Functions. Exago handles table value functions similar to views and tables
except it will pass any parameters set in the Data Object Tab or in the Programmable Object Settings.

For more information, see Table-Valued Functions.

Custom SQL Objects

Exago can use custom SQL as Data Objects. Parameters can be embedded in these SQL statements to enable you to
change the statement at runtime.

To add or edit a Custom SQL Data Object click the ‘Custom SQL’ button and a dialog will appear.

Data Object Name

The name of the Data Object to be displayed in the Administration Console.
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Data Source

The Data Source that will be sent the SQL.

Parameter/insert

Select the parameter you want to embed in the statements. Use the ‘Add’ button to mowe the selected parameter into the
SQL statement where your cursor is located. Parameters may also be added manually between @ symbols (ex.

@userld@).
Use the “TEST button to werify that the SQL statement is correct.

Press 'OK' to save the SQL statement or 'Cancel’ to close the dialog without saving.

Custom SQL Object x
Object Mame Data Source Parameter Test
Pivot Table Morthwind v v  Add W
1 select

2 id

3 ma;, (case when fieldId=1 then value else null end) as color,
4 max, (case when fieldId=2 then value else null end} as weight
from Pivot_Example

group by id

+ OK ¥ cancel

Data Object Macros

‘Macros’ can be embedded in Custom SQL Data Objects to make them even more dynamic. Each macro allows for
different SQL to be used according to the circumstances in which the Data Object is being called. Below are the details
and examples of available macros.

IfExecuteMode
(string trueCondition, string falseCondition)

Will include the trueCondition if a user is executing a report. Will include the

Description falseCondition otherwise.
Example select * from wv_webrpt_optionee IfExecuteMode("where [State] = 'CT","")
IfExistReportDataObject

(string dataObjectName, string trueCondition, string falseCondition)

Will include the trueCondition if dataObjectName exists inside the full Exago SQL

Description statement to the data source. Will include the falseCondition otherwise.

select * from wv_webrpt_optionee IfExistReportDataObject("fn_webrpt_grant", "join on

Example fn_webrpt_grant...", ™)

Column Metadata

Column Metadata refers to the properties of each column in the Data Objects. Normally Exago gets the metadata for
each column directly from the Data Source, however, in some cases it may be helpful to override or add additional
information to the metadata.

To modify the metadata of a column, select it and click the ‘Add’ button or double click it. Enter a Column Alias or use
the Data Type, Filterable, and Visible drop-downs to set the desired properties.

Click the ‘Read Schema’ button to quickly create column metadata for each column in the Data Object.
To remove Column Metadata for a column, select it in the right panel and click the 'Delete’ button.

To sawe changes to Column Metadata, click the ‘OK’ button. Click the ‘Cancel’ button to discard changes.
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Select columns to mask

Address

City
CompanyName
ContactName
ContactTitle
Country
CustomerlD
Fax

Phane
FostalCode
Region

& Read Schema

= add =k Add New

Column Metadata

[ Address

[ city

[ CompanyMName

[ P

Data Type Column Alias

String ~

Fitterable Sort and Group-By “alue
True ~

isible

True ~

¥ OK

The following properties of each column can be modified:

Column Alias

The name of the Data Field that the end-users see.

Column Description

Selected columns

Column Descripticn

M Cancel

X X X

(v2016.3+) Data fields can have description text added. If the data field is hovered over in a selection screen in the Report
Designer, the description text will pop up:

€200
)

+ 00
ZOoo

Search report names. ..

» Sample Reports

Employees

Address
BirthDate
City
Country

TestReport

Getting Started

Employeel
Frtension

Unigue Employee Mumber

BN S

HireDate

Page F

Foo
Emple

Admins can add description text to data fields on an application-wide level. To do so, using the Admin Console, expand
the Objects dropdown, and double-click on the desired data object, or select it and press Edit. Then, in the object menu
click on the rectangle next to Column Metadata. This will open the Column Metadata dialog.

Double-click on the desired data field, or click-and-drag it to the Selected Columns pane, or select it and press the Add
button. You have two options for adding description text: Using Plain Text or editing the Language File.

Plain Text
Selected columns

[l EmployeelD

Data Type Column Alias

-

Fitterable Column Description

True ~  Unigue Employes Number
isible Sort and Group-By Yalue
True -

7

Hovwertext can be added verbatim in the Column Description field. In-line HTML tags like <b> can also be used if desired.
Press OK when done, then Apply the change.

Language File

<AdminObjects:

2384
2365
2386
Az salam

<element id="eNum" toocltip="Unique Employee Id"></elementy
<element id="AdminSQLObjectTestLbl">Test</element>

mmd AN AR kA F AT I Ar T BT R T+ " ThaA

ar mama Lam Fha Ao ahdas
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Selected columns

[l EmployeelD 4
Data Type Column Alias
Fitterable Column Description
True ~ | |eMum
isible Sort and Group-By Yalue
True - fx

You can also add description elements to the language file, and reference them in the Column Description field.

In the language file, add new elements to the <AdminObjects> section using the following format:
<element id="uniqueIdentifier" tooltip="Description Text"></element>

HTML tags must be encoded like so:

e Encode < as &lt;
e Encode > as &gt;
e Encode " as &quot;

For example, the following tooltip string encodes "<b>Description</b> Text", which appears as "Description Text" in the
howertext.

<element id="uniqueldentifier" tooltip="&lt;b&gt;Description&lt;/b&gt; Text"></element>

After adding the element to the language file, add the id string to the Column Description field. Press OK when done, then
Apply the change.

Data Type
The type of data Exago should treat the Data Field as (ex. DateTime).

o Valid values for Data Type include: String, Date, Datetime, Time, Int, Decimal, Image, Float, Boolean, and Guid.

Filterable
Whether this field can be used to filter reports. The available options are:

o All (True) - This field can be used as a report filter in the Advanced/Express/ExpressView Designers, Dashboard
Designer, and Scheduler, and as an interactive filter in the Report Viewer.

o Dynamic (False) - This field can only be used as an interactive filter in the Report Viewer.

o Static (v2017.1.2+) - This field can only be used as a report filter in the Advanced/Express/ExpressView
designers, Dashboard Designer, and Scheduler.

o None (v2017.1.2+) - This field cannot be used as either a report filter or interactive filter.

Sortable
(v2016.3+) If set to 'False' the Data Field will not be listed in the Sorts menu.

Admins can now indicate whether data fields should appear in the Sorts menu using the Sortable dropdown.

NOTE. This toggle does not prevent data fields from being sorted by. Users can still enter the data fields manually as a
formula, or use the data fields within a sort formula.

Visible

If set to 'False' the Data Field will not be listed for users.

Sort and Group-By Value

(v2016.3+) Specify a custom formula by which columns should be sorted and grouped by the application.

This field allows admins to specify how columns should be sorted and grouped by the application. By default, Exago will
sort (and group) columns based on the data in the column. You can use this metadata field to specify different data by
which the column should be sorted.

For example, you may have a custom column Employees.FullName like the following:

{Employees.FirstName} &' ' & {Employees.LastName}
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By default, Exago would sort this field on the full string. You may want to sort on just the LastName, instead. In Sort and
Group-By Value, enter {Employees.LastName}, and the column will sort on LastName.

Ancther common example is sorting a Month field by the numeric representation of the month instead of the name. Since
this value accepts any valid Exago formula (except aggregates), custom functions can also be used.

NOTE. The sort-and-group field must have a one-to-one relationship with the data field. Otherwise, unexpected behavior
could occur.

Custom Columns

(v2016.3+) Custom columns are a way to add columns to Exago that don't exist in the database. This is completely
transparent for the users; they can then use them like any other column. New data fields can be created from composite
or interpreted data fields. You could even use a formula to create data from scratch. Admins often use custom columns
to make popular formula sorts available on an application-wide level.

Admin Console

To add a custom column using the Admin Console, expand the Objects dropdown and double-click on the desired data
object, or select it and press Edit. Then, in the object menu click on the rectangle next to Column Metadata. This will
open the Column Metadata dialog.

Press the Add New button. Enter a name for your data field in the dialog box.

Column Metadata X
Select columns to mask
Address Selected columns
BirthDate fx FulName x
City
Country
EmployeelD
Extension
FirstName
HireDate
HomePhaone
LastName
Notes
Fhoto
PhotoPath
PostalCode
Region
ReportsTo Data Type Column Alias Column Description
SocialSecurityNumber String =~ FulMame First and Last Mame
Title
TitleOfCourtesy \isible Column Type
True ~ | |Exago Formula~
Column Value Saort and Group-By Value
a] - -
&y Read Schema {Employees.FirstName} & ** & {Employ... [ {Employees.LastName} Jx
4= Add =k Add New
oK X Cancel

Data Type, Column Alias, and Column Value are required fields. In the Column Value field, press the formula button to
bring up the Formula Editor.

Press OK when done, then Apply the change.

Config File

To add a custom column by editing the config file, open the config file in a text or xml editor. Data objects are <entity>
elements. Locate the entity and add a new <column_metadata> element:

<entity>

<column metadata>
<col_source>ExagoFormula</col source>
<col name>FullName</col name>
<col type>string</col type>
<col alias>FullName</col alias>
<col description>First and Last Name</col description>
<filterable>false</filterable>
<col value>{Employees_0.FirstName} &amp; ' ' &amp; {Employees 0.LastName}</col value>
<col sortandgroupbyvalue>{Employees 0.LastName}</col sortandgroupbyvalue>
</column metadata>
</entity>

Bold fields are required.

<col_source>ExagoFormula</col_source> is static. This is the same for every <column_metadata>.
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In <col_value> and <col_sortandgroupbyvalue>, data fields are identified by their id, not their alias.

Acceptable values for <col_type>: string, date, datetime, time, int, decimal, image, float, boolean, guid, currency
Sawe the config file when done, and restart the web sener.

Examples

There are a lot of options for what kinds of data fields you can create:

Transform or interpret an existing data field:

o Right({Employees.SocialSecurityNumber},4)
¢ Month({Orders.OrderDate})

Combine multiple data fields together:

o {Employees.FirstName} & '' & {Employees.LastName}
Create new data from scratch:

¢ Random(0,65536) (uses a custom function)

And much more!

NOTE. Custom columns cannot be used as Filters, or inside Aggregate Formulas.

Retrieving Data Object Schemas

Many of the dialogs throughout Exago require schema information (ex. column name, data type, etc.). By default these
dialogs query the Data Sources for the schema. This process, however, may cause performance issues if the Data
Sources take a considerable amount of time to retum the schema.

To enhance performance, schema information can be stored as Column Metadata. Exago can then read the Column
Metadata instead of querying the Data Source.

NOTE. While storing the schema as Column Metadata improves performance, updates to the Column Metadata will be
required whenever columns are added, removed, or retitled.

For Exago to retrieve schema information from Metadata:

1. In Other Settings, set ‘Schema Access Type’ to ‘Metadata’. This will force Exago to get all schema information
from Metadata for all Data Objects.

NOTE. Altematiely this setting can be overwritten for individual Data Objects by setting the ‘Schema Access Type’
property.

2. For each Data Object open the Column Metadata Menu.
1. Click the ‘Read Schema’ button. A message will appear asking you to confirm you want to continue. Click
'OK..
2. Click 'OK' to close the Column Metadata Menu.
3. Press 'Apply' or 'OK' to sawe the Data Objects.

NOTE. Other metadata options such as aliasing can still be utilized.

Data Object Ids
There are three ways in which you can utilize Data Object Ids.
Adding Multiple Data Objects with the Same Name

Ids are used distinguish Data Objects that have the same name but come from different Data Sources. When adding
multiple Data Objects with the same name, make sure each Data Object has a unique Id.

Avoiding Issues from Changes to Object Names

Pronviding Ids for all the Data Objects will awid issues if the name of the underlying tables, views, or stored procedures, is
changed.

Calling a Single Web Service/.Net Assembly/Stored Procedure

Web Senices, .Net Assemblies, and Stored Procedures comprise a group called Programmable Data Objects. These
Objects can retrieve parameters from Exago and the host application in order to control what data is exposed to the user.
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Generally for Web Senices and .Net Assemblies each Data Object calls a distinct method. Similarly each Stored
Procedure is its own Data Object. By using Data Object Ids a single method/stored procedure can be called. This
method can then retum data or schema based on the Data Object Id.

To call a single Web Senvice/.Net Assembly/Stored Procedure:

¢ Provide a name for ‘Data Object ID Parameter Name’ in Programmable Object Settings
o Create a method/procedure in your Senice/Assembly/Procedure that utilizes the Object Id Parameter to retum the
appropriate data/schema. (see example below)
e For each Data Object:
o Select ‘Object’ in the Main Menu and click the ‘Add’ button
o Select the single Senice/Assembly/Procedure
o Provide an Alias and an Id for the Object
o Select the key columns
Click 'Apply' or 'OK' to save the Object.

o

Ex. This stored procedure uses the Object Id Parameter (@objectID) to retum different data/schema information for
different Object Ids.
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ALTER PROCEDURE "dbo"." Exago Example" @callType INT, @objectID nvarchar (max) AS

SET

NOCOUNT
ON

SET

FMTONLY OFF if @objectID = 'Produce’ begin if @callType = 0 begin SELECT
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock

FROM
Products

WHERE
CategoryID = 1001

end

else if @callType = 1 begin SELECT
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock

FROM
Products

ORDER BY
ProductID

end

else if QcallType = 2 begin SELECT
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock

FROM
Products

ORDER BY
ProductID

end

end if @objectID = 'Orders0Q' begin if Q@callType = 0O begin SELECT

OrderID,

OrderDate,

RequiredDate,

ShippedDate,

CustomerID

FROM

Orders

WHERE

CustomerID = 0

end

else if @callType = 1 begin SELECT

OrderID,

OrderDate,

RequiredDate,

ShippedDate,

CustomerID

FROM

Orders

ORDER BY

OrderID

end

else if @callType = 2 begin SELECT

OrderID,

OrderDate,

RequiredDate,

ShippedDate,

CustomerID

FROM

Orders

ORDER BY

OrderID

end

end
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Reading Images from a Database

Exago can read images from a database and load them directly into a cell of a report. When images are stored in a
database as a binary string there are two ways that Exago can load them into a report.

1. In the Administration Console edit the Data Object that contains the images. Open the Column Metadata Menu
and for the image column set Data Type to ‘Image’. Next, simply place the Data Field containing the images into
the desired cell of a report. Upon execution the images will be loaded into the cell.

2. Place the Data Field that contains the images into the Loadlmage function. Upon execution Exago will interpret
the binary and load the images into the cell.

Joins

Caution
The Joins window is recommended for advanced users only.

Joins describe how the categories on a report are related to each other. When two categories are joined, a field in the first
category is associated with a field in the second category. Wherever a value in the first category's field matches a value
in the second category's field, that value's rows from each category come together to form a composite row. The table
produced by all the composite rows is the resulting data that appears on the report.

For example, take the following categories, Orders and Products. The Orders.Productld field corresponds with the
Products.Id field. When the categories are joined from Orders.Productld to Products.ld, the rows are connected wherever
those two fields have matching values.

Categories joined on Orders. ProductId >> Products.Id

The result of this join is the following composite rows. These categories have a one-to-one relationship, because each
row in the "left" category joins at most one row in the "right" category.

Joined categories. Products.ld is omitted.

Tip
Categories could be joined along more than one set of fields; composite rows are formed only when all sets have
matching values.

For two categories to be copresent on a report, there must be a join path between them. They are either directly joined,
or there is a path through one or more intermediate categories. You do not have to configure joins manually - they already
exist in the environment. However, if you want to leamn how to add or adjust joins on a per-report basis, this topic will
explain the options that are available.

Join Types

The join that was previously described is the most common type of join, an inner join. When an inner join is applied, rows
in either category that have no matching row in the other are excluded from the resulting table. However, you may not
want to exclude these rows. To do so, you can change the type of join to an outer join.

For example, the row in the Products category with Id: 12 has no matching row in the Orders category. With an inner
join, this row is excluded from the output. If you want to see the Products rows that have no matching Orders row, you
can change the join type.

To do so, from the { Report Options > *** Advanced > =~ Joins window, select the Products data that does not
have Orders data check box.

Left outer join

This changes the join between these categories to a left outer join, because all rows from the /eft category are included.
The following rows result:

Joined categories with all Products rows. Products.ld is omitted.

Similarly, selecting the Orders data that does not have Products data check box changes the join to a right outer
Jjoin, which includes all rows from the right category. Selecting both check boxes includes all rows from both categories;
this is a full outer join.
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Relationship Types
There are two types of join relationships: one-to-one and one-to-many.

In the previous example, the relationship between the categories is one-to-one, because each row in the left category
joins at most one row in the right category. Some categories have a one-to-many relationship, where each row in the left
category joins zero or more rows in the right category.

A one-to-many relationship from categories Xto Y is represented in the following diagram:

Each X is joined to one or more Y

Reports with a single one-to-many join are well suited to grouping by the left category. The data in these reports is
generally well-formed and understandable.

However, when a report has multiple categories with one-to-many joins, data can appear more disorganized and
confusing. For example, the following diagram represents data from three categories, X Y, and Z where the relationships
between X-Y and X- Z are both one-to-many:

Each X has 1 or more Y, and 1 or more Z

Because Y and Z are not directly related to each other, there are many rows with only Y or only Z This can cause the
report to be significantly larger, and to be difficult to read and interpret. This occurs even with inner joins, the most
restrictive type, because by default there is no logic that deals with the relationship between Y and Z

Read on for different ways of improving the structure of a report with multiple one-to-many joins.

Cartesian Processing

You could fill the blank spaces with supplementary data by disabling Special Cartesian Processing from the Joins
window. Blank cells are filled in with data that is repeated directly from the previous row. The following diagram
demonstrates how this works:

Disabling Special Cartesian Processing

The shaded cells represent data that has been repeated from the previous row. This can make the report more readable.
However, this approach poses a problem: Blank cells indicate a lack of a relationship between two fields, so filling in
these spaces with artificial data can obfuscate any relationship between Y and Z This can decrease the accuracy of the
report.

There are better ways to improve the readability of such a report without sacrificing accuracy:

o Use repeating groups to show the X-Y and X- Z relationships in entirely separate sections. This is suitable if any
relationship between Y and Z is irrelevant or nonexistent. See Sections for more information.

o Hide some or all of the rows which do not have data for both Y and Z This is suitable if you want to highlight an
implicit or indirect relationship between Y and Z This is done by imposing Must constraints. Read on for more
information.

Must Constraints

Although Y and Z are not directly joined, they are both related to X so there is an implicit relationship between them. If
you examine Y and Z alone, you will notice that they technically exhibit a full outer join.

Y and Z, without X

Because all the rows from Y and Z that relate to Xare shown, there are rows with both Y and Z or with only one of either.
Must constraints allow you to change the implicit join type, and in doing so, eliminate rows that lack data from one or
both categories.

To set Must constraints, from the Joins window, locate the MUST panel for the applicable categories:

Setting Must constraints
Do one of the following:

o Select the Y check box - Left outer join: Any rows without Z are removed
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o Select the Z check box - Right outer join: Any rows without Y are removed

o Select the Y and Z check boxes - Full outer join: Any rows without Y or Z are removed

Effect of setting various Must constraints

Modifying Joins

The Joins window shows all direct and implicit joins on the report. Direct joins can be added, modified, or removed from
the report.

To add a new join:
1. Click ¥ Add.
2. Add From and To fields.

With multiple From and To fields, the first From field is joined to the first To field, the second From to the second

To, and so on. Every From field must have a respective To field, and vice versa. Use the “* Up and ™ Down
arrows to reorder the join fields.

Tip
If there are multiple join fields, only the rows that satisfy all the conditions are joined.

3. Click OK.
To modify a join's fields:
1. Click the Edit [% icon next to the join to edit.
2. Add, remowe, or modify From and To fields.
3. Click OK.
To remowe a join, click the Delete * icon next to the join to delete, then click OK.

To restore the default joins, click C Recreate, then click OK.

Parameters

Parameters are used throughout the Exago application to store values. Although parameters can be created and given a
default value in the Administration Console, parameters are designed to be set at runtime through the API.

In Exago parameters can be used to:

o Pass values to Web Senices, .NET Assemblies, or custom SQL Data Objects.
e Set tenant values to assure security in a multi-tenant environment.

‘ For more information see Data Objects.

e Pass values into cells and formulas of a report. To display a non-hidden parameter in a cell type
‘=@ParameterName@'.

| NOTE. Parameters ARE case sensitive.

e Pass values into custom functions. For more information see Custom Functions.
e Create a custom dropdown list of values for user selection on a report prompt.

All existing Parameters are listed in the Main Menu under Data. All the parameters that are added or edited will be
displayed in a Tab entitled 'Parameters’.

e To add a new parameter click ‘Parameters’ in the Main Menu then click the 'Add' button.
o To edit a parameter either double click it or select it and click the 'Edit' button.

o To delete a parameter select it and click the 'Delete' button.

e To sawe changes click the ‘OK’ button or press the ‘Apply’ button.

Each Parameter has the following properties:

Name
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A name for the parameter. Prompting parameters are sorted alphabetically by name unless otherwise specified or unless
there are dropdown parameters with dependencies.

Type
The type of parameter being used.
Value

The default value of a parameter. This is intended to be overwritten at runtime through the API. Date values should be
entered in yyyy-MM-dd format.

Hidden
Check hidden to disable this parameter from being used by users in cells and formulas.

Prompt Text

Give non-hidden parameters a prompt text to query the user for a value at the time of report execution. Leave blank to use
the default value.

Parameter Dropdown Object

Optional Data Object for populating the parameter as a drop-down selection list. Only applicable with prompting
parameters. Commonly used in conjunction with programmable data objects (such as stored procedures).

Stored Procedure Parameters
A list of preexisting Exago parameters to be used as variables for a selected stored procedure.
Value Field

A column from the data object or custom SQL that sets that actual value of the parameter at runtime. This represents a
set of values that are not displayed to the end user but are instead used when parameter values are required in custom
SQL or stored procedures, or other sener side processing.

Display Value Field

A column from the data object or custom SQL that sets the display value of the parameter for the dropdown selector.
This represents the set of values that should be presented to the end user when they are executing or scheduling a
report.

Display Type

The display value data type.

Roles

This chapter explains how to use the Roles to control access to Data and override the General Settings.
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Programmable Object Settings
Filter Settings
Database Settings
Scheduler Settings
User Settings
Other Settings
22 Roles
» Extensions

e To add a new role select ‘Roles’ in the Main Menu then click the 'Add' button.
o To edit a role either double click it or select it and click the 'Edit' button.
o To delete a role select it and click the 'Delete’ button.

About Roles

Roles are created to specify how a user or group of users interfaces with Exago. Roles can restrict access to folders or
Data Objects. Roles can also owerride the General Settings.

NOTE. Exago was designed to be an integrated reporting solution for other applications using the application’s own
security and authentication methods. Although you can create Roles through the Administration Console, Roles are
typically created through the API to dynamically set a user's access. For more information see the articles
regarding Integration and API.

Roles hawe five sections to control access: Main, General, Folders, Objects, and Filters.
Main

Controls the broad properties of the Role.

General

Owerrides General Settings.

Folders

Controls which report folders a role can see and edit.

Object

Controls which Data Objects a role can access.

Filter

Provides row lewel filters on Data Objects.
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Main Settings
The main settings control the broad properties of the Role.
Main
10 Active nclude All Folders All Folders Read Only Allow Folder Managment  Include All Data Objects

The Main role settings are:
Id

A name for the role.
Active

Check to activate the role.
Include All Folders

If checked, all folders that are not listed in Folder Access will be available. If unchecked, only those listed in Folder
Access will be available.

All Folders Read Only

If checked, all folders that are not specified in Folder Access will be execute-only. If unchecked, only those specified in
Folder Access will be execute-only.

Allow Folder Management
Displays/Hides the Folder Management Icon and functionality.
Include All Data Objects

If checked, all Data Objects that are not listed in Objects Access will be available. If unchecked, only those listed in
Objects Access will be available.

General Settings

The General Settings of a Role override the Global General Settings. Utilize the API in order to overwrite additional
settings for a user or group of users. For more information see API.
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General

Date Format

Time Format

DateTime Format

MNumeric Separator Symbal

Nurmeric Currency Symbol

MNumeric Decimal Symbol

Server Time Zone Offset 0
Show Grid Lines in Report Viewer

Allow Creation/Editing of Express Reports
Allow Creation/Editing of Advanced Reports
Allow Creation of Crosstab Reports

Show Crosstab Wizard

Allow Creation/Editing of Dashboards

Allow Creaticn/Editing of Chained Reports
Allow Creation/Editing of ExpressViews
Allow Editing ExpressView with Live Data
Show Styling Toolbar

Show Themes

Show Grouping

Show Formula Button

Database Timeout 0
Read Database for Filter Values

Show Report Scheduling Option

Show Email Report Options

Show Schedule Reports Manager

Scheduler Manager User View Level

Allow Creation/Editing of Dashboard Visualizations

The following settings can be overwritten:
Report Path

The parent folder for all reports. The Report Path can be:

o Virtual Path
o Absolute Path: used to provide increased security (ex. C:\Reports)
e Web Service URL or .NET Assembly: using a Web Senice or .NET Assembly allows reports and folders to be
managed in a database. For more information see Report Folder Storage & Management.
o A Web Senice should be formatted as ‘url=http://\WWebSeniceUrl.asmx’. A .NET Assembly should be
formatted as ‘assembly = AssemblyFullPath.dll;class-Namespace.ClassName’.

Date Format

The format of date values. Can be any .NET standard (ex. MM/dd/yyyy). Leawe blank to use the browser culture.
Time Format

The format of time values. Can be any .NET standard (ex. h:mm:ss tt). Leave blank to use the browser culture.

Date Time Format

The format of date-time values. May be any .NET standard (ex. M/d/yy h:mm tt). Leave blank to use the browser culture.

Report Path ¥

NOTE. For more details on .NET Date, Time and DateTime Format Strings please see

Numeric Separator Symbol

Symbol used to separate 3 digit groups (ex. thousandths) in numeric values. The default is *,’.
Numeric Currency Symbol

Symbol prepended to numeric values to represent currency. The default is ‘$’.

Numeric Decimal Symbol
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Symbol used for numeric decimal values. The default is “.".

Server Time Zone Offset

Value that is used to convert sener to client time (the negation is used to conwert client to sener time). Leave blank to
use sener time, or to use External Interface to calculate value.

Show HTML Export Grid Lines

Sets the default value for the HTML output option Show Grid. This can be modified in the Options Menu of the Report
Designer.

Show Crosstab Reports

Displays/Hides the Crosstab Report Wizard and Insert Crosstab button in the Report Designer.
Show Express Reports

Displays/Hides the Express Report Wizard.

Show Styling Toolbar

Displays/Hides the styling tools in the Layout tab of the Express Report Wizard.

Show Themes

Displays/Hides the Theme drop-down in the Layout tab of the Express Report Wizard.
Show Grouping

Displays/Hides the grouping tools in the Layout tab of the Express Report Wizard.
Show Formula Button

Displays/Hides the Formula Editor button in the Layout tab of the Express Report Wizard.
Show Advanced Reports

Displays/Hides the Advanced Report Wizard and Report Designer.

NOTE. If ‘Show Advanced Reports’ is False then attempts to edit Advanced or Crosstab reports will cause an ‘access
denied’ message. Additionally if 'False’, users will not be able to create Crosstab reports.

Database Timeout
Maximum number of seconds for a single query to run.
Read Database for Filter Values

Enable/Disables filter drop-downs to contain values from the database. Set to 'False' only if retrieving values for the drop-
down will take more than a couple of seconds.

Show Report Scheduling Option

Displays/Hides the scheduler icon on the Main Menu. Set to 'False' to disable users from creating scheduled reports.
Show Email Report Options

Displays/Hides the email report icon on the Main Menu. Set to 'False' to disable users from emailing reports.
Show Schedule Manager

Displays/Hides the scheduler manager icon on the Main Menu. Set to 'False' to disable users from editing existing
schedules.

Scheduler Manager User View Level

Controls what information each user can see in the Schedule Manager. These lewels utilize the Parameters companyld
and userld. There are three possible values:

e Current User: Can only view and delete report jobs that have been created by that user.
e All Users in Current Company: User can only view and delete report schedules for their company.
e All Usersin All Companies: User can view and delete report schedules for all companies (administrator).
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Folder Access

The Folder Access controls which report folders are \isible and executable for the Role.

Folders

Folder Name Read Only

== Add

NOTE. If Include All Folders is checked this list will deny access to the folders added. If unchecked, the list will allow
access to the folders added.

o If All Folders Read Only is checked this list will overwrite the setting when a folder is added without the 'Read
Only' option checked.

To add a folder click 'New.
Click in the 'Folder Name' column and select the Folder you want to add.
To make the folder execute only check the box in the '‘Read Only' column.

To delete a folder click the 'Delete’ button.

Objects Access

The Objects Access controls which Data Objects are accessible to the Role. A report can only be executed if the Role
has access to all the Data Objects on the report.

Objects
Data Object Name
o= Add
NOTE. If Include All Data Objects is checked this list will deny access to the Data Objects added. If unchecked the
list will allow access to the Data Objects added.

To add a Data Object click 'New.
Click in the 'Data Object Name' column and select the Object you want to add.

To delete an Object click the 'Delete’ button.

Filters Access

The Filter Access provides a means to filter a Data Object by Role.
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Filters
Data Object Name Filter String

o= Add

To add a filter click 'New'.
Click in the 'Data Object Name' column and select the filter you want to add.

Enter the filter string in the Filter String Column. The filter string should be Standard SQL. This string will be added to the
"Where' clause.

To delete a filter click the 'Delete’ button.

NOTE: Role filters do not support parameters as part of the filter string. Instead, use the API to programmatically insert
the value of the parameter into the filter string.

Custom Functions

Exago comes with a large number of predefined functions that can be used to make formulas in the Formula Editor. As
an administrator you may create additional custom functions using high lewel coding languages. Custom functions will be
accessible to users in the Formula Editor or by typing their name into a cell of a report. Functions can be added to a
preexisting function category or a function can be put into a new custom category.

Functions can be written in C#, JavaScript or VB. Net. Functions can take as few or many arguments as inputs, provided
that the max number of arguments is greater than or equal to the minimum number of arguments.

Functions written in C# and VB.Net can get and set elements from the current session of Exago such as Parameter
values. See Exago Session Info for more information.

Creating Functions

To create a custom function, select ‘Functions’ in the Main Menu and click the 'Add' button. This will open a Custom
Function tab.

Each Custom Function has the following properties:

Name

A name for the function that will be displayed to the end users.
Description

A description of the function that will be displayed to the end users.

NOTE. To support multi-language functionality, if the description matches the Id of any element in the language files,
then the string of that language element will be used instead of the description. For more information see Multi-
Language Support.

Minimum Number of Arguments
(pre-v2017.2) The minimum number of values that an end user must enter in the function separated by commas.
Maximum Number of Arguments

(pre-v2017.2) The maximum number of values that an end user may enter in the function separated by commas.

NOTE. Arguments are passed to your code as an array of generic objects so there can be as many arguments as
desired. The argument array is accessed by args| ]. Arguments are passed into the function as objects.

Category

A way of grouping similar functions. You can assign custom functions to an existing Exago Category or create a new
Category. To create a new Category, select “Other”. An input field will appear. Leaving this field blank will assign your
Function to the “Other” Category in the Exago Formula Editor. A non-empty value in this field tells Exago to create a new
Category with the specified name.
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NOTE. To support multi-language functionality, if the custom category matches the Id of any element in the language
files, then the string of that language element will be used instead of the description. For more information see Multi-
Language Support.

Language
The high-level language of the code for the function. Can be C#, JavaScript or VB.Net.
Reference

A semicolon-separated list of any DLLs that need to be referenced by the Custom Function. The DLLs must be present in
the Bin folder of the Exago web application, as well as any scheduler bin folders.

NOTE. System.dll does not need to be listed as a reference as it is already available.

Program Code

The program code for your Custom Function. Press the green check mark to verify the code executes properly.

NOTE. Parameters may be referenced within custom functions by placing their name between @'s.

Arguments

Starting with version 2017.2 there are several enhancements to the way function arguments are implemented and used.
See Formula Editor for details on how argument and function information will appear for end-users.

Click Edit Argument Info to show a dialog for managing arguments. Then click Add Argument for each argument the
function will have. Arguments have the following properties:

Name

The name of the argument, which will appear as a placeholder in the function parentheses and in the function's
description tooltip.

Description

A description for what the argument is used for. You should mention the expected data type, if it is not obvious. This will
appear in a tooltip when the placeholder name is selected.

Can also be a language file ID.
Optional

Whether this argument is required or optional. Optional arguments are surrounded by brackets [ ] in the function's
description tooltip.

Variable Argument Count

If selected, the last argument in the list accepts more than one value. Variable arguments are followed by an ellipsis (...)
in the function's description tooltip.

Exago Session Info

Custom Functions can access the Exago session state through a “sessioninfo” variable. Access to sessioninfo allows
powerful new capabilities such as the ability to persist values across function invocations, allowing each invocation to be
aware of previous calls and behave accordingly.

NOTE. sessioninfo can also be accessed in Server Events, Action Events, and Assembly Data Sources.

The second example in the next section provides a function that retums the line number of the report being written by
creating and incrementing a Stored Value which exists only for the report execution.

The following properties are available:
Pagelnfo

This is the parent of all information in the current session. Included is the active Report and SetupData objects.

NOTE. Since the Report and SetupData objects are accessed frequently, direct pointers are included for these objects.

Report
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An object that contains all of the report’s Data Object, sort, filter, and layout information.

SetupData

An object that contains all of the session’s configuration setting including Filters, Parameters, Data Objects, Joins,
Roles, etc.

Companyld
Contains the value specified by the companyld Parameter.
Userld

Contains the value specified by the userld Parameter.

The following methods are available:

GetReportExecuteHtml (string reportName)

A method that executes the specified report and retums its html output. This could be used to embed a report within a
cell of another report.

NOTE. The reportName’ is relative to the session’s report path.

GetParameter (string parameterName)

A method that retums the specified Parameter Object. 'GetParameter’ first looks in the Report Parameter collection,
parameters being utilized by the report, and then in the Config Parameter collection, as well as other parameters such as
hidden parameters or multi-tenant values.

GetReportParameter (string parameterName)

A method that retums the specified Parameter object that is utilized by the report being executed.

Ex. If a parameter is prompting a user for a value it will be available with the prompted value.

GetConfigParameter (string parameterName)

A method that retums the parameter object stored in the default configuration.

| Ex. Any parameter that is not being utilized by the report being executed.

WriteLog (string text)

A method that writes the specified text to the Exago’s log file.

NOTE. The following methods utilize Stored Values which are objects that can be created and set by custom functions
during report execution to pass data between custom function calls. Stored Values only exist for the duration of report
execution.

GetStoredValue (string valueName, object initialValue = null)

A method that retrieves a Store Value. If a there is no Stored Value with the specified valueName, then one will be
created with the specified initialValue.

SetStoredValue (string valueName, object newValue)

A method that sets the value of a Store Value. Setting newValue to 'null' will delete the Stored Value.

Calling Exago Functions

Cases may arise where you want to call an existing function within your Custom Function. Using the class CellFormula
and retuming the method CellFormula. Evaluate().

Example
The following are two examples of Custom Functions.
Name — RewerseString

Description — Rewerses characters in the input string
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e Minimum Number of Arguments — 1
e Maximum Number of Arguments — 1
Language — C#

Category — Other

Program Code —

string inputString = args[0].ToString();
char[] inputChars = inputString.ToCharArray() ;
System.Text.StringBuilder reverseStringSb = new System.Text.StringBuilder ("");

for (int i = inputChars.Length - 1; i >= 0; i--)
{
reverseStringSb.Append (inputChars[i]) ;
}
return reverseStringSb.ToString() ;

Name — LineNumber
Description — Displays the number of the line of the report.

e Minimum Number of Arguments — 0
e Maximum Number of Arguments -0
Language — C#

Category — Other

Program Code —

// this function creates a Stored Value and increments the value by 1 each time the value is render
int i = (int)sessionInfo.GetStoredValue ("IncrementNumber", 0);

// increment the value by 1 and return
sessionInfo.SetStoredvalue ("IncrementNumber", ++i);
return i;

4‘ Alj

Default Custom Functions

Starting with version 2017.2, Exago Bl ships with several built-in custom functions. These are functions that are common
in many reporting environments, but the manner in which they work may be different depending on locality, time zone, or
other factors. For this reason, these functions have been exposed in the Admin Console so that administrators may
change how they work.

Note: If these functions are unawailable, such as on an upgrade, you can use the following setting to restore them to the
configuration:
( Filter Settings ) Restore All Default Formula Functions

The following custom functions ship with Exago BI:

MonthName

Given a date value, returns the name of the month of the date. The month name is retrieved from the active language
dictionary. So, for example, given the date "01/01/2017", MonthName will retum "January" in an English-speaking
environment, and "Enero" in a Spanish-speaking one.

QuarterName

Given a date value, retums the fiscal quarter of the date, as "Q1", "Q2", "Q3", or "Q4". By default, Q1 encompasses
January 01 - March 31, Q2 encompasses April 01 - June 30, Q3 encompasses July 01 - Sept 30, and Q4 encompasses
Oct 01 - Dec 31. But since different countries or financial landscapes may use different systems of quarters, the behavior
of the function is exposed and customizable.

QuarterNumber

Given a date value, retumns the fiscal quarter of the date, as "1", "2", "3", or "4". Otherwise, this function has the same
behavior as QuarterName.

Custom Filter Functions

Custom Filter Functions provide the ability to make functions that will dynamically calculate a value for a filter using high
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level code.
Filter Functions can be written in C#, JavaScript, or VB. Net.

Filter Functions written in C# and VB.Net can get and set elements from the current session of Exago, such as
Parameter values. See Exago Session Info for more information.

Creating Filter Functions

To create a custom function, select ‘Date Functions’ in the Main Menu and click the Add button. This will open a Date
Function tab.

Each Custom Date Filter Function has the following properties:

Name

A name for the filter function that will be displayed to the end users.

Description

NOTE. To support multi-language functionality, if the filter function’s name or description prepended with *_wrFunctionld’
matches the id of any element in the language files, then the string of that language element will be displayed to the
user instead of the function name/description.

o For the example function below you could create a language id ‘Begining_of Month_wrFunctionld’. The string
associated with this id would be displayed instead of the name. For more information see Multi-Language
Support.

Filter Type

Determines the "data type" of filters that the filter function should be available for.

List Order

The order the filter function will appear among other filter functions of the same type. Functions with a lower number will
appear higher on the list. If two functions have the same list value they will display in alphabetic order. All of the built in
filter functions start with list value 100 or greater.

Language
The high-level language of the code for the date function. May be C#, JavaScript, or VB.Net.

Reference

A semicolon-separated list of any dlls that need to be referenced by the Date Function. If the dlls are not accessible in
the GAC then the dlls must be copied to the 'Bin' folder of Exago or the reference should point to their physical path.

NOTE. System.dll does not need to be listed as a reference as it is already available.

Program Code

The program code for your Date Function. The code must return a DateTime value. Press the green check mark to verify
the code executes properly.

NOTE. Parameters may be referenced within custom functions by placing their name between @'s.
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3 FirstDayOfCurrentMonth %

Mame FirstDayCfCurrentMonth

Description FirstD ayOfCurrentMonth

Filter Data Type date v

List Crder 13 =
Language | CSharp v References W
Namespaces

1 return new DateTime(sessionInfo.Today.Year, sessionInfo.Today.Month, 1)
Example

The following is an example of a Custom Function.

e Name — Beginning_of Month
e Language — C#
e Program Code —

// retrieve the first day of the current month

DateTime now = DateTime.Now;

DateTime FirstDayInMonth = new DateTime (now.Year, now.Month, 1);
// return as date time

return FirstDayInMonth;

Custom Options

This chapter explains how to create Custom Options. Custom Options provide a modifiable menu for end users to set
values that can be utilized by Custom Functions, Sener Events, or the API.

e To add a new Option select ‘Custom Options’ in the Main Menu then click the add button.
o To edit an existing Option either double click it or select it and click the edit button.
¢ To delete an Option select it and click the delete button.

About Options

Custom Options allow for the definition of settings that users can be modify on a per-report basis in the Report Designer.
Options can be accessed during report execution by Sener Events or Custom Functions.

The name of each option can be controlled on a per-user basis using our multi-language feature. Custom Options can
store several types of data such as integer, boolean, text, etc. Each data type provides an appropriate Ul element for the
user to select a value.

Creating Options

To create a Custom Option, select ‘Custom Options’ in the Main Menu and click the 'Add' button. This will open a
Custom Options tab.

Each Custom Option has the following properties:

Id

The unique Id of the option. The Id is used in accessing the option and may be displayed in the Custom Options Menu as
the user sets its value on a report.

NOTE. To support multi-language functionality, create an element in the language file(s) with an Id that matches the
Option’s Id. The string of that language element will be displayed to the user in the Custom Options Menu. For more
information see Multi-Language Support.

Type
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The data type the Option should display. Each data type will display an appropriate input element in the Custom Options
Menu. The following types are available.

e Int — Represents a whole number.

e Decimal — Represents a decimal.

¢ Bool — Represents a Boolean value. A checkbox is displayed.

Text — Represents text and displays a text box.

List — Represents a choice from among multiple values. Click the 'Add' button to define choices.

Custom Option
d

ype

Decimal
Bool
Text
List

Setting Options

After Custom Options are created, the Custom Options Menu will be available in the Report Designer of Standard and
Crosstab Reports. In the Custom Options Menu, options can be set using the Ul elements displayed abowe.

NOTE. The Custom Options Menu will only display if Custom Options exist.

Accessing Options

The .Net Api, Sener Events, and Custom Functions can access Custom Options values through the Sessioninfo.Report
object by using the following method:

string GetCustomOptionValue(string id)

Description Returns the value of the specified Custom Option as a string.

For Bool options the value retumed will be “true” or “false”.

For List Options, the chosen Id is retumed.

Remarks
NOTE. List options will retum the Id of the selected value and not the displayed
language string.
A Custom Function could use the following C# code to retum the value of a Custom
Example Option. The Id of the Option is entered as an argument of the Custom Function.

retum sessionInfo.Report. GetCustomOptionValue(args[0]. ToString());

Hidden Flags

The following options are inaccessible from the Admin Console, but may be toggled on or off by editing the field in the
config file xml.

o <showcrosstabwizard> — Show or hide the CrossTab Wizard button in the Report Designer.

o <allowhtmlinscheduledemails> — Set to True to allow users to insert html tags within the body of scheduled
emails.

o <showbrowseroutofdatewarning> (v20716.3.4+) — Set to False to prevent a popup error message from appearing
if a user accesses Exago with an unsupported browser.

o <webfarmsupport> — Must be set to True if running in a web farm environment.

o <expressviewdefaultformattheme> — (v2077. 7+) Select a default ExpressView theme.

o <aliasallentities> — (v2077.2+) Always use data object Ids as an alias in the generated SQL.

o <safemode> — (v2017.2+) Ensure that data object names and Ids are unique. If not, log an Error.

Any fields which are not mentioned here are either not intended for external use or not fully implemented, and should be
ignored.

Setting Up Monitoring
Monitoring is a new feature of Exago v2017.1 that allows you to track report management, execution, and performance

statistics for the web application and schedulers. Monitoring data is stored in local sqlite database files, and can be
reported on using Exago.

When you install the Exago web application, the monitoring system is automatically installed, but it is disabled by
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default. You must configure and enable it manually. Many actions in the application can be tracked:

e Report management
o Edit
o Execute (begin & end)
o Sawe
o Delete
o Rename
o Duplicate
o Report designer usage
o Gauge Wizard
o Google Map Wizard
o GeoChart Wizard
o Map Wizard
e Scheduling
o Scheduled report
o Schedule Manager

Monitoring for these components can be toggled on or off depending on your needs.

Additionally, you can track track CPU and memory load for each scheduler application so you can fine-tune your load
balancing setup.

To set up monitoring, you need to configure the monitoring application, set your options for which data to collect, and
then set the monitoring senice to run automatically.

Configuring monitoring

The monitoring system is located in a folder MonitoringService, in the same folder as where the web application is
installed. The web application stores its monitoring data in a Moni toring subfolder of the installation. So you should
hawe the following folders:

ExagoWeb
Monitoring
MonitoringSenice

Windows: Ensure that the lIS user has Full Control permissions for the Exagoweb\Monitoring and
MonitoringService folders. See Configuring IIS for instructions.

To configure monitoring:

1. InMonitoringService, open the file Monitoring.exe.config in atext or xml editor. For each of the
following keys in the <appSettings> element, set the values as follows:

o exagoAppPath, value="path" where path s the file path to the web app
Format: "C:\ file\path\" (Windows), "/ file/path/" (Linux)
A trailing slash (\) or (/) is required

o userConfig, value="config" where confiqg is the application config file
Format: " filename.xml"
Use extension . xm1 for either the encrypted or unencrypted version

o webAppUri, value="uri" where uri is the ur vrtual path to the web app
Format: "http://local/path/"
A trailing backslash (/) is required

o Optional: ExtractionIntervalMinutes, value="1i" where iis the number of minutes between
updates to the core database. The default is 3.

o Optional: StatisticsIntervalMinutes, value="7" where j is the number of minutes between
when each scheduler is polled for performance statistics. The default is 1.

Example

<appSettings>

<add key="ExtractionIntervalMinutes" value="3" />

<add key="StatisticsIntervalMinutes" value="1" />

<add key="exagoAppPath" value="C:\ExagoWeb\" />

<add key="userConfig" value="WebReports.xml" />

<add key="webAppUri" value="http://localhost/monitoring/" />
</appSettings>

2. In ExagoWeb, open the file appSettings.config in a text or xml editor. In the <appSettings> element, set
the Monitoring.DbPath key to the folder where your web application's monitoring data file is. The default
location is ExagoWeb\Monitoring.
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<appSettings>
<add key="Monitoring.DbPath" value="C:\Exago\ExagoWeb\Monitoring\" />

</appSettings>

3. In the same file, set the options for which types of usage data you want to collect. To tum on monitoring for a
specific action, set the value for the key to "true". Available options are as follows:

Note. Keys are formatted as "Monitoring.Option"; The "Monitoring." prefix is omitted below.

o CollectDeleteReportUsage

o CollectRenameReportUsage

o CollectDuplicateReportUsage

o CollectExecuteReportUsage

o CollectSaveReportUsage

o CollectSaveReportXmlUsage

o CollectDesignReportUsage

o CollectGaugeControlUsage

o CollectGoogleMapControlUsage

o CollectMapControlUsage

o CollectChartControlUsage

o CollectScheduleReportControlUsage
o CollectScheduleReportManagerControlUsage

Example
<appSettings>

<add key="Monitoring.CollectDeleteReportUsage" value="true" />
<add key="Monitoring.CollectRenameReportUsage" value="false" />
<add key="Monitoring.CollectDuplicateReportUsage" value="true" />
<add key="Monitoring.CollectExecuteReportUsage" value="true" />

</appSettings>
4. Restart your web sener for the changes to be applied.

Configuring scheduler monitoring
If you want to track scheduled report execution, do the following for each scheduler application:

Open the eWebReportsScheduler.exe.config file in a text or xml editor. Add the following key to the <appSettings>
element:

<add key="Monitoring.CollectExecuteReportUsage" value="true" />

Enabling the polling service

The monitoring system uses a Windows or Linux senice that updates the core database with data from the web
application and schedulers at specified intervals. This way you have the data from every component in a single location.

The senice is installed automatically, but it is not enabled by default.

To enable the senice:

Windows

1. As an administrator, open the Senices manager:
1. Click Start>Run.
2. Type services.msc.
3. Press Enter.
2. Locate the senice Exago Monitoring Service vX.X.X.X, where vX.X.X.Xis your Exago version. Right-
click the senice and select Properties.
3. In the Properties window:
1. From the Startup Type list, select Automatic.
2. Click Start to start the senice.
3. Click OK.

Using the monitoring database with Exago

Tech Guide
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Before using monitoring data in reports, you need to add the core database
file MonitoringService/Monitoring.sglite as an Exago data source. See Using SQLite Data Sources for
instructions.

Monitoring System Overview

The Monitoring system is structured in the following manner:

Web Application , —
(http//localhost/) WebApp db

WebApp tracks report and
user interface event data

Service collects web app data in
main db

Scheduler Application (1)
(tep:/ocalhost:2001)

Monitoring
Service

Sched db Collected db

Service collects schedule report

Performance data

Schedulers track report is persistent, not execution data in main db
execution data stored locally

Service polls scheduler
performance stats, collects in

5 main db
Scheduler Application (2) e
(tep:/localhost:2002) Sched db

Structure of the monitoring system.

Web Application Database

The Web Application database stores data for report and user interface events. The type of data tracked depends on your
configuration. At the Extract interval, the monitoring senice mowes this data from the local db to the collected db.

Scheduler Application Databases

Each scheduler application has a local database which stores report execution data, if enabled in the configuration. At
the Extract intenal, the monitoring senice mowes this data from the local dbs to the collected db.

Scheduler performance data is "persistent,” that is, always available, and is therefore not stored in the local scheduler
dbs. At the Statistics interval, the monitoring senice polls the schedulers for their performance statistics, and logs this
data in the collected db.

File Paths for Config Files & Databases
ExagoWeb\Monitoring\Monitoring.sqglite - WebApp db
ExagolWeb\appSettings.config - Select which web app data to track
MonitoringService\Monitoring.sqglite - Main collected db
MonitoringService\Monitoring.exe.config - Set Extraction & Statistics intenals
ExagoScheduler\Monitoring.sqglite - Scheduler local db

ExagoScheduler\eWebReportsScheduler.exe.config - Select which scheduled report data to track

Monitoring Database Schema

The monitoring database has three tables that can be used to build reports. This article describes what data is stored,
and how to interpret what you see.
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ReportDetail
L > Audit SystemStatistics

> & id INTEGER £ INTEGER

ExecutionDetail

Entity-relationship diagram (ERD) for the monitoring database

SystemStatistics

The SystemStatistics table logs the available CPU load and memory for the system on which each scheduler senice is
installed.

Data is polled at occasional intenals. You can specify the time between polls using the StatisticsintervalMinutes
setting in the Monitoring.exe.config file. For instructions, see "Configuring monitoring".

The table contains the following data columns:
id

An integer used to uniquely identify each row. This is the primary key for the table.
transactionld

(v2017.2+) An integer used to associate rows with type: cpu available and type: free memory to common
transactions, in order to facilitate a vertical table transformation and report off both CPU and Memory usage in the same
report and chart.

hostld

The scheduler which was polled for system data. Every scheduler is polled at the same time. Schedulers are identified
by their host address, as specified in the Administration Console.

Example. tcp://localhost:2010
type
One of:

e cpu available, which indicates that the value field in this row shows the CPU load percentage available at
this time.
e free memory, which indicates that the value field in this row shows the amount of free memory at this time.

value
One of:

o A value indicating the CPU load available at this time, as a percentage of 100%. This field indicates CPU available
if the type field for this row shows cpu available. This value is "-1" if the scheduler could not be reached at
this time.

o A value indicating the amount of free memory at this time, in megabytes (MB). This field indicates free memory if
the type field for this row shows free memory. This value is "-1" if the scheduler could not be reached at this
time.

Note. This field should be formatted as a decimal, either in the metadata for this column, or in the report cell formatting.
timestamp

A datetime value indicating when this scheduler was polled.
Transform

The following vertical transformation is recommended for the SystemStatistics table:
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<entity>
<!-—<entity name></entity name>-->
<db_name>SystemStatistics</db name>
<!--<datasource id></datasource id>-->
<object type>table</object type>
<key>
<col name>transactionId</col name>
</key>
<transform>
<col name>type</col name>
<val name>value</val name>
<non_transform col>
<col name>timestamp</col name>
<data type>8</data type>
</non_transform col>
<non_transform col>
<col name>hostId</col name>
<data type>0</data type>
</non_transform col>
<non_transform col>
<col name>transactionId</col name>
<data_ type>0</data type>
</non_transform col>
</transform>
</entity>

Audit

The Audit table records when certain events, which you specify, happen to reports. This table records data for the
web application and the schedulers.

Data is logged at the time of each event, but the data is only collected in the core database at occasional intervals. You
can specify the time between data collections using the ExtractionintervalMinutes setting in the
Monitoring.exe.config file. For instructions, see "Configuring monitoring".

The table contains the following data columns:
id

An integer used to uniquely identify each row. This is the primary key for the table.
hostld

The application for which this action took place. The web application and schedulers are identified by their host
address.

Example. tcp://localhost:2010
Example. http://localhost

transactionType
A string indicating which type of event has triggered this row to be created. One of:

e Execute Report

e Rename Report

¢ Duplicate Report

o Delete Report

¢ Design Report

e Sawe Report XML

e Chart Control

e Gauge Control

e Map Control

e Google Map Control

userld

The userld parameter for this event.
companyld

The companyld parameter for this event.

timestamp
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A datetime value indicating when this event happened.
auditld

For rows where the transactionType is Execute Report, this field joins up to two rows in the
ExecutionDetail table that indicate when this execution started and, if successful, when it ended.

This field also joins rows in the ReportDetail table which give some information about the report in which the logged
event happened.

ExecutionDetail
This table records data for report execution events.
Up to two rows for each event are created:

o The first has transactionType Report Execution Begins, which logs when the report execution started.
¢ The second has transactionType Report Execution Ends, which logs when the report execution ends. If the
report execution was not successful, this row will not be created.

The table contains the following data columns:
auditld

An integer used to join up to two rows in this table with a row in the Audit table.
transactionld

A globally unique identifier (GUID) for this execution. This GUID is used in several places throughout Exago. Notably, it
is used as the file name for scheduled reports which have been saved to disk.

transactionType
One of:

e Report Execution Begins, which indicates that the timestamp value for this row shows when this execution
started.

e Report Execution Ends, which indicates that the timestamp value for this row shows when this execution
ended.

timestamp

A datetime value indicating when this execution started or finished, depending on the value of transactionType.

Note. This table uses columns (transactionld and transactionType) as a primary key.

ReportDetall
This table records information about the reports which relate to events in the Audit table.
auditld
An integer used to join a row in this table with a row in the Audit table.
reportld
The file path and name of the report which the event affected.
reportType

The type of report: advanced, express, expressview, chained, dashboard

Introduction to Integration

Exago is designed to be seamlessly integrated into the host application. Integration can entail either styling Exago’
interface to match the host or making API calls such as report execution directly from the host application. To access
the user interface, Exago can either be embedded in a div or iframe or users can be directed to a separate page.

Whether you are exposing the provided interface or calling APl methods it is important to:

o Ensure users are verified through the host application: Users should be signed in through the API to access
Exago. To ensure that this happens, disable direct access to Exago by setting the parameter ‘Allow direct access
to Exago’ to False in the Main Settings.
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o Assure the correct permissions and features are available to the user: As the user is signed in, activate the
correct role and set values for any necessary parameters to assure that the user can only access the data,
features, folders and reports that he/she has permission to use. For more information see Roles.

To further integrate Exago you can:

o Re-style the user interface to match the aesthetic of your application. See Styling.

o Translate or modify any text that appears in the user interface. See Multi-Language Support.

o Customize the Getting Started Tab and/or create additional custom tabs. See Customizing Getting Started
Content.

¢ Integrate the Exago installer into the host application’s installer. See Manual Application Installation.

Integration utilizes several types of files. The diagram below details the role of these files:

eWebReports 20121 provides per-user s Useris redirected to this page by host application. Location
styling and multi-language capabilities.

* ContainseWebReports control.

To utilize these features eWebRe ports *  Surrounds eWeb_Reportswithvisualelements suchasa
employs three types of session files; home, Default is logo and headerimage.

configuration, and language/tab files. ExagoHome aspx | * Contains custom CSSto style elements of eWebReports.

This diagram details the function of each ---»QW@@(@

type of file and where they are located
within the eWebReports folder structure.

<Root> indicates
eWebReports root folder.

The zsgx page may specify the name of the configuration xml to read
Settings can also be modified through the APL

+ Contains most of the settings of eWebReports, including: =
o Data configuration < f@mﬁ@

I o Generalsettings
o Role basedrestrictions and settings
Default is

s Specifies which Language and Tab Content files to utilize. i E
WebReportsxml i@@mﬁ@
+

* Containsthe HTMLthat is displayed in the

| PR—

* Specifiesthe string to be used for each text

elementin eWebReports. Getting Started tab.
ﬂ *  Multiple language filescan be specifiedin * Additional custom tabs can be created.
configuration. + JavaScript methods are available to perform
Default is kS Default is basic f pr:t' has R HE pt'
en-us.xml en-us-getting asIC TUNCLIONS sUch as Repo xecunon.

started.xml

Styling

Visually modifying and rebranding the user interface is a simple but effective step toward integrating Exago into the host
application. For styling purposes Exago can be thought of as a control that sits within a divon an .aspx page. Aesthetic
changes can be made for single users or groups of users by directing each user/group to different custom .aspx pages.

To visually integrate Exago make a copy of the .aspx example below and modify the elements surrounding the Exago
control or override the CSS of the user interface itself.

NOTE. Do not make changes directly to ExagoHome.aspx as they will be overwritten during upgrades. Instead use the
example below to create a custom .aspx page.

Styling Exago's Surroundings

The example below demonstrates an .aspx page that contains the Exago control. In this page, some built-in CSS is un-
commented in order to hide the Exago logo.
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<%@ Page Language="C#" EnableViewState="false" EnableEventValidation="false" %>
<%@ Register src="WebReportsCtrl.ascx" tagname="WebReportsCtrl" tagprefix="wr" %>

<!DOCTYPE HTML PUBLIC "-//W3C//DTD HIML 4.01//EN" "http://www.w3.org/TR/html4/transitional.dtd">

<html xmlns="http://www.w3.0rg/1999/xhtml">
<head id="Headl" runat="server">
<title>Exago</title>
<meta name="viewport" content="width=device-width, initial-scale=1">
<style type="text/css">
html, body { height:100%; width:100%; margin:0; padding:0; overflow:auto; background-color: #FEFDF
html { overflow: hidden; } /* Prevents "bounce scroll" on the body in MacOS and iOS */
#WebReportsContainer { position:absolute; top:0; bottom:0; left:0; right:0; overflow:hidden; }

/*

The optional wrMainCompanylLogo style override is in the head of the document because we want
the browser to load the style before the image is loaded so that the image does not

briefly appear on-screen before the style applies as the page is loading. Other style
overrides may be put in the body below so that selectors of the same specificity as
existing Exago selectors will take precedence.

Y

div.wrMainCompanylLogo {
display: none;
}

</style>

</head>

<body>

<form id="forml" runat="server">

<div>

<div id="WebReportsContainer">

<wr:WebReportsCtrl ID="WebReportsCtrl" runat="server" />

</div>

</div>

</form>

<style type="text/css">

/* Styles can be overidden here like this: .wrDynamicTabItemSelected { color:red; }
Please duplicate this file (ExagoHome.aspx) to your own aspx page, since this file will be recreat
See technical guide for additional information */

/*
Uncomment the following styles in addition to the wrMainCompanyLogo override in the head section
to remove the company logo from the left-hand sidebar */

.wrMainReportsContainer {
top: 11llpx;

}

.wrMainTbContainer {
margin-top: 10px;

}

</style>
</body>
</html>

1| H ;LJ

The effect of these changes is seen below.

Original:
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Search report names...

» Financial Holdings Reports
» Retail Customers Reports
» Sales Reports

Scheduled Reports
» Seasonal Reports
» University Student Reports
» Wholesale

New:

+ 00
OO

Search report names...

» Financial Holdings Reports
» Retail Customers Reports
» Sales Reports

Scheduled Reports
» Seasonal Reports
» University Student Reports
» Wholesale

Exago Control Properties

Within each .aspx page seweral properties can be set on the Exago Control to modify various settings and behawviors of
Exago. The following properties can be set.

o ConfigFile — Loads a configuration file other than that created by the Administration Console (ex.
ConfigFile="NorthwindConfig.xml").

NOTE. If entering Exago through the Api this parameter is ignored.

e Language File - Specify which language file(s) to use in place of the ‘Language File’ parameter of Main Settings
in the configuration file. (ex. LanguageFile ="es-mx, gettingstartedcustom").

o ForcelECompatMode — Setting to True will force certain JavaScript functions to working in ‘compatibility’ mode.
Currently this property only needs to be set if dragging a Data Field into a cell of the Report Designer does not
work properly. (ex. ForcelECompatMode="true").

e XUaCompat — Setting that controls whether to remove the meta u-ax-comptaible tag when running reports to PDF
in IE8. The default is ‘false’ which removes the tag. If you are experiencing issues downloading PDF reports in IE8
setting this flag to True may resolve the issue. (ex. XUaCompat="true").

Changing CSS

All of the CSS used by Exago can be modified at the bottom of the .aspx page. This means that every individual element
or class of objects can be modified. To make changes, add <style type="text/css"></style> to your .aspx page in the
line above </body>. Between these style tags place the desired modifications to the CSS.

The table below details the recommend CSS classes for styling.

Class Feature Property = Example
Text Elements

Modifies text

wrMain throughout  color wrMain { color:Red; }
Exago.
Modifies the
text of input

.wrinputText boxes and color wrinputText { color:Blue; }
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wrTree

wrTreeltemSelected

wrTabltem

.wrTabltemSelected

wrDialogTitle

Background Elements

.wrMainLeftPaneGradient

wrMainLeftPane

.wrTabContent

.wrTabContentWizard

.wrDialogShadow

.wrPopupMenu

wrDesignLeftPane

.wrDsgnTbContainer

wrTabltem

dropdowns.

Modifies the
text of tree
controls such
as the
reports in the
Main Menu or
the Data
Fields in the
Report
Designer.

Modifies the
selected item
inatree
control.

Modifies the
text of
unselected
tabs.

Modifies the
text of the
selected tab.

Modifies the
text of the
title of dialog
menus

Modifies the
gradient at
the top of the
Main Menu

Modifies the
background
of the Main

Menu

Modifies the
background
of all Tabs

Modifies the
background
of all Wizards
(ex. the New
Report
Wizard)

Modifies the
background
of all dialog
menus (ex.
the Filters
Menu)

Modifies the
background
of all popup
menus (ex.
the Folder
Management
Menu)

Modifies the
background
of the Data
Field Menu in
the Report
Designer

Modifies the
background
of the Report
Designer

Modifies the
background
unselected
tabs

Modifies the

color

color

color

color

color

background

background-
color

background-
color

background-
color

background

background

background-
color

background-
color

background-
color

.wrTree { color:Green; }

wrTreeltemSelected{color: yellow; }

wrTabltem { color:Aqua; }

.wrTabltemSelected{color: #FFO0FF; }

.wrDialogTitle{color: Orange; }

wrMainLeftPaneGradient{background: -

webkit-gradient(linear, left top, left bottom,

from(white), to(Blue));}

wrMainLeftPane{background-color: Blue;}

.wrTabContent{background-color: Blue;}

.wr TabContentWizard{background-color:
Blue;}

.wrDialogShadow

{background: -webkit-gradient(linear, left
top, left bottom, from(white), to(Blue));}

.wrPopupMenu{ background: -webkit-
gradient(linear, left top, left bottom,
from(white), to(blue));

wrDesignLeftPane{background-color:
Blue;}

.wrDsgnTbContainer{background-color:
Blue;}

.wrTabltem{background-color: Blue;}
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.wrDsgnTbSection gradient background
behind the
buttons on
the Report
Designer

Selected Elements
.wrTabltemSelected Modifies the background
selected tab

Modifies the

selected item background-
inatree color

control

Modifies the
.wrPopupMenultemHover, selected item
wrPopupMenultem:hover popup menu  background-

(ex. the color

Report Folder

Management)

Modifies the

background
wrTbimgHover,
\wiMainThimgHover, of tool bar background-

WrTblma: hover images when color
’ 9 they are

hovered over.

wrreeltemSelected

Other Elements

.wrimageButton, .wrButton1 Modifies the
buttons (ex.  background
Ok, Cancel)

Modifies the
lines used
throughout
Exago

Modifies the
.wrDialogDragBar bar atop all

dialog menus background

(ex. the

Filters Menu)

Modifies the
.wrMainReportDescriptionContainer report

description in  border

the Main

Menu

border-top,
border-
bottom

.wrLine

The code below demonstrates an example of custom CSS styling.

Code:

<style type="text/css">

.wrMain { color:Red; }

.wrInputText { color:Blue; }

.wrTree { color:Green; }
.wrTreeltemSelected { background-color:Purple; }
.wrDynamicTabItemSelected { color: Pink; }
.wrDialogTitle { color: Orange; }

.grRh { color: mediumaquamarine; }

.grNum { color: sandybrown; }

.wrGridIbl thead th { color: cadetblue; }
.wrTabText { color: dodgerblue; }

</style>

Before:

.wrDsgnTbSection{background: -webkit-
gradient(linear, left top, left bottom,
from(white), to(Blue));}

.wrTabltemSelected{background: -webkit-
gradient(linear, left top, left bottom,
from(white), to(Blue));}

wrTreeltemSelected{background-
color:Purple; }

.wrPopupMenultemHover,
.wrPopupMenultem: hover{background-
color:Purple; }

wrTbimgHovwer, .wrMainTblmgHover,

.wr'Tbimg: hover{background-color: Orange;}

.wrimageButton, .wrButton1

{background: -webkit-gradient(linear, left
top, left bottom, from(white), to(Blue));}

.wrLine{border-top: solid 1px
#55D8F2;border-bottom: solid 1px blue;}

.wrDialogDragBar{background: -webkit-
gradient(linear, left top, left bottom,
from(white), to(Blue));}

.wrMainReportDescriptionContainer{border:

solid 1px blue;}
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Changing Icon Images
To further Exago’s integration capabilities, any icon in Exago can be changed on a per-company or per-user basis:

1. Create the custom images you would like to display.

2. ldentify the Id of the image you want to change. See Finding Image Ids for more details.

3. Create a language file that maps the Ids to the location of the custom images. See Multi-Language Support for
more information.

Ex.

<element id="ExportTypeMenuHtml" image= "Config\Images\Custom\HTMLExecutIconLarge.png"></element>

Alternately, you can use the css content tag to override individual images:

img.ExportTypeMenuHtml { content: url ('Config/Images/Custom/HTMLExecutIconlarge.png'); }

Hovering Images

For icons that have hower effects (ex. the next page button on report output) there is a special naming convention.
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To change custom icons with hover effects:

1. Follow the steps abowe to create the non-hover icon.
2. Create the custom icon with the hower effect. Sawe it to have the same name as the non-hover icon and append
“ h”to its name.

Finding Image |lds
To find the Ids of icons in Exago:

1. Open Exago in a browser.

2. Use the browser's developer tools to inspect the icon you want to change. For most browsers this can be done by
pressing F12.

3. Look at the id property of the icon. There will be sewveral words separated by underscores. Use the last element as
the image Id (see example below).

b_Designsplitter DesignToolbarctrl_Sa .WrThImg.wrDsgnThImg

Element ID
=l Ul Element

Hiding the Exago Logo
You can use the following code to hide the default Logo in a custom home page:
<head> Styling
div.wrMainCompanyLogo { display: none; }
<body> Styling

.wrMainReportsContainer { top: 1llpx; }
.wrMainTbContainer { margin-top: 10px; }

Styling the Administration Console

Though we strongly recommend against exposing the administration console to end-users or clients, it can be stylized
much like the Exago interface.

To style the administration console:

1. Make a copy of ExagoHome.aspx and give it a unique name (ex. CompanyAdmin.aspx)
2. At the top of this copy change the source from WebReportsCtrl.ascx to WebAdminCtrl.ascx (see example below.

<%@ Page Language="C#" EnableViewState="false" %>
<%@ Register src="WebAdminCtrl.ascx" tagname="WebAdminCtrl" tagprefix="wr" %>

3. Modify surrounding styles and css in the same manner described in the sections above.

Customizing Getting Started Content

The Getting Started tab is displayed as a user enters Exago. This tab can be customized by loading custom html. This is
done by modifying the language element ‘GettingStartedContent’ in the file ‘en-us-getting-started.xml’. To assist in
customizing the Getting Started tab, Exago provides several JavaScript functions to open the New Report Wizard,
execute reports, open other custom tabs and display reports as dashboards.

The example below demonstrates a custom tab with links to the New Report Wizard and Dashboards.
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Getting Started

Delivering Fresh Ad Hoc Food Items Right To Your Door!
Use the menu on the left to create, edit, run reports.!
Shorteuts:

Click here to create a new report.
Click here to g0 to www.exageinc.com.

Quick Reports:
Quick Reports

Dashboards:

Revenue By Category : Employee Information:

1.020
830 I
.
N - - III ||

Buchans Cslishsn Dsvolic Oodswest Fuller Levering Peseos Suyams
N h

NOTE. It is recommended to make custom tabs in a separate language file to make it easy to change tabs by user or
groups of users. See Modifying Select Language Elements.

Creating Additional Custom Tabs

Addition custom tabs can be created by creating two language elements with unique names. One element specifies the

title of the custom tab and the second contains the html content. Custom tabs can be opened with the JavaScript
function wrAddTabbedContent (see Available JavaScript Functions).

The example below demonstrates a custom tab that has buttons to launch reports.

<element id="QuickReportsTabName">Quick Reports</element>
<element id="QuickReportsTab">

<style type="text/css">

.Button

{

height:20px;

width: 60px;

color: black;

font-size:8pt;

margin-right:5px;

}

.divProductDescription

{

margin-bottom:3px;

}

</style>

<p style="font-family:Arial; font-size:12pt; font-weight:bold; text-decoration:underline; text-ali
<br />

<div class="divProductDescription">

<b>Revenue by Category (with drilldown)</b> - Complete list of revenue generated by each category

</div>

<div class="divProductButtons">

<input type="button" class="Button" value="HTML" onclick="wrExecuteReport ('Sales Reports\\Revenue
<input type="button" class="Button" value="EXCEL" onclick="wrExecuteReport ('Sales Reports\\Revenue
<input type="button" class="Button" value="PDF" onclick="wrExecuteReport ('Sales Reports\\Revenue b
<input type="button" class="Button" value="RTF" onclick="wrExecuteReport ('Sales Reports\\Revenue b
<input type="button" class="Button" value="CSV" onclick="wrExecuteReport ('Sales Reports\\Revenue b
</div>

</element>

1]

| il

Available JavaScript Functions

To assist with the creation of custom tab content, Exago provides a small number of JavaScript functions to allow custom
html to call features of Exago.

woid wrStartNewReportWizard()

Description

Example

Opens the New Report wizard in a new tab.

Ex. Click <span style="text-decoration:underline; cursor:pointer;”
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onclick="wrStartNewReportWizard(); ">here</span> to create a new report.
wid wrStartDuplicateReportDialog(string reportFolder\\reportName):

Description  Opens the Duplicate Report dialog.
Remark If the report name is null or blank Exago will use the report selected in the Main Menu.

Ex. Click <span style="text-decoration:underline; cursor:pointer;"” onclick="

Example wrStartDuplicateReportDialog(); ">here</span> to create a duplicate this report.

woid wrExecuteReport(string reportFolder\\reportName, string format)

Description  Executes the specified report in the specified format.

Ex. <input type="button" class="Button" value="HTML"

S onclick="wrExecuteReport('Sales Reports\\Revenue by Category','html’)

string wrGetSelectedReportName()

Description  Retums the name of the report that is selected in the Main Menu.

Remark The retumed string will include the folder structure of the report separated by slashes.
wid wrAddTabbedContent(string ContentID, string TabName)

Opens a new tab and loads the html stored in the element of the Language file that

Description corresponds to the Content ID.

The ContentID should match the element ID of the html you want to load.
Remark
The TabName should make the element ID of the name you want the tab to display.

data-onloadreportname= “ReportFolder\\ReportName”

Description  Executes a report as HTML and loads it into a div or iframe.
The report string should be formatted as Report Folder \\ Report Name.

Remark NOTE. When using this function make sure the setting Enable Debugging in Other
settings is False.
Example Ex. <div class="Report" data-onloadreportname="Employee Reports\\Number of

Sales by Employee"></div>
data-useviewer ="True/False"

Description  Specifies to load a report as raw html or utilize Exago dynamic report viewer.

Default value is True. In cases where the dynamic capabilities of the Exago viewer is not

Remark need set to False to load raw html.

Ex. <div class="Report" data-onloadreportname="Employee Reports\\Number of

Example Sales by Employee" data-useviewer= “False”></div>

data-enablescrolling ="True/False"

Description Specifies whether or not to show scroll bars.

Default value is True. This can helpful for certain reports that may not fit exactly within

Remark the startup content.

Ex. <div class="Report" data-onloadreportname="Employee Reports\\Number of

Example Sales by Employee” data-enablescrolling= “False”></div>

data-reloadintenal="n"

Description  Reloads a report every n seconds.
Remark This function is used in conjunction with data-onloadreportname.

Examole Ex. <div class="Report" data-onloadreportname="Employee Reports\\Number of
P Sales by Employee" data-reloadinterval="2"></div>

data-allowexport="0/1"

Description  Specifies wether or not to show the re-export menu for the report.

The default value is 0 (does not show the menu). Set to 1 to have the re-export options

R display.

Ex. <div class="Report" data-onloadreportname="Employee Reports\\Number of

Example Sales by Employee" data-reloadinterval="1"></div>
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Custom Context Sensitive Help

Exago is installed with context sensitive help. When a user clicks the help button a tab appears displaying the
appropriate section of the Exago User Guide. The content of this tab can be replaced with custom content managed by
the host application

To implement Custom Context Sensitive Help:

1. Create a webpage for the custom help.
2. Set the URL of the webpage in the Custom Help Source parameter in Feature/Ul Settings. Ex
url=http://www.Customhelp.com/Exago;

NOTE. When a user clicks the help button Exago will populate a tab with the content received from the URL. To notify
the host application the user’s language the URL will be appended with the ‘Language File’ of Main Settings and a
context parameter (listed below). Ex. http://www.customhelp.com/Exago?helpKey= newreport&language=en-us

Context Parameter

Details

tabexecute The user has report output active.

Express Report Wizard

tabExpressName The user has the Name tab of the Express Report Wizard active.
tabExpressCatepgories The user has the Categories tab of the Express Report Wizard active.
tabExpressSorts The user has the Sorts tab of the Express Report Wizard active.

tabExpressFilters

The user has the Filters tab of the Express Report Wizard active.

tabExpressLayout The user has the Layout tab of the Express Report Wizard active.
tabExpressOptions The user has the Options tab of the Express Report Wizard active.
New Crosstab Wizard

tabCrosstabName ;23 \;ser has the Names tab of the New Crosstab Report Wizard
tabCrosstabCategories The user has the Categories tab of the New Crosstab Report Wizard

tabCrosstabFilters

active.

The user has the Filters tab of the New Crosstab Report Wizard active.

tabCrosstabLayout The user has the Layout tab of the New Crosstab Report Wizard active.

New Report Wizard

tabStandardName Th(bT user has the Names tab of the New Advanced Report Wizard
active.

tabStandardCategories szi VL';ser has the Categories tab of the New Advanced Report Wizard

tabStandardSorts The user has the Sorts tab of the New Advanced Report Wizard active.

tabStandardFilters

tabStandardLayout

The user has the Filters tab of the New Advanced Report Wizard active.
The user has the Layout tab of the New Advanced Report Wizard

active.
Report Designer
tabDesign ;:g gztef\rés editing an Advanced or Crosstab report and has the design
dialogName The user has the Rename Menu active.
dialogDescription The user has the Description Menu active.
dialogCategories The user has the Categories Menu active.
dialogSorts The user has the Sorts Menu active.
dialogFilters The user has the Filters Menu active.
dialogGeneralOptions The user has the Options Menu active.

listitemReportHtmIOptionsGeneral
listitemReportHtmIOptionsFilters
listitemReportHtmIOptionsSorts

The user has the General section of the HTML Options active.
The user has the Filter section of the HTML Options active.

The user has the Sorts section of the HTML Options active.

dialogTemplate The user has the Template Menu active.
dialogJoins The user has the Advanced Menu active.
dialogJoinEdit The user has the Report Join Menu active.
dialogFormulaEditor The user has the Formula Editor active.
dialogLinkedReport The user has the Linked Report Menu active.

tabCellFormatNumber

The user has the Number tab of the Cell Format Menu active.
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tabCellFormatBoder
tabCellFormatConditional
dialogCrosstabDesign
dialogGroup
dialogSectionShading
tabChartType
tabChartLabels
tabChartData
tabMapType
tabMapLocations
tabMapData
tabGaugeType
tabGaugeData
Dashboards
tabDashboardDesigner
dialogDashboardUrlOptions
dialogDashboardName

dialogDashboardDescription

dialogDashboardOptions

tabDashboardReportOptions
tabDashboardReportOptionsFilterPrompts
tabDashboardReportOptionsParameterPrompts
tabDashboardReportOptionsOptions
tabDashboardFilterOptionsReports
tabDashboardFilterOptionsFilter
dialogDashboardVisualizationOptions

Scheduler

tabScheduleReportManager

tabScheduleRecurrence
tabScheduleParameters
tabScheduleFilters
tabScheduleRecipients

Tech Guide

The user has the Border tab of the Cell Format Menu active.
The user has the Conditional tab of the Cell Format Menu active.
The user has the Crosstab Menu active.

The user has the Group Section Menu active.

The user has the Section Shading Menu active.

The user has the Type tab of the Chart menu active.

The user has the Labels tab of the Chart menu active.

The user has the Data tab of the Chart menu active.

The user has the Type tab of the Map menu active.

The user has the Locations tab of the Map menu active.

The user has the Data tab of the Map menu active.

The user has the Appearance tab of the Gauge menu active.

The user has the Data tab of the Gauge menu active.

The user has the Dashboard designer active.

The user has the Insert Ul menu active.

The user has the Dashboard Rename menu active.

The user has the Dashboard Description menu active.

The user has the Dashboard Options menu active.

The user has the Report tab of the Insert Report menu active.
The user has the Filters tab of the Insert Report menu active.
The user has the Parameters tab of the Insert Report menu active.
The user has the Options tab of the Insert Report menu active.
The user has the Reports tab of the Insert Filter menu active.
The user has the Filter tab of the Insert Filter menu active.

The user has the Options menu of a Data Visualization active.

The user has the Schedule Report Manager active.

The user has the Recurrence tab of the New Schedule Wizard active.
The user has the Parameter tab of the New Schedule Wizard active.
The user has the Filter tab of the New Schedule Wizard active.

The user has the Recipients tab of the New Schedule Wizard active.

NOTE. Create a default page to handle any cases where an undocumented or null context parameter is passed. This
guarantees that a valid help page will always be shown.

Themes

Themes allow a user to quickly stylize reports or elements of reports such as maps and charts. Exago comes with
seweral themes pre-installed. Additional custom themes can also be created.

Pre-installed themes are saved in the Themes folder of Exago. By default custom themes are saved in the Report Path,
which is specified in Main Settings. Alternatively the host application can manage theme storage by implementing the
GetTemplate, GetTemplatelist, and SaveTemplate functions. See Report and Folder Management for more

information.

NOTE. To support multianguage functionality, if the theme name concatenated with °_ wrThemeld' matches the id of
any element in the language files then the string of that language element will be displayed to the user instead of the
theme name. Ex. For the Basic theme that is installed with Exago, there exists a language id ‘Basic_wrThemeld’. The
string associated with this id is displayed. For more information see Multi-Language Support

Chart Themes

A user can quickly select colors for Charts by applying a chart theme.

To create custom Chart themes:
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1. In folder specified in the Report Path of Main Settings create a text file containing a comma separated list of the
css values of the desired colors. Sawe the file and change the extension to ‘wrth’.

NOTE. The file name will be displayed to the end user. To translate the name of a custom theme, see the note above
section.

Ex: The theme ‘Cocktails In Miami.wrth’ contains the list: Navy, #00ff00, Yellow,Orange, Red.

Crosstab Themes

A user can quickly style Crosstabs by applying a crosstab theme. Crosstab themes can specify background color,
foreground color, section shading, borders, fonts and text size.

To create custom Crosstab themes:

1. Create a Crosstab with as seweral Tabulation Data, Row Headers, Column Headers as well as sub-totals and
grand totals.

NOTE. If a user adds more Tabulation Data, Row Headers or Colum Headers than existed on the theme they will appear
without styling. We recommend Crosstab Themes hawe five Row Headers, Column Headers, Tabulation Data, sub-total
rows, and sub-total columns as well as a grand total row and a grand total column.

2. In the Report Designer stylize each cell of the Crosstab as desired.
3. Mowe your cursor over the Crosstab. Notice a dropdown menu appears in the bottom left comer.
4. Hold Alt+Ctr+Shift and click on the dropdown.

1

2 ProductlD
3 SupplierlD
4 UnitsinStock

5 | CategoryName ProductName Discontinued ReorderLevel UnitsOnOrder

Qe |~ o,

EE-.

= [# Modify
B Save as Theme

»  Delete

5. Click ‘Sawe as Theme'.
6. Enter a name for the Theme. This name will be displayed to the end-users.

The page at localhost says:

Enter name of theme

Custom Crosstab

OK Cancel

Express Report Themes

A user can quickly style Express Reports by applying an express report theme. Express report themes can specify
background color, foreground color, section shading, borders, fonts and text size.

To create custom Express Report themes:

1. Create an Express Report with Headers, Footers and a Page Header/Footer and a Grand Total.

NOTE. If a user adds more Columns, Headers, or Footers than existed on the theme they will appear without styling.
We recommend Express Report Themes utilize many Columns, Headers and Footers.

2. Inthe Layout tab stylize the report as desired.
3. On your keyboard, hold Ctri+Alt+Shift and click on the sawe button =}
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4. Enter a name for the theme. This name will be displayed to the end-users.

The page at localhost says:

Enter name of theme

i

|

|

‘ Custom Express
! 0K Cancel
|

Geochart Themes

A user can quickly select colors for Geocharts by applying a theme.

To create custom Geochart themes:

1. In folder specified in the Report Path of Main Settings create a text file containing a comma separated list of the
css values of the desired colors. Sawe the file and change the extension to ‘wrtm’.

NOTE. The file name will be displayed to the end user. To translate the name of a custom theme, see the note above
section.

Ex: The theme ‘Cocktails In Miami.wrtm’ contains the list: Nawy, #00ff00, Yellow,Orange, Red.

Multi-Language Support

NOTE. The language elements discussed in this section do not include those created by users or administrators such
as reports, folders, express report/crosstab themes or Data Field names. To modify Data Field names please see
Column Metadata. To modify theme names please see Express Report and Crosstab Themes.

To help localize Exago, any text in the application can be translated or modified. This can be accomplished by creating
xml files in the Language folder that map ID’s to strings. Any place within Exago that displays text has an associated ID.
When a text element is required in the application Exago will read the file(s) specified in the ‘Language File’ parameter of
Main Settings and use the string that is mapped to the ID.

Exago comes with both a standard English file ‘en-us.xml’ and a Spanish translation ‘es-mx.xml’. Below is an example of
the multi-language functionality. Notice that the prompt text in the New Report Wizard can be set by changing the string
associated with the id NewReportLb1.

En-us.xml:

<NewReport>
<element id="NewReportlLbl">Complete the steps in the wizard below to create a new report</element>
</NewReport>

‘] v

+ New Standard Report *

Complete the steps in the wizard below to create a new report

Name Categories Sorts Filters  Layout

Enter the report name

Es-mx.xml:

<NewReport>
<element id="NewReportLbl">Complete los pasos en el asistente para crear un nuevo informe</eleme
</NewReport>

d Bl
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+ Nuevo Informe Estandar *

Complete los pasos en el asistente para crear un nuevo informe

Nombre Categorias Ordenas Filtros  Disefio

Intreduzca &l nombre del informe

NOTE. Some language strings contain special place holders between curly brackets (ex. {0}). These hold the place of
elements that must be filled in dynamically by Exago. Do not translate anything inside curly brackets. The place
holders may be moved within the string but do not delete them.

The example below demonstrates three place holders that will be replaced by dropdown menus in the Scheduling Wizard.

<element id="ScheduleRecurrenceRelativeMonthlyTxt">The {DayPosition} {DayOfWeek} of every {MonthNum

J | 2l

) The first * day = ofevery 1 % month(s)

Translating Exago

To translate the entire interface, make a copy of the file ‘en-us.xml’ and giwe it a different name. Make sure this copy is in
the folder ‘<webapp_dir>/Config/Languages’. Without changing the IDs translate the strings as desired (see example
abowe). Then set the ‘Language File’ parameter of Main Settings to specify the desired translation.

NOTE. If you are using the Exago Scheduler Senice be sure to copy all custom language xml files to the
‘<scheduler_dir>/Languages’ folder of the Scheduler Senice.

Modifying Select Language Elements

To change specific language elements without copying the entire mapping you can use a base file and specify changes
in separate language files. When you set the parameter ‘Language File’ list the all of the files you want to load separated
by comas or semicolons. Exago will load the files from left to right, meaning the first file listed will be used as a base and
can be changed by the files loaded after it.

As an example you can create the file en-custom.xml which only contains the lines:

<?xml version="1.0" encoding="utf-8" ?>
<element id="GettingStartedTab">Home</element>

Set the ‘Language File’ parameter to ‘en-us, en-custom’ and the Getting Started tab will reflect the change made in the
custom file.

42 Home X

NOTE. Begin all language xml files with the line ‘<?xml version="1.0" encoding="utf-8" 7>’

Text of Prompting Filters and Parameters on Dashboards

When adding a Report to a Dashbaord a user can specify text for any prompting Filters or Parameters. By default this
text will match the strings associated with the ids CompositeReportOptionsFilterDefaultPrompt Text and
CompositeReportOptionsParameterDefaultPrompt Text respectively.

If a user changes the default and enters a different language Id then the associated text for that new Id will display when
the dashboard is executed.

If a user enters text that does not match any language Id the text will be displayed when the dashboard is executed.
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Report Properties x
Report  Filters Parameters  Options
Assign how te handle a report’s promptable fitters.
Report Fitter Prompt Action Data (Prompt Text or Value)
Categories. CategoryMame Dashboard Prompt ¥ Specify value for Categories. CategoryName:

Multi-Tenant Environment Integration

Exago supports a variety of approaches to make sure that users can only access the data that is assigned to them.
These approaches can eliminate the need to create different reports for each user. This can be done in one of four ways.
Using either column, schema, database, or custom SQL based tenancy.

Column Based Tenancy

The most basic multi-tenant environment is when each table, view and stored procedure has one or more columns that
indicate which user(s) has access to each row.

To set column based tenancy in Exago:

1. Create a Parameter for each tenant column.

NOTE. For these parameters set Hidden to False.

2. For each Data Object click the Tenant Columns dropdown. Use the Tenant Columns menu to match each tenant
column in the Data Object with its corresponding Parameter.
3. When initializing Exago through the API, set the value of each tenant parameter for the current user.

& Objects *
Northwind.dbo.Customers x
Mame Morthwind ¥ | dbo.Customers E| I;m
Alias Test Alias
Unique Key Fields =l
Category
Id
Parameters =l
Tenant Columns E|
Column Metzdata Tenant Columns Tenant Parameters
Schema Access Type CustomerlD r v X

Filter Dropdown Chject

b+ Add

+ OK # cancel

Schema Based Tenancy

Some multi-tenant environments create multiple tables/views/stored procedures with the same name and columns but
different database schema. Information is then stored in the appropriate table based on database schema.

To set schema based Tenancy in Exago:

1. On the Data Source set ‘Schema/Owner Name (blank for default) to any valid value.

2. For each table/view/stored procedure create a Data Object. In the Name dropdown select the object that utilizes
the schema value used in step 1. This will tell Exago that for this Data Object it should retrieve the schema from
the Data Source.

3. When initializing Exago through the API, set the schema on the Data Source for the current user.

= Sources *
Northwind X
MName Morthwind
Type masgl ¥
Schema/Owner Mame (blank for default) example
Cennection String Server==servername=,Database==database= uid==user>;pwd==password=>; d
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Database Based Tenancy

Another way to assure that each user can only access their data is to provide a separate database for each user. In this
situation each database should have the same tables, views and stored procedures.

To support database based tenancy in Exago:

1. Create a Data Source and corresponding Data Objects using any one of the Databases.
2. When initializing Exago through the API, set the connection string on the Data Source to access the appropriate
database for the current user.

= Sources X
Northwind x
Mame Morthwind
Type mssgl v
Schema/Cwner Name (blank for default) example
Connection String Server==servername=,Database==database = uid==user=;pwd==password=; L

Custom SQL Based Tenancy

Multi-Tenant security can also be assured by using Custom SQL for all Data Objects. Exago can pass parameter values
into each SQL statement to filter data based on user.

To set Custom SQL based tenancy in Exago:

1. For each Data Object open the Custom SQL menu and create the desired SQL utilizing parameters to assure
only appropriate information is available.

NOTE. Parameters should be surrounded by single quotes.

2. When initializing Exago through the API, set the value of any parameters utilized in the SQL for the current user.

& Objects =

Custom SQL Object x
Object Mame Data Source Parameter Test
Customers Morthwind v v = Add W
1 Select *
2 From Customers
3 Where Tenant_Column = '@TenantParam@’|
+ OK ¥ Cancel

An Overview of Exago Extensions

Exago extensions allow dewelopers to access, extend and modify the platform's capabilities to suit particular needs that
can't be handled "out-of-the-box".

The interface for most capabilities is via coded elements, done either via Code Editor in the Administration Console or
external code modules provided via .NET Assemblies or Web Senices. Other situation-specific options are also
available, such as prowviding custom, parameterized SQL.

Overview

The following extension types are supported. More information on each type is provided in the remainder of this
document:

Custom SQL

Custom Functions and Filter Functions
Sener Events

Action Events

Custom Data Sources
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e External Interface
e Custom Options

Custom SQL

Exago supports a Custom SQL type Entity. Objects of this type are very similar to pre-defined database views. They
consist of a SQL statement, have an implied field schema and retum a relational value.

There are a few differences from traditional database views however.

o Exago Custom SQL statements can be parameterized. In other words Exago parameters can be embedded
within the SQL statement. Parameters sene as placeholders for runtime values. Upon execution of a report any
parameter values will be replaced with the value of the parameter at runtime. Any part of the SQL statement can
be parameterized in this way.

e Exago Custom SQL statements behawe like any other entity type. Administrators can attache column metadata.
Report designers can filter, sort and layout fields from the entity, etc.

e Since the SQL is stored in the Exago configuration no intervention by database administrators is required.

Adding Custom SQL

Add a new Data Object and select the Data Source from the dropdown. Instead of selecting a table or view from the name
field, click the SQL button on the right of the name field.

You will be presented with the SQL code editor. Specify a name for your Data Object (no whitespace or special
characters) then enter your SQL as shown.

Notice the @StartDate@ and @EndDate@ parameters. They can be manually typed or inserted by selecting from the
list of Parameters and selecting the Add button.

When finished select Ok to save your object's information. You can then specify and Alias and select Unique Key Fields
like any other object.

The sessionInfo Object

The global SessionInfo object is available to Custom Functions, Sener Events, and Action Events. It is similar to
the API object in that it contains the full running state of the Exago system during execution.

Collections of metadata and settings normally set in the Administration Console and/or via the API are accessible
through the sessionInfo.SetupData property. Note that for the most part the accessible properties are settable
via Sessionlinfo.

SessionInfo also contains a key object store accessible via two methods:

void sessionInfo.SetStoredvValue (Cbject key, Object value)
Object sessionInfo.GetStoredvValue (Object key)

Custom Functions and Custom Filter Functions

Custom Functions and Custom Filter Functions allow dewelopers to create abstracted high level language routines that
are used by report designers. Standard Custom Functions appear in the Exago Formula Editor as if they were part of the
product. Custom Filter Functions are available to use as values in user formulas.

Both types of functions have access to the Sessioninfo object, creating powerful opportunities for context-sensitive
processing as well as storage. In the case of Custom Functions, global storage can be used to maintain counts as the
report is processing.

Server Events

Sener Events are handlers invoked on the server side during the normal execution lifecycle. They allow developers to
inspect and/or modify running state to achieve situation-specific objectives. Sener Event handlers also have access to
the global sessionInfo object, providing the same global storage and state variables as mentioned above.

A commonly used event is the OnReportExecuteStart event, which allows the handler to make modifications to a
report just prior to execution. Another commonly-used event is OnExecuteSglStatementConstructed which is
invoked after Exago generates SQL but before it is shipped to the data source. This event can be used to simply log the
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SQL for audit or diagnostics or to modify it to e.g. substitute actual fields for placeholders.

Action Events

Action Events are handlers invoked on the client side during the normal execution lifecycle and include an abstracted
interface for sener-side callbacks to gather data as needed and perform similar tasks. They offer a rich interface for
modify charts and dashboard reports in response to user actions. There are also specific interfaces to allow trapping and
instrumentation of things like user saves.

Custom Data Sources

In additional to traditional relational data sources Exago can consume data from programmable data sources such as
.NET assemblies and SOAP-based web senices. Connection to and marshalling of the data sources is handled at the
metadata layer, just like standard sources. This capability provides two key benefits to end users:

o Data from multiple disparate sources can be combined into a single report, Visualization or dashboard
o The end user view is the same regardless of the type of data source. Users will see no difference between
relational and programmable data sources when building reports and dashboards.

Custom data sources are often used when it is desirable to make use of an existing business logic layer such as a
means to pull data from non-traditional or distributed sources.

External Interface

The Extemnal Interface is a set of pre-defined event types that can be trapped and instrumented. Extemal Interface events
are similar to Sener Events with two key differences: External Interface can be invoked via web senice (whereas Sener
Events require code developed using the Administration Console code editor or via .NET assemblies). As a result
Extemal Interface methods do not have access to the global Sessioninfo object.

Custom Options

Custom Options allow administrators to alter the Exago Ul to capture custom input from report designers. The values
chosen by the designer are available via the sessioninfo object and are thus accessible to Sener Event and Action Event
handlers.

Introduction to Server Events

This section explains how to create Events Handlers that run custom code when reports are executed.

e To add a new Event Handler select ‘Sener Events’ in the Main Menu then click the add button.
o To edit an existing Event Handler either double click it or select it and click the edit button.
o To delete an Event Handler select it and click the delete button.

Event Handlers

Event Handlers provide code that Exago can execute when certain events happen during the report execution process.
This code can either come from a .Net Assembly method or within Exago configuration.

All existing Event Handlers are listed in the Main Menu under Sener Events. All the Event Handlers you are adding or
editing will be displayed in a Tab entitled Senver Events.

Each Event Handler has the following properties:

o Name — Provides a unique identifier for each Event Handler
¢ Function — Can either be Custom Code or a .Net Assembly method.
o Custom Code — To sawe code directly in Exago, select Custom Code from the first function dropdown.
Clicking on the second dropdown opens the custom code menu.
See Custom Code for information on how to access the arguments for each Event. Press the green check
mark to verify the code executes properly.

Custom Code has three properties:
= Language — Code can be written in C#, Javascript or VB. Net.
= References— A semicolon-separated list of any .Net Assembly dlils that need to be referenced by
the Event Handler

NOTE. System.dll does not need to be listed as a reference as it is already available.

e Code — The code that will be executed by Exago when called.
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Custom Code

Language | CSharp v References System.data.dll; Ssytem.xXml.dll

MNamespaces

System.Data.DataTable dt = (System.Data.DataTable)
// prevent unauthorized users form knowing the age
// TODO: actually check usedId/companyId to see if
bool shouldCensor = true;

if (shouldCensor && dt.Cloumns.Contains("Employees.

Tech Guide

args(e);

of an employee, they can
they can view year

BirthDate™))

foreach (System.Data.DataRow row in dt.Rows)
for (int 1 = @; 1 < row.ItemArray.Length; i++)
row("Employees.BirthDate") = ((DateTime)row[Employees.BirthDate

h

b
return dt;

+ DK * Cancel

o .Net Assembly Method — To utilize a .Net Assembly method first create a .Net Assembly Data Source. Select
the desired assembly from the first Function dropdown. Clicking on the second dropdown will open a list of

available methods.
See .Net Assembilies for information on how to access the arguments for each Event.

NOTE. The Assembly’s dll will be locked by Exago when it is first accessed. To replace the dll, unlock it by restarting
the IIS App pool.

NOTE. If you want to utilize the sessioninfo object that is passed to all Event Handlers the Assembly must include a
reference to WebReportsApi.dll. For more information see Sessionlinfo.

NOTE. All methods used as Event Handlers must be static.

[¥] Server Events *

OnDateCombinedAssemblyCensorEmployeeBirthYear X
Mame CnDateCombinedAssemblyCensorEmployeeBirthear

Function Custom Code ¥ [=]
Global Event MNone A

e Global Event — In this dropdown select an Event to indicate that the Event Handler should be called wheneer this
event occurs for all report execution. Leave Global Event set to ‘None’ to indicate the Event Handler is meant for a
specific report.

o Specified Event — The Event Handler will be called when the specified Event happens during the execution of all
reports.

Ex. Selecting OnReportExecuteStart from this dropdown will cause the Event Handler to be called whenewer any Report
Execution begins.

e None — The Event Handler will not be called automatically for all reports, but can be set to run for the execution of
specific reports. See Setting Event Handlers on Specific Reports for more information.

Custom Code

Event Handler custom code can be saved directly in Exago via the Administration Console. There are two objects that
custom code can utilize to access information relevant to an Event.

¢ sessioninfo — Without any special references, all custom code can make use of a sessioninfo object that
provides access to elements of Exago current session such as parameters, filters, the logger, etc.

e arguments array — Custom code can also access an array of input values called args[]. For each Event the
content of the args array will be different. The content of this array is detailed in Full Description of Events.

.Net Assemblies

Event Handlers can also reside in .Net Assemblies. The following are important details for using .Net Assemblies as
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Event Handlers.

o The Assembly’s dil will be locked by Exago when it is first accessed. To replace the dll, unlock it by restarting the

IIS App pool.
o The first argument of all Event Handlers is the sessioninfo object which can be used to access elements within

the Exago session. To make use of this object the assembly must reference WebReportsApi.dil.
If the code does not need to make use of sessioninfo then the method signature in the assembly can declare
sessioninfo as an object instead of as a sessioninfo data type. For more information see Available Events.

Adding Server Events to Specific Reports

Event Handlers can either be set to run during the execution of every report or to only be called when executing specific
reports.

NOTE. When multiple Event Handlers are set to run for a single Event, all the Event Handlers are run using the same
input values and then the first non-null return value is used by Exago. This means that the retumn value of Report-specific
Event Handlers will take precedence over global Event Handlers.

Ex. Suppose there is a global Event Handler for OnExecuteSqlStatmentConstructed that logs each reports SQL query
and a report specific Handler that modifies the ‘Where’ clause of the SQL. When the specified report is run, both
Handlers will be executed and return an SQL string. If non-null, the modified SQL from the report specific Event Handler
will be utilized by Exago to query the database.

To set an Event Handler to be report specific:
In the Administration Console:

1. Set the Event Handler's Global Event to None. Click Apply or Ok.
2. In the Feature/Ul Settings set Show Events Window to True. Click Apply or Ok.

In the Reporting Application:

1. In the Main Menu select the desired report and double click or click the edit button.
2. Select the Report Options drop-down menu and hover over Advanced. Click Events. This will cause the Events
Menu to appear.
— [ F E & Aral
- - T U Ab:

AP

b Rename
= Description
- 1
= Categories
A 2 Pre
&) Sors . =

\ 3 Produc
=7 Filters

¢ Options 3

g Template

sco Advanced » | oL Joins

= Events

3. Inthe Event Menu click the Add button.

4. From the Event dropdown select when the Event Handler should be called.
5. From the Action dropdown select which the desired Event Handler.

6. Click Okay and sawe the report.

Events x

Event Action
OnDataCombined v r XX

b Add

+ OK ¥ Cancel

Displaying User Messages

Some Sener Events are designed to display messages to the user based on a retumn value. For the other sener events a

Tech Guide
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user message can be displayed by throwing the following exception method.

WrUserMessage(string messageOrld, wrUserMessageType Type)

Description Displays a message to the user.

wrUserMessageType can either be Text or Id.
Text — The user message will display the string message
Remarks Id — The user message will display the string associated with the Id in the Language Files.

This requires a reference to WebReports.Api.Common

//OnWebServiceExecuteEnd, inspect the returned value and throw a
//message if it matches any of the error messages.

object webServiceResult = args[0];
Example ) . )
P switch (webServiceResult.ToString())

{

case "messagel" : throw new WrUserMessage ("Some Message to User", WrUserMessageType.Text) ;

}

return webServiceResult;

‘ NOTE. This cannot be used for the Events OnConfigLoadStart or OnConfigLoadEnd.

Sessioninfo

Custom Functions, Server Events, Action Events, and Assembly Data Sources can access the Exago session state
through a "sessionInfo" variable. Access to sessioninfo allows powerful new capabilities such as the ability to persist
values across function invocations, allowing each invocation to be aware of previous calls and behave accordingly.

Properties
Pagelnfo

This is the parent of all information in the current session. Included is the active Report and SetupData objects.

NOTE. Since the Report and SetupData objects are accessed frequently, direct pointers are included for these objects.

Report
An object that contains all of the report’s Data Object, sort, filter, and layout information.

SetupData

An object that contains all of the session’s configuration settings including Functions, Parameters, Data Objects, Joins,
Roles, etc.

Companyld
Contains the value specified by the companyld Parameter.
Userld

Contains the value specified by the userld Parameter.

Methods
GetReportExecuteHtml (string reportName)

A method that executes the specified report and retums its html output. This could be used to embed a report within a
cell of another report.

NOTE. The reportName’ is relative to the session’s report path.

GetParameter (string parameterName)

A method that retums the specified Parameter Object. 'GetParameter’ first looks in the Report Parameter collection,
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parameters being utilized by the report, and then in the Config Parameter collection, as well as other parameters such as
hidden parameters or multi-tenant values.

GetReportParameter (string parameterName)

A method that retums the specified Parameter object that is utilized by the report being executed.

Ex. If a parameter is prompting a user for a value it will be available with the prompted value.

GetConfigParameter (string parameterName)

A method that retums the parameter object stored in the default configuration.

| Ex. Any parameter that is not being utilized by the report being executed.

WriteLog (string text)

A method that writes the specified text to the Exago’s log file.

NOTE. The following methods utilize Stored Values which are objects that can be created and set by custom functions
during report execution to pass data between custom function calls. Stored Values only exist for the duration of report
execution.

GetStoredValue (string valueName, object initialValue = null)

A method that retrieves a Store Value. If a there is no Stored Value with the specified valueName, then one will be
created with the specified initialValue.

SetStoredValue (string valueName, object newValue)

A method that sets the value of a Store Value. Setting newValue to 'null’ will delete the Stored Value.

Calling Functions

To call an existing function from within your extension, use the class CellFormula and retum the method
CellFormula.Evaluate(null).

Example

CellFormula formula = CellFormula.CreateFormula (sessionInfo.PageInfo, formulaText, CellVariableColl
return formula.Evaluate (null);

4 ‘ ﬂ

CellVariableCollectionFilter types:

DataField
AggFunction
CellReference
LinkedReport
Parameter
WidgetCellReference
All

Introduction to Action Events

Action Events can be grouped into two general categories: Local and Global events.

e Local events hawe two sub-categories:
o Handlers attached to items in reports and set to fire automatically, or when the item is interacted with in the
Report Viewer.
o Handlers attached to items in the Exago Ul and set to fire when that item is clicked.
o Global ewents are active throughout the application, and fire when specific events occur.

This article explains how to create Local and Global action events, describes the ways in which action events can
interact with the Exago application, and lays out examples for common usages.

Creating Event Handlers

Action event handlers are created using the Admin Console or by directly editing the WebReports.xml config file. They
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can also be added or modified on a per-session basis in a .NET configuration using the 'Api.SetupData.ActionEvents'
sener call.

o To create a new Event Handler expand ‘Extensions’ in the Main Menu, select ‘Action Events’, and click the add
button.

e To edit an Event Handler either double click it or select it and click the edit button.

o To delete an Event Handler select it and click the delete button.

The Action Events tab will open and display the selected event or a New Action Event dialog:
& Action Events

OnLoadChart

Name OnLoadChart

Function Custom Code hd v
Event Type Load hd

Global Event Type Hone hd

Assigned Ul ltem(s)

Apply OK

Each Event Handler has the following properties:

e Name — A unique identifier for each Event Handler.
e Function — Can either be Custom Code or a .Net Assembly method.

o Custom Code — To sawe code directly in Exago, select Custom Code from the first function dropdown.
Clicking on the second dropdown opens the custom code menu. See Writing Action Events for
information on how to access the arguments for each Event. Press the green check mark to verify the code
executes properly.

Custom Code X
Language CSharp References
MNamespaces

oK X Cancel

Custom Code has four properties:

e Language — Code can be written in C#, Javascript or VB.NET.
o References— A semicolon-separated list of any .NET Assembly dlls that need to be referenced by the Event
Handler.

NOTE. System.dll does not need to be listed as a reference as it is already available.

o Namespaces — A semicolon-separated list of namespaces in the referenced dlls or the Exago API library.
e Code — The code that will be executed.

o .NET Assembly Method — To utilize a .NET Assembly method first create a .NET Assembly Data Source.
Select the desired assembly from the first Function dropdown. Clicking on the second dropdown will open a list of
available methods. See Writing Action Events for information on how to access the arguments for each Event.

NOTE. The Assembly’s dll will be locked by Exago when it is first accessed. To replace the dll, unlock it by
restarting the IIS App pool.

NOTE. If you want to utilize the sessioninfo object that is passed to all Event Handlers the Assembly must
include a reference to WebReportsApi.dll. For more information see Sessioninfo.

NOTE. All methods used as Event Handlers must be static.

o Event Type — Select an option in this dropdown to create an event that will be executed when certain client-side
actions are taken.
o None — This event handler is a Global Event. You must specify a Global Event Type in the
following dropdown.
o Load - The event handler will execute when a report item is loaded in the Report Designer, Viewer, or
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(v2016.2.5+) upon Export. This type of handler is typically used to interpret and then apply alterations to
report data, e.g. conditionally changing the colors on charts or maps. As of v2016.2.5 Load events can
affect Export formats (PDF, Excel, RTF, CSV).
o Click — The event handler will execute when a user clicks on an item in a report or in the Exago Ul. This

type of handler is typically used to add additional interactive elements to reports or to the Report Designer.
Click events will not function on Export formats.

o Global Event Type — Select an option in this dropdown to create an event that will be triggered when a condition

is met in the Exago application. See Global Events.

NOTE. Selecting a Global Event Type will cause Exago to ignore any selected Local Event Type.

o Assigned Ul Item(s) — This field designates a comma-separated list of Ul item IDs for items in the Exago
interface. These elements can be intercepted and modified by assigning them in this field. For a list of compatible
Ul items, see Ul Elements.

NOTE. This selection field only applies when the Event Type is Click. This field will be ignored when any other
options are selected.

Writing Action Events

When an Action Event is fired, two primary parameter objects are passed: sessioninfo and clientinfo. These are the main
points of interaction with the Exago application.

o sessioninfo — Provides access to all the elements of the current Exago session. This is the sener-side
information. For more information see Sessioninfo. The most relevant elements are the following:

To access the sessioninfo from a .NET Assembly, you must include a reference to WebReportsApi.dil.
o SetupData — The Admin Console options and data.
o Userld and Companyld
o Report — The current report object.
o JavascriptAction — This object is set when sessioninfo is called from an action event. It is primarily used
to load the client-side Javascript:
= JavascriptAction.SetJsCode(string JsCode) — Sets the javascript string.

NOTE. An action event must retum the JavascriptAction object.

o clientinfo — A Javascript object that is called from within the client-side script. Provdes access to any specified
client-side parameters and information about the item attached to the event handler. For a breakdown of the
elements in clientinfo, see Clientinfo.

arguments array — Action events can also access an array of input values called args[]. These parameters can be set
manually using a ServerCallback, but a few Global Events pass some preset parameters related to their specific action.

Adding Action Events to a Report

To enable an end-user to add Action Events to items in a report, the user must have access to the Report Viewer and the
Action Events toolbar option in the Report Designer. The options to enable these features are located in the following
sections of the Admin Console:

¢ Main Settings

I Allow Execution in Viewer | True hd

o Feature/Ul Settings > Advanced Report Designer Settings
I Show Linked Action True -

After a Local Action Event has been created, the event will be available to add to a report. In the Report Designer, select
the cell to which to add an event and click on the Linked Action Event button. The Linked Action Events Menu will

open:

Linked Action Events X

Action Event

OnChartSectionClick v X

= Add

OK X Cancel
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Press Add and select the event from the dropdown list. Press Delete to remove the selected event. Press OK when
finished.

If the event is a Load event, you will have to save and re-open the report to see the changes applied in the Report
Designer.

Global Action Events

Global Events are actions that can be attached one of a specific list of events that will occur within the Exago application.

These events usually trigger in response to user input, but they are not necessarily directly related to the input action,
and thus will not transfer information about the user input. However, global events are more reliable than capturing user
clicks, especially in response to actions that can be taken in a variety of ways, such as saving a report.

Please note that a subset of global events, namely the ones which are used to handle report tree interaction, require a
true or false return value in the client script. True indicates to Exago that we don't want to continue with the "normal”
course of action, which we have replaced with our custom code. False indicates that we should continue with the normal
action.

For example, when double-clicking on a third party (non-Exago) report, we may want to launch an extemal editor instead
of the Exago report designer. We would check the report type, and if it is a third party report, we would insert our callout
and then retumn True. If it is a regular Exago report, we would continue with the normal course of action by returming
False.

Also note that for these events to be able to have a retumn value, they must be enclosed within a javascript function. This
means that if you want to write the full client scripts in the admin console (rather than calling out to a separate function)
each event will need to be wrapped in an auto-executing anonymous function, like so:

string jsCode = Q" (function()
{
/* javascript stuff; */
return true;

PO

sessionInfo.JavascriptAction.SetJsCode (jsCode) ;
return sessionInfo.JavascriptAction;

List of Global Events
Events which require a true/false retum value are labeled.
OnSaveReport
Fires when a user attempts to save an open report. This action event overrides the

Description default save handling. If this action event is implemented, reports will not be saved by
the normal means.

Remarks Passes the report object.

OnDuplicateReport

Description Fires when an open report is duplicated.
Remarks Passes the report object.

OnEditReport (v20716.3+)

Description Fires when a report is opened for editing.

Passes the webReportsCtrl object, i.e. the application DOM, including the main Ul
Remarks window, folders tree, main menu, etc. Retums true or false to indicate whether to
continue normal operation. Must be enclosed in a function.

OnSelectReport (v2016.3+)

Description Fires when a report item in the folders tree is selected.

Passes the webReportsCtrl object, i.e. the application DOM, including the main Ul
Remarks window, folders tree, main menu, etc. Retums true or false to indicate whether to
continue normal operation. Must be enclosed in a function.

OnDeleteReport (v2076.3+)

Description Fires when a report is deleted from within the folders tree.

Passes the webReportsCtrl object, i.e. the application DOM, including the main Ul
Remarks window, folders tree, main menu, etc. Retums true or false to indicate whether to
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continue normal operation. Must be enclosed in a function.
OnRenameReport (v2016.3+)

Description Fires when a report is renamed from within the folders tree.

Passes the webReportsCtrl object, i.e. the application DOM, including the main Ul
Remarks window, folders tree, main menu, etc. Retums true or false to indicate whether to
continue normal operation. Must be enclosed in a function.

OnExecuteReport (v2076.3+)

Description Fires when a report is executed from within the folders tree.

Passes the webReportsCtrl object, i.e. the application DOM, including the main Ul
Remarks window, folders tree, main menu, etc. Retums true or false to indicate whether to

continue normal operation. Must be enclosed in a function.
OnDoubleClickReport (v2016.3+)

Description Fires when a report item in the folders tree is double-clicked.
Passes the webReportsCtrl object, i.e. the application DOM, including the main Ul
Remarks window, folders tree, main menu, etc. Retums true or false to indicate whether to
continue normal operation. Must be enclosed in a function.
OnRightClickReport (v2076.3+)

Description Fires when a report item in the folders tree is right-clicked.

Passes the webReportsCtrl object, i.e. the application DOM, including the main Ul
Remarks window, folders tree, main menu, etc. Retums true or false to indicate whether to
continue normal operation. Must be enclosed in a function.

OnAfterAddDataObject

Description Fires after a data object is added to a report.
OnBeforeRemoveDataObject

Description Fires before a data object is removed from a report.

OnChangeParameterValue

Description Fires when the value of a parameter in a prompt is changed

Remarks This is commonly used in conjunction with parameter drop-downs in order to
selectively enable, disable, and populate fields.

OnDashboardResize

i Fires when a running dashboard has its container size changed, by either the web
Description page or the browser window
R This is commonly used to enable dashboards to re-format their contents in response
emarks ) )

to changing screen size.

OnBeforeCloseApiWindow

Descripti Fires when the user clicks the cancel button in an iFrame or modal window containing

scription .

a report wizard.

Remarks This can be used to provide a javascript callback to close the window automatically,

rather than retuming to a blank page.
OnSaveReportSuccess (v2017.1.5+)
Fires after an existing report is successfully saved from a Wizard, Designer, or

Viewer. Works for all report types. Also fires when an Advanced Report is created from
an ExpressView, Express Report or a Dashboard Visualization.

Description
Does not fire when a report is duplicated, or when a User Report is saved as a new
Advanced Report from the Report Viewer. Use OnDuplicateReport for these cases.
This can be useful for implementing handlers to update the host application after
reports are saved. This does not interfere with the default report saving behavior.
Remarks

Report name (path and filename) is available to the action event handler through the
reportName property of the ClientInfo object.
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Identifying Actionable Ul Elements

This article describes how to identify items in the Exago Ul that can be captured by "Click"-type Local Action Events. If
an item is not listed below, you can use a Web Inspector to determine the ID of an Ul item.

‘ NOTE. Only toolbar items are currently supported.

For example, in Chrome press F12 to open the deweloper tools, press Ctrl-Shift-C to enable the Inspect Element tool,
and hower over the item for which you wish to find the ID:

resignsplitter_DesignToolbarCtrl SaveReportBin.wrTbImg.wrDsgnTbImg | 18«18

El t1D
El Ul Element smen

The Element ID is usually going to be the text string situated in between the rightmost underscore mark (_) and the
leftmost period mark (.).

To attach an action event to Ul elements, key the element IDs into the Assigned Ul Item(s) text field, separated by a
comma:

OnRunSaveReport
Mame OnRunSaveReport
Function Custom Code ¥ | return sessioninfo Javazcript Sction; v
Event Type Click b
Global Event Type Mane ~
Azzigned Ul kem((s) | SaveReportBtn ExecuteBtn ExportBtn

NOTE. Ul items do not support "Load"-type action events.

List of Toolbar Item IDs

ExecuteBtn MergeCellsBtn
ReportOptionsBtn SplitCellsBtn
SaweReportBtn WrapTextBtn
DesignNewReportBtn AutoSumBtn

UndoBtn SuppressDuplicatesBtn
RedoBtn InsertFilelnput
FormatCellsBtn CrossTabWizardBtn
FormatPaintbrushBtn EditFormulaBtn
BoldBtn LinkedReportBtn
ItalicBtn LinkedActionBtn
UnderlineBtn ExportBtn
DropDownlmage FontSize NumericEditDown

FontNameList_DropDownContainer FontNameList_DropDownText
FontNameList_DropDownSelect FontSize NumericEditContainer

FontSize_NumericEditTB FontSize_NumericEditUp
AlignJustifyBtn AlignTopBtn

AlignLeftBtn AlignMiddleBtn
AlignCenterBtn AlignBottomBtn

AlignRightBtn

Clientinfo

This article describes the properties and methods in the clientinfo object and what they are commonly used for.

’ NOTE. If an element is not listed here, it is likely intended for internal use and should not be accessed.

Properties
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showHourglass
Description Set to false to disable the progress icon that appears when data is being saved or
loaded.
includeReportData
i Set to false to prevent the client from passing the sessioninfo object to the sener
Description whenever a sener callback is done.
It may be useful to disable this to limit overhead if access to sessioninfo is not needed
Remarks :
for a specific callback.
includeReportSaveData
I Set to false to prevent the client from passing the report save data to the sener
Description .
whenever a sener callback is done.
The SaweData is an additional set of data passed whenever a report is saved. This
Remarks information is only passed by an onSaveReport global event. It may be useful to
disable this to limit overhead if the save data is not needed for a specific callback.
refreshDataOnRetumn
. Set to false to prevent the client Viewer from refreshing the report whenever a sener
Description callback alters report data.
If a SaveReport callback does not alter the appearance of the report, it may be useful
Remarks : . e
to disable this to limit overhead.
Utilities
Description Access to a large variety of utilities and controls.
Likely unnecessary in most cases. A pre-written action event provided to you by a
Remarks f
support analyst may make use of this.
webReportsCtrl
Description Access to the Exago Web Reports Ul.
Remarks Often used in order to add or remowe items from the report tree sidebar. Useful for
allowing Exago to handle third-party report objects.
contextObject
Description A generic class for the object which the action event call was attached.
Remarks The more specific context items below provide a superset of this class.

dashboard, dashboardltem, report, chartData, chartSeriesDataPoint, chartltemDataPoint, reportWidgets, categoriesCtrl,

parameterListCtrl

Description
Remarks
uiElement
Description

isSandboxMode

Description

Methods

Specific classes which are set depending on the context of the call. Contain
information about the object for which the action event call was attached.

These are set contextually depending on the object of the call. E.g. chartData will only
be set if the action event was attached to a chart or gauge.

Provides information about the Ul element called by a "click" local action event. For a
list of supported elements, see Ul Elements.

True if an action event is running in a non-interactive environment, i.e. any non-html
environment, where javascript interactivity is not permitted. Includes all export types:
PDF, Excel, RTF, CSV.

SenerCallback(args(])

Description Call back to the sener with any given arguments.
GetLanguageData(id)
Description Returns the text and toadltio info from the lanauaae file for the specified Ul item.
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ExecuteParentFunction(func, args), GetParentFunction(func), GetParentByFunctionName(func)

If the Exago Ul application is running in an iFrame these are helper functions to call

Description javascript functions in the parent frame.

These functions are for convenience and safety. They are generally the same as
Remarks . .

calling Parent.FunctionName.
LoadHtmiIDialog(html, options)

Creates and loads an html dialog box. Accepts an Html string or an Html element.
Accepts several options.

Description
SetDialogValue(elementld, value)
Description Populates the given element of a dialog with a given value.

GetDialogElementByld(elementID)

Description Finds and returns the element given by its ID.
Alert(alertText)
Description Creates and loads an html alert dialog with the given text.

UpdateChart(chartWidget, chartData)

Description Updates the given chart with the given data and re-renders it in the report.
GetDashboardReports(options)

Description Returns all the reports on the dashboard as report objects.
GetDashboardWidgets()

Description Returns all the widgets on the dashboard (i.e. all dashboard elements besides
P embedded reports).

EditReport(reportName, options)

Description Opens the Report Designer for the given report with options. See .NET API.
ExecuteReport(reportName, exportType, options)

Description Executes the given report with options. See .NET API.
StartNewReportWizard(report Type)

Description Starts the New Report Wizard for the given report type.
GetClientReportObject(reportName)

Description Returns the given report object by name.

LoadUri ToNewTab(string url)

Description Opens a new tab with the provided URL as the contents.

How to Inspect Session Data and Debug Extensions

Using a debugger to inspect session data is a good way to leam how to interact and extend application functionality. This
guide explains how to inspect session state for events which allow you to insert custom event handlers. The Visual
Studio debugger and Google Chrome javascript console are used in this demonstration, but other tools can be used as
well.

Caution: These methods cause program halting, and are therefore not for use in a production environment.
Part 1 explains how to inspect sener data for use with Server Events and Custom Functions.

Part 2 explains how to inspect client data for use with Action Events.

Server Data
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You can inspect sener data by calling out to an assembly with a debugger statement in a Sener Event or Custom
Function. By attaching the process to a debugger you can see the object variables currently in use.

First, build an assembly that has a public method call to launch the debugger. This can be accomplished in only a few
lines of code. The method should pass in the sessioninfo object as an argument.

Note: The assembly needs a reference to the WebReportsApi.dll file in the {Exagoj\bin folder.
Example

namespace Extensions

{

public class ServerEvents

{

public static void LaunchDebugger (WebReports.Api.Common.SessionInfo sessionInfo)

{

System.Diagnostics.Debugger.Launch () ;

You could also use an object array argument to make it easier to pass in any other session variables you want to
inspect.

Example
public static void LaunchDebugger (params object[] args)

Compile the program as a .dll assembly in Debug mode. Then copy the .dll to the {Exago}\bin folder. Keep Visual
Studio open in the background so that the debugger is recognized.

D¢ Extensions - Microsoft Visual Studio (Administrator) YH & | Quick Launch (Ctril+Q) Pl - B x
File Edit View Project Build Debug Team  Tools Test WebEssentials Analyze Window Help Sign in E
fe-o | @ E| - | Debug -~ AnycPU - b St | g | |m _

ServerEvents.cs £ X
[ Extensions

Solution Explorer > X

@ o-5a f-
Search Solution Explorer (Ctrl+;) P~

- | #3 Extensions.ServerEvents «|® LaunchDebugger(Sessionlnfo sessionlr ~

1 using kebReports.Api.Common; ES
-

=namespace Extensions

{

{

System.Diagnostics.Debugger. Launch();

78] Solution 'Extensions' (1 project)
4 s[c¥] Extensions

b A Properties

> =B References

b +c* ServerEvents.cs

P €* CustomFunctions.cs

b v ¢ DataSource.cs

I €* Externallnterface.cs

Solution Explorer EET R D SN elEERNEN

Properties

Itemis) Saved 4 Bdensions %' master «
Code to launch the Visual Studio debugger

Next, open the Exago Administration Console and add a new Senver Event or Custom Function. For a Sener Event, set
the Global Event type to the application state that you want to inspect.

Inspect Sessioninfo

Name InspectSessioninfo
Function Custorn Code ServerEvents LaunchDebugger{sessioninfo);...
Global Event OnReportExecuteStart

Setting the event to fire at the start of a report execution

In the custom code window, add your .dil as a reference, and add the namespace if necessary. Then in the code field,
call the debugger method, passing in the sessioninfo object and any other variables relevant to the session state.

Note: Make sure to use the correct retum value for the Global Event.

Example

ServerEvents.LaunchDebugger (sessionInfo) ;
return null;

Click the green check mark to verify that the code is valid. Then click OK to sawe the event.
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Custom Code x

Language CSharp References  Extensions.dll

Mamespaces Extensions

1 ServerEvents.LaunchDebugger(sessionInfo);

2 return null;|

Calling the debugger method from the Server Event

Next, launch the Exago interface and cause the Sener Event or Custom Function to fire. An exception will occur and
Visual Studio will ask you to debug the process. Select the instance of Visual Studio with your assembly code and click
Yes.

Visual Studio Just-In-Time Debugger d

An unhandled Microsoft .MET Framework exception occurred in w3wp.exe

[7450].

Possible Debugaers:

Extensions - Microsoft Visual Studio (Administrator): Microsoft Visual Stu
New instance of Microsoft Visual Studio 2015

Set the currently selected debugaer as the default.

[Imanually choose the debugging engines.

Do you want to debug using the selected debugger?

Yes Mo

Visual Studio exception handler

Finally, if an Attach Security Waming appears, click Attach.

Tl

ision
Attach Security Warning ? >

I Attaching to this process can potentially harm your computer.

. If the infermation below looks suspicious or you are unsure, do
. not attach to this process, .

MName: wiwp.exe

User: 115 APPPOOLYNET wd.5

Do you want to attach to this process?
| Attach Don't Attach

Attach the debugger to the Exago process

The Visual Studio debugging and diagnostics tools will launch for this program instance. There are many tools available,
but for now focus on the Autos window. This shows all of the variables in use for the application at the moment. Any
arguments passed into the debugger method, including sessioninfo, are available to inspect. This is a great way to see
how variables are used at different points in the application, and to learn about how the APl is structured.
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ServerEvents.cs & 1 X

[c#] Extensions = %z Extensions.ServerEvents ~| @ LaunchDebugg

1 using WebReports.Api.Common;
2
3 —namespace Extensions
4 {
5 = public class ServerEvents
6 {
7 = sessionInfo)
8 {
[ 9 System.Diagnostics.Debugger.Launch();
1@
1 T
12
13 ¥
14 }
99 % -
Autos * X
MName Value Type
4 {WebReports. Api.Common.Sessionlnfo} WebRep|
& Companyld "Alex" Q ~ string
I S CompositeReport null WebRep
& CurQuarter 1 int
I J Javascriptiction {WebReports. Api.Programmability JavascriptAction} WebRep
I S Pagelnfo {WebReports.Api.Common.Pagelnfo} WebRep
I S Report {WebReports.Api.Reports.Report} WebRep
I & ReportObject {WebReports.Api.Reports.Report} WebRep
I €3 ReportSchedulerService ‘sessioninfo.ReportSchedulerService' threw an exception of type 'System.Exceptio WebRep
I J SetupData {WebReports.Api.Common.SetupData} WebRep
b S Today 12017-06-27 00:00:00} Systern.[
€3 Userld ‘sessioninfo.Userld’ threw an exception of type 'System.MullReferencebxception’  string {5
I S VisualizationReport null WebRep
I #3 Static members
I & Mon-Public members

Inspecting sessioninfo data

Click the Continue or Stop buttons to exit the debugger when you are finished.

Client Data

You can inspect client data by inserting a debugger statement into the page's javascript using an Action Event. This lets
you use your browser’s javascript console to inspect the client objects, such as application DOM and report output data.
Unlike Sener Data, debugging client data requires no external software.

The javascript code can be implemented in an assembly, imported into the Exago home page, or written directly in the
Administration Console. This example uses an assembly.

First, use the proper method formatting to add an Action Event which simply calls the javascript debugger. The
encapsulating C# method must pass in the sessioninfo object, and retum sessionlinfo.JavascriptAction which contains
the client-side javascript.

Example

using WebReports.Api.Common;
using WebReports.Api.Programmability;

namespace Extensions

{
public class ActionEvents

{
public static JavascriptAction LaunchConsole (SessionInfo sessionInfo)

{
sessionInfo.JavascriptAction.SetJsCode (" (function () { debugger; }())"):;

return sessionInfo.JavascriptAction;

Note: Using an anonymous function wrapper is not required for all action events, but it is more broadly compatible, and
thus recommended.
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using WebReports.Api.Common;
using WebReports.Api.Programmability;

namespace Extensions

{ public class ActionEvents
{
public static JavascriptéAction LaunchConsole(SessionInfo sessionInfo)
{
sessionInfo.JavascriptAction.SetlsCode(" (function() { debugger; 1())");
return sessionInfo.JavascriptAction;
¥
¥
1

The javascript code is the string argument of JavascriptAction. SetJsCode

If you are using an assembly, compile the program as a .dll, then copy it to the {Exago}\bin folder. If your javascript is in a
separate .js file, copy that as well.

Next, open the Exago Administration Console and add a new Action Event. Set the Event Type to Click or Load if you
want to attach the event to a specific occurrence in the Report Designer or on a Report. Set the Global Event Type if you
want to attach the event to a general application action.

LaunchConsole

Name LaunchCensole

Function Customn Code return ActionEvents LaunchConscle|sessioninfo); W
Ewent Type Click

Global Event Type Mone

Assigned Ul fem(s)

"Click" events can be attached to report items or buttons in the Report Designer

In the custom code window, add the assembly .dll as a reference. In the code field, retum the Action Event method,
passing in sessioninfo as an argument.

Example
return ActionEvents.LaunchConsole (sessionInfo) ;

Click the green check mark to verify that the code is valid. Then click OK to save the event.
Custom Code 4

age sha erences i
Language |CSharp References Extensions.dll

Mamespaces Extensions

1 return ActionEvents.LaunchConsole(sessionInfo);

Calling an Action Event in an assembly

Next, launch the Exago Ul. If you are using a Local action event, with a type Click or Load, then attach the event to an
item in the report designer or on a report.

Press F12 to open the browser's Developer Tools. Finally, cause the Action Event to fire. The browser will load the object
state in the debugger. Click the Sources tab and focus on the right-most pane. Expand the Scope pane to see the client
object data. The clientinfo object contains the data most relevant to the application session. You can see the current
state variables, and you can browse the structure of the client data to learn how to develop Action Events for your Exago
environment.
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Paused in debugger | b |/ ® ] CFlements Console Sources MNetwork Performance » @141 & X
Sources | Content scripts  Snippets i[9 |wmi993 x| »
*O top - 1| (function() { _
¥ localhost
v I 20171
» B ApplicationThemes/Basic -
a v {} Line 1, Column 15 ™
IP‘ o ot gb @ | O Async Scope | Watch
O Del ey paused “ | ¥ Local -
bugger pa » this: Window
¥ Call Stack Closure
# (anonymous) VM1993:1 {UtilitiesClass.Evaluatefction)
» actionData: Object
(@nonymous) VM1993:1 ®» arguments: Arguments{3)
UtilitiesClass.EvaluateAction ¥ clientInfo! wrClientInfoClass
WrSeriptResourc...r Toolbar...:15 categoriesCtrl: null
wrACExe 'WrScriptResourc...riCerl Clien...:1 ¥ chartData: Obje';t .
> chartItemDataPoint: Object
(anonymous) VM1991:2 chartSeriesDataPoint: null
{anonymous) VM1992:1 » contextObject: wrHtmlViewerClass
(anonymous) dashboard: null
WirScriptResourc...ts.charts f..:5 tlﬂashboar‘dltem: nui
includeReportData: true
(anonymous) includeReportSaveData: true
WrScriptResourc..ts.charts f..:5 b internal: Object
¥ Breakpoints isSandboxMode: false

parameterListCtrl: null
No Breakpoints refreshDataOnReturn: true

» XHR Breakpoints report: null -

mDONAD

Examining clientinfo variables

Press F8 to continue or F12 to close the debugger when you are done.

Introduction to the .NET API

The Exago interface consists of two elements: The User Interface and the API. The User Interface is built directly onto the
.NET API. This means that .NET applications can interface directly with Exago. Non-.NET applications can interface with
the SOAP Web Service API or the REST Web Service API, which offer subsets of the .NET API.

This guide will walk through the process of integrating Exago into a .NET-based web application. We will demonstrate
how to use the API to connect with an existing installation of the Exago Application, and showcase how to do some
basic report management tasks. For a full list of classes see the Technical Guide.

For this example, we will load an existing report, modify its run-time filters, and then execute the report in a browser
window.

Referencing the Api

First reference the Web Reports API library. This is usually located in your Installation Directory > bin folder, and is
called WebReportsApi.dll. This library contains all the namespaces necessary to utilize the Web Application's features.

Include the following namespaces for now:

o WebReports.Api: Contains the Api class which is the main interaction class between Exago and your
application.

o WebReports.Api.Reports: Contains the Report class, for creating and managing reports.

¢ WebReports.Api.Roles: Contains classes for managing role security settings.

Creating an Api Object

An Api Object is the main class you need to create in order to interact with Exago. It contains the first and last points of
entry for each instance of your application.

Create an Api Object using the following overloaded constructor:
Api myApi = new Api (AppPath);

AppPath is the physical or virtual location of your Exago installation.

NOTE: You can use the ConfigFile parameter to load an Exago Config file. If left out, it will default to WebReports.xml.
NOTE: Do not call the constructor method with empty parameters.

Loading a Report

Now let's load the report we want to modify.
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Report myReport = (Report)myApi.ReportObjectFactory.LoadFromRepository (@"TestReport") ;

NOTE: You do not need to specify the file extension. The application will not allow reports of the same name but
different types.

The ReportObjectFactory class is the collection class for report management methods. This contains methods for
creating, loading, copying, saving, renaming, and deleting report files. It can be used to work within a repository or a
temporary browser session, or both if necessary. In this case, we're simply loading a pre-existing report into the Api.

NOTE: Seweral methods reference an Active report by default. This is usually the last report accessed, but can be
specified by the Active property of the ReportObjectFactory.

Reports called from within the ReportObjectFactory are ReportObject objects, which is a general class representing the
various report types.

We are casting the ReportObject called from the factory to a Report, because we know it is a report. Report inherits
seweral methods from ReportObject, but greatly expands the management capabilities.

Note: If we loaded a dashboard report or a chained report, we would cast it to DashboardReport or ChainedReport
respectively.

See Loading Reports in the .NET API for more information.
Retrieving the Role Security
Let's see if the current user has access to the database object we want to filter for.

if (myApi.Roles.ActiveRole.Security.DataObjects.GetDataObject ("Customers") != null)
{ Permission Granted!; }

else Permission Denied!;

The Roles object allows for accessing and modifying the elements found within the Admin Console. Changing or adding
Role settings will only persist for the current session, and will not modify the config file.

We can also set some additional security and restrict the user from seeing specific data object rows:
DataCbjectRow dataObjectRow = myApi.Roles.ActiveRole.Security.DataObjectRows.NewDataObjectRow () ;

dataObjectRow.ObjectName = "SSN";
dataObjectRow.FilterString = "false";

Modifying the Report

Now that we have loaded and declared our Report object, we can begin to modify its contents. Let's clear out the pre-
existing runtime filters, and add one of our own:

foreach (Filter oldFilter in myReport.Filters)
{ myReport.Filters.Remove (oldFilter); }

Filter myFilter = myReport.Filters.NewFilter () ;
myFilter.DbName = "Customers.CompanyName";
myFilter.Operator = wrFilterOperator.NotEqualTo;
myFilter.Value = "Exago Inc.";

myFilter.AndOrWithNext = wrFilterAndOrWithNext.And;

Note that all these modifications will take place within the current session, and will not modify the report data unless you
specifically overwrite the report file.

Closing the Session and Executing
That's enough for now; Let's execute the altered report. First, some administrative stuff.

Set the report execute type to HTML, so it runs in the browser:
myReport .ExportType = wrExportType.Html;
And hide the application tabs to awoid clutter:

myApi.ShowTabs = false;
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Now sawe the changes we've made to the Api. This will load the report into a temporary space in the Api to prepare for
execution.

myApi .ReportObjectFactory.SaveToRpi (myReport) ;

And we're all set! Calling the following method will end the session, performing the specified action, and retumn the
session URL. The session URL is an alphanumeric single-use identifier for the session. Append it to your Exago
application URL.

Since we loaded a report into the Api, the action defaults to Execute.

string url = @"//MyDomainServer/Exago/" + myApi.GetUrlParamString (ExagoHome) ;

The ExagoHome parameter can be used to specify the Exago application's home page. It will default to
ExagoHome.aspx.

Now redirect your browser to the generated URL and see the results!

Load Reports inthe .NET API

The ReportObject Class

All Report type objects inherit from ReportObject. The class includes basic functions such as loading and saving the
objects. Report type objects consist of simple report types such as express and standard, and composite types such as
dashboard and chained.

Accessing Reports via the API

A Report is normally loaded via API in order to launch directly into the execution or editing of the report. In most cases,
report loading is handling by the Exago runtime via the LoadFromRepository call. LoadFromRepository retums an
object of type ReportObiject. In order for the load to complete, a corresponding SaveToApi is done. SaveToApi will
sawe the ReportObject, including any modifications back to the API for loading (for execution or editing).

Both LoadFromRepository and SaveToApi can be accessed via the Api .ReportObjectFactory property.

Both LoadFromRepository and SaveToApi retum and store a ReportObject respectively. Most modifications
made to a report loaded at runtime (such as changing filter values) are performed on properties defined within the child
types (such as Report or DashboardReport). Such modifications would require a cast of the Reportobject to the
appropriate child type.

If no modifications are required, the sequence is simple:

//Load the report. refers to the full folder path

//followed by the report name

ReportObject ro = api.ReportObjectFactory.LoadFromRepository () ;
//Save the report back to the API
api.ReportObjectFactory.SaveToApi (ro) ;

If modifications are desired, it is necessary to cast the value retumed by LoadFromRepository to the appropriate base
type. Supported base types include WebReports.Api.Reports.Report for standard, express, and crosstab reports,
WebReports.Api.Composite.Dashboard.DashboardReport for dashboards, and
WebReports.Api.Composite.Chained.ChainedReport for chained reports

For example, you can modify Filters on a report to be executed as follows:

//Load the report. refers to the full folder path

//followed by the report name

Report report = api.ReportObjectFactory.LoadFromRepository () as Report;
report.Filters[0].Value = ;

//Save the report back to the API
api.ReportObjectFactory.SaveToApi (report) ;

Note that the filter change will only apply to this execution of the report. The report design itself will not be modified.

Note also that all elements of the Report object (as opposed to the ReportObject object!) can be modified in this
manner. It is also possible to build a report from scratch in the API. There are examples in production of clients that have
programatically built their own reports.

.NET API General Reference
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This article contains a list of examples for using the .NET API's various features. The .NET API can be used for many
purposes, and the most common is to create secured access points for end-users via browser sessions. However, you
can also use the API to create and manage schedules, generate config files and reports programmatically, edit existing
reports, and more.

Note: This guide is kept up to date for the most current version available. For a list of changes in the API, see the
Updating Guide.

Getting Started

Exago BI .NET applications must include a reference to the file WebReportsApi.dll, found in the bin folder of the
application directory. This contains all the classes and method groups necessary for the examples in this article.

Optional: If you are connecting to a .NET Assembly Data Source, you will need to include a reference to
WebReportsAsmi.dll. A reference to WebReports.dll is unnecessary, except in some rare cases that are not
discussed in this guide.

The following Exago Bl namespaces are used in the examples in this guide:

o \WebReports.Api

o WebReports.Api.Reports

o WebReports.Api.Common

o WebReports.Api.Data

o WebReports.Api.Roles

o WebReports.Api.Programmability
o \WebReports.Api.Scheduler

o WebReports.Api.ReportMgmt

o \WebReports.Api. Theme

As well as the following system namespaces:

o System.Collections.Generic
e System.Ling
o System.Xml

Contents

o API Object

e Sorts and Filters

o Settings

¢ Role Permissions

o Advanced Configuration

e Scheduling

e Managing Files and Folders

API Object

An API object must be instantiated at the start of an API application, as the access point for all API activity. API objects
also encompass sessions which are used to encapsulate user-specific changes, such as security and permissions
settings.

Note: Variable names, such as "api" and "report”, are declared in their respective sections in this guide, then referenced
throughout the remainder.

Constructors

Basic constructor. appPath is file path or virtual path to Exago base installl.
Api api = new Api ("appPath");

Specify a config file (other than the default WebReports.xml)

Api api = new Api ("appPath", "configFn");

Custom config file and its location in Azure storage (must match web.config)
Api api = new Api ("appPath", "configFn", "azurePath");

Let the host application configure log4net

Api api = new Api ("appPath", bool isLogCustomConfig, "configFn");
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Write to the log file

Logger logger = Log.GetLogger () ;
logger.Info("message"); // writes at info level

API Action

Where to direct the Exago interface when first loaded. Edit or Execute actions work on "active" report.
api.Action = wrApiAction.Home;
Hide tabbed Ul

api.ShowTabs = false;

Active Report

Load a report from repository. Makes it the active report. "reportName” is the fully qualified path relative to the base report
directory, without file extension. ReportObject is a generic class encompassing all report types.

ReportObject reportObject = api.ReportObjectFactory.LoadFromRepository ("reportName") ;
Report is validated (checked for errors) unless owerridden

ReportObject reportObject = api.ReportObjectFactory.LoadFromRepository ("reportName", bool validate)
‘] o

Manually validate

reportObject.Validate() ;

Check the errors list. See list of error types.

foreach (ReportValidationError error in report.ValidationErrors)

{
string.Format ("Error: {0}\n\t{1}\n\t{2}\n",

error.ReportErrorType.ToString (),
error.Datal,
error.Data2) ;

Get the report type

string reportType = reportObject.ReportType.ToString() ;

Cast the report object to higher level class

Report report = (Report)reportObject;

Validate the export type

bool IsReportAllowPdfExport report.IsExportTypeAllowed (wrExportType.Pdf) ;
bool IsConfigAllowPdfExport = api.General.AllowPdfOutput;

Set the export type

report.ExportType = wrExportType.Pdf;

Launch Exago and Execute Report

To launch in a browser frame with specified Action, get the App URL to redirect the browser. Redirecting to the App URL
closes the API to further changes. It should be the last thing done.

Get the App URL, with the default home page "ExagoHome.aspx"
string appUrl = api.GetUrlParamString() ;
Specify a custom Exago home page. homePage is the file name, without the file extension.

string appUrl = api.GetUrlParamString ("homePage") ;
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Set ShowEmorDetail to true, for more detailed user error messages

string appUrl = api.GetUrlParamString(null, true);
// this is equivalent to:
string appUrl = api.GetUrlParamString() + "?ShowErrorDetail=true";

Redirect the browser to the App URL. This will close the API to any further changes.

Frame.Src = baseUrl + appUrl;

GetExecute

As an alterative to Api Action, reports can be executed and the data returmned directly to the application. This will not
close the API. Since this does not launch Exago, report interactivity is not supported - only bare HTML or JSON, etc.
Acts on the specified report, not the active report.

string reportHtml = report.GetExecuteHtml

’
’

string reportJson = report.GetExecutedson

’

byte[] reportData = report.GetExecuteData

’

0
0
0
string[] reportSqgl = report.GetExecuteSql ()

Sorts and Filters

You can add sorts and filters to reports at runtime. After making changes, sawe back to the API for execution in the
session.

api.ReportObjectFactory.SaveToApi (report) ;
Changes could be saved back to the report file on disk
api.ReportObjectFactory.SaveToRepository (report) ;
Sawe edited report as a new report

api.ReportObjectFactory.Copy (report, "newName", null);

Sorts

See the existing sorts in a report

foreach (Sort sort in report.Sorts)

{

string.Format ("{0}, {1}\n", sort.SortText, sort.Direction);

Add a new sort to a report

report.Sorts.Add (new Sort (api.PageInfo)

{
// use object Alias name, and field Alias name if set
SortText = '{' + objectName + '.' + fieldName + '}
Direction = wrSortDirection.Ascending

1

Formula sort

SortText = string.Format ("=Formula ({{{0}.{1}}})", objectName, fieldName);
Sorts is an ordered list. Reorder the list to change the precedence of the sorts.

// move a sort from position 3 to position 1

for (int 1 = 3; 1 > 1; i--)

{
Sort temp = report.Sorts[i - 1];

report.Sorts[i - 1] = report.Sorts[i];
report.Sorts[i] = temp;

}

Filters
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See the existing filters in a report

string filterString = ""; // build a filter summary string for display
foreach (Filter f in report.Filters)
{
filterString += string.Format ("{0}{1} {2} {3}{4}",
new string(' (', f.GroupStartCnt),
f.Name,
f.DisplayOperatorText,
f.DisplayValue,
f.GroupEndCnt > 0 ? new string(')', f.GroupEndCnt) : ' ' + f.AndOrValue + ' ');

Add a new filter

// get the data field info (should first check that the report contains the entity)

EntityColumn field = report.Entities.GetEntity ("objectName") .GetColumn ("fieldName") ;

report.Filters.Add (new Filter (api.PageInfo)
{

Name = field.FullName, // object and field Alias names
DataType = field.DataType,
Operator = wrFilterOperator.OneOf, // this filter type takes multiple values

DataValues = new DataValueCollection ()

{

new DataValue (api.PageInfo, field) { Value = "valuel" },
new DataValue (api.PageInfo, field) { Value = "value2" }
}
1
Group Min/Max filters
string groupFilterString = ""; // build a filter summary string for display

int i = 0;
foreach (GroupFilter filter in report.GroupFilters)
{
groupFilterString += string.Format ("{0} {1} for each {2} {3}{4}",
filter.DisplayOperatorText,
filter.Name,
filter.GroupName,

filter.IgnoreOtherGroups ? "ignoring other groupings" : "",
(1 < report.GroupFilters.Count()) 2 ", "™ : "" );
i++;
}
Add a new group filter

// should check that the entity and sorts exist on the report
EntityColumn field = report.Entities.GetEntity ("objectName") .GetColumn ("fieldName") ;
Sort sort = report.Sorts.GetSort ("sortName") ;

report.GroupFilters.Add (new GroupFilter (api.PageInfo)
{

Name

field.FullName, // object and field Alias names

Operator = wrGroupFilterOperator.Maximum,

GroupName = sort.SortText // or sort.Entities[0].Name, or "EntireDataSet"
b

See Top N filter
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// build a filter summary string for display
// reports limited to one Top N filter, max one foreach group per filter
string topNFilterString = "";
if (report.TopNItems.Count () > 0)
{
if (report.TopNItems[0].UseTopNItem)
{
TopNItem filter = report.TopNItems[0];
topNFilterString = string.Format ("{0} {1} {2}{3}",
filter.Action == TopNAction.top ? "Top" : "Bottom",
filter.Number,
report.Cells.GetCellById (filter.CellId) .DisplayText,
(filter.ForEachGroup.Count () > 0) ? " for each " + filter.ForEachGroup[0] : "");

Add Top N filter

// check that the cell exists
int cellld = report.Cells.GetCell (int row, int col).Id;

TopNItem topN = new TopNItem (api.PageInfo)
{

Action = TopNAction.top,
Number = int N, // the N in "Top N"
CellId = cellld,

ForEachGroup = new List<string> { },
UseTopNItem = true

}i

// must be at zero-index position

if (report.TopNItems.Count () == 0)
report.TopNItems.Add (topN) ;

else
report.TopNItems[0] = topN;

Settings

Change the values of config settings and parameters dynamically, often depending on user access rights. A dynamic
config can be thought of as an extension of a Role, although Roles aren't necessarily required.

Change config setting
api.General.anySetting = newValue;
See Config File and API Setting Reference for the full list of config settings.

Parameters

Parameters are "buckets" for values that persist throughout a session, and are reachable by extensions. You can use
them to set custom environment variables. userld and companyld are built-in parameters for storing user information.

Caution: The .NET namespace System.Web.Ul.WebControls also contains a class called Parameter. You may wish to
alias one or both classes to resolve name conflicts.

using wrParameter = WebReports.Api.Common.Parameter;
List config parameters
foreach (Parameter parameter in api.Parameters)
{
string.Format ("Name: {0}, Value: {1}\n", parameter.Id, parameter.Value);
Get a specific parameter by Id

Parameter parameter = api.Parameters.GetParameter ("parameterId");

Add a new parameter
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api.Parameters.Add (new Parameter (api.Pagelnfo)
{
Id
DataType = (int)DataType.String,

"foo", // no spaces

Value = "bar"

1) i
Non-hidden parameters are usable on reports
parameter.IsHidden = false;
Prompting parameters will ask the user for a value when running a containing report
parameter.PromptText = "Enter a value";
Prompting parameters can display a selection list based on a data field or custom SQL

Entity entity = api.Entities.GetEntity ("entityName");

parameter.DropdownDataSourceId = entity.DataSourceld;
parameter.DropdownObjectType = entity.ObjectType;
parameter.DropdownDbName = entity.DbName;
parameter.DropdownValueField = entity.GetColumn ("colName") .Name;

parameter.DropdownDisplayValueField = entity.GetColumn ("colName") .Name;

Save to Disk

Creates .xml and encrypted .enc files in the Temp directory. If isPermanent = true, creates the files in the Config
directory, overwriting the existing config files.

api.SaveData (bool isPermanent) ;

Role Permissions

Roles are a neat way to encapsulate a collection of permissions. Roles also allow for some more fine grained control over
data and folder access than the base config settings. Only one role can be active at a time.

Get a specific role

Role role = api.Roles.GetRole ("roleId");

Create new role

api.Roles.Add (new Role (api.PageInfo) { Id = "roleId", IsActive = true });

Edit role settings

role.General .AnySetting = "value";

Folder/Object/Row Security

role.Security.Folders.IncludeAll = true;

role.Security.Folders.Add (new Folder () { Name = "folderPath", ReadOnly = true });
role.Security.DataObjects.Add (new DataObject () { Name = "objectName" });

role.Security.DataObjectRows.Add (new DataCbjectRow ()
{

ObjectName = "objectName",

FilterString = "filterString"
1

Activate a role

role.Activate () ;

Advanced Configuration

You can dynamically change data sources, objects, joins, etc., in the API, or simply use these settings to
programmatically generate a config file.

Data Sources
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View data source
api.DataSources.GetDataSource ("dataSourceName") . DataConnStr;
Create a new data source

api.DataSources.Add (new DataSource (api.PageInfo)
{

Name = "dataSourceName",

DbType

DataConnStr = "connectionString"”
b

Constants.DatabaseType.SqlServer,

Data Objects

View data objects

foreach (Entity entity in api.Entities)
{
// three ways to identify an entity
string.Format ("Alias: {0}, Id: {1}, Database Name: {2}\n",
entity.Name, // Alias
entity.Id, // 1Id
entity.DbName // Database Name
)i

Get a specific data object

Note: This is the recommended way to get an entity by name, but there are other methods provided as well

Entity entity = api.Entities.GetEntity("entityAlias"); // returns null if it does not exist
// best to retrieve entities by Alias name, because Aliases are unique and required
// Ids are unique, but not required; Db names are required, but not unique (across sources)

View object fields

foreach (EntityColumn column in entity.Columns)
{
string.Format ("Alias: {0}, Database name: {1}\n",
column.Name, // Alias (or actual if no alias)
column.ActualName // Database name
)i

Create new data object
Entity entity = new Entity(api.Pagelnfo)

{

DataSourceId = api.DataSources.GetDataSource ("dataSourceName") .Id,

ObjectType = DataObjectType.Table,

DbName = "databaseName", // required

Name = "aliasName", // required, unique
Id = "idName" // unique

i

// add key column

entity.KeyColumns.Add (new KeyColumn (entity.GetColumn ("colName") .ActualFullName)) ;

api.Entities.Add(entity) ;

SQL Object

entity.SglStmt = "SELECT * FROM Employees";

Add tenanting to object

entity.Tenants.Add (new EntityTenant (api.PageInfo,
entity.Name,
entity.GetColumn ("colName") .ActualFullName, //get col by Alias but supply ActualFullName

"parameterId" //tenant parameter
)i
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Filter dropdowns

entity.FilterObjectType = DataObjectType.Table; // Table, View, Function, Procedure, etc.
entity.FilterDbName = "FilterObjectName";

// or custom SQL:

entity.FilterObjectType = DataObjectType.SqglStmt;

entity.FilterSqglStmt = "SELECT etc...";

Joins

See all config joins

// build the join string for display
string joinString = "";

// all config joins; for report joins, use report.Joins
foreach (Join join in api.Joins.OrderByDescending (x => x.Weight)) // order by weight
{
foreach (JoinColumn col in join.JoinColumns)
{
joinString += string.Format ("{0} {1} {2}{3}\n",
col.FromColumn.FullKeyName,
join.JoinText,
col.ToColumn.FullKeyName,
join.RelationType == 1 2 "(s)" : "" // l-to-Many
)i
}
if (join.Weight > 0) joinString += ("Weight: " + Jjoin.Weight + "\n");

Get specific join
Join join = api.Joins.GetItem("fromEntity", "toEntity", false);

Create a new join

Entity fromEntity = api.Entities.GetEntity ("fromName");
Entity toEntity = api.Entities.GetEntity ("toName");

Join newJoin = new Join (api.PageInfo)

{

EntityFromName = fromEntity.Name,

EntityToName = toEntity.Name,

Type = (int)JoinType.Inner,

RelationType = 0, // 0: One-to-One, 1: One-to-Many
Weight =0

1
// add the key columns
newJoin.JoinColumns.FromColumns.Add (
new KeyColumn (fromEntity.GetColumn ("fromColName") .ActualFullName)) ;
newJoin.JoinColumns.ToColumns.Add (

new KeyColumn (toEntity.GetColumn ("toColName") .ActualFullName)) ;

// add to the config. for reports, use report.Joins.Add()
api.Joins.Add (newJoin) ;

// 1if there is an active report, recreate the joins
report.CreateJoins () ;

Custom Functions

Get a specific function
UdfFunction function = api.CustomFunctions.GetItem("functionName") ;

Create a new function
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UdfFunction newFunction = new UdfFunction (api.PageInfo)

{

Name

"functionName",

AvailableIn = UdfFunctionAvailableType.Formula, // custom or filter function
//MinArgs = 0, (deprecated in v2017.2)
//MaxArgs = 0, (deprecated in v2017.2)

ArgumentsJson = "[{'Name':'argName', 'Required':true, 'Description':'desc'}]", // (v2017.2+)
Language = CodeLanguage.CSharp.ToString (),
ProgramCode = "Code () ;"

i
// add any references and namespaces
newFunction.Namespaces.Add ("Program.Namespace") ;

newFunction.References.Add ("Reference.d1l1l") ;

// add to the config
api.CustomFunctions.Add (newFunction) ;

Server Events

Get a specific sener event
ServerEvent serverEvent = api.ServerEvents.GetByName ("eventName") ;
Create a new sener event

ServerEvent newEvent = new ServerEvent (api.PageInfo)
{
Name = "eventName",
EventType = ServerEventType.OnReportExecuteStart, // global event, or "None"
}i
// custom code
newEvent . ServerCode.CustomCode . Language = CodelLanguage.CSharp;

newEvent . ServerCode.CustomCode . ProgramCode = "Code () ;";

// code from data source

newEvent.ServerCode.DataSourceld = api.DataSources.GetDataSource ("eventsAssembly") .Id;

newEvent.ServerCode.FunctionName = "functionName";

// add to config
api.ServerEvents.Add (newEvent) ;

// add to a report (must be in config)
report.ServerEvents.Add (new ReportServerEvent (api.PageInfo)
{

EventType = ServerEventType.OnDataCombined,

EventId = api.ServerEvents.GetByName ("eventName") . Id
b

Scheduling

View schedule list
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List<Exception> exceptions;

// build the job list string
string jobList = "";

foreach (List<JobInfo> schedule in api.ReportScheduler.GetJoblList (out exceptions))
{
foreach (JobInfo job in schedule.OrderBy (x => x.NextExecuteDate) .ThenBy (x => x.Name))
{
joblList += string.Format ("Job '{0}' for report '{1}' ",
job.Name,
api.ReportScheduler.GetReportScheduleInfoByJobId (job.JobId.ToString() ) .ReportBaseName
);

switch (job.Status)
{
case JobStatus.Completed:
jobList += string.Format ("ran on {0}, at host {1}.\n",
job.LastExecuteDate.ToString ("MMM d hh:mm tt"),
api.ReportScheduler.GetHost (api.ReportScheduler.GetHostIdxForJob (job.JobId) )
);
break;
case JobStatus.Ready:
jobList += string.Format ("ready to run on {0}.\n",
job.NextExecuteDate.ToString ("MMM d hh:mm tt")
)i
break;
case JobStatus.Deleted:
case JobStatus.Removed:
case JobStatus.Abended:
case JobStatus.UserAbort:
jobList += string.Format ("ended. Last run on {0}, at host {1}.\n",
job.LastExecuteDate.ToString ("MMM d hh:mm tt"),
api.ReportScheduler.GetHost (api.ReportScheduler.GetHostIdxForJob (job.JobId) )
)
break;
default:
jobList += string.Format ("status unknown.\n");
break;

Create an immediate schedule (basic options)

// run-once, immediately, save to disk
string jobId; // use to retrieve schedule info later for editing
int hostIdx; // assigned execution host id

ReportScheduleInfo newSchedule = new ReportScheduleInfoOnce ()
{

ScheduleName = "Immediate Schedule", // schedule name
ReportName = @"Report\Full\Path", // report path
ReportType = wrReportType.Advanced, // report type
RangeStartDate = DateTime.Today, // start date
ScheduleTime = new TimeSpan (DateTime.Now.Ticks), // start time
SendReportInEmail = false // email or save

i

// send to the scheduler; wrap in try/catch to handle exceptions
try {
api.ReportScheduler.AddReport (
new ReportSchedule (api.PageInfo) { ScheduleInfo = newSchedule }, out jobId, out hostIdx);
}
catch (Exception) { }

Recurring schedules (additional options)

Daily
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ReportScheduleInfo newSchedule = new ReportScheduleInfoDaily ()

{
... // include basic options
// range of recurrence, every N days, or every weekday
DailyPattern = ReportScheduleInfo.DailyPatternType.EveryNDays,
EveryNDays = 2, // N days

// end date (optional):
RangeEndDate = DateTime.Parse ("December 25 2017"), // end on a specific date

RangeNOccurences = 10, // or end after N occurrences

// intraday recurrence (optional) :

RepeatEvery = true, // enable intraday recurrence
RepeatEveryHours =4, // repeat every N hours
RepeatEveryMinutes = 0, // and N minutes

RepeatEveryEndTime = new TimeSpan (DateTime.Parse ("12:00 PM").Ticks) // optional end time

Weekly

ReportScheduleInfo newSchedule = new ReportScheduleInfoWeekly ()
{
// include basic options
// optional end date, optional intraday recurrence
EveryNWeeks = 1, // every N weeks

// on these days: Sun Mon  Tues Wed Thurs Fri Sat
IsDayOfiWleek = new bool[] { false, true, false, false, true, false, false }
}
Monthly

ReportScheduleInfo newSchedule = new ReportScheduleInfoMonthly ()
{
// include basic options
// optional end date, optional intraday recurrence
// specific or relative day pattern
MonthlyPattern = ReportSchedulelInfo.MonthlyPatternType.SpecificDayOfMonth,

// specific: day X of every N months
SpecificDayOfMonth = 7, // day of the month
SpecificEveryNMonths = 2, // every N months

// relative: the Xth day-of-week of every N months
RelativeWeekOfMonth = ReportScheduleInfo.WeekOfMonthType.First, // week of month

RelativeDayOfiWeek = ReportSchedulelInfo.DayOfleekType.Weekday, // day of week
RelativeEveryNMonths = 2 // every N months
}
Yearly

ReportScheduleInfo newSchedule = new ReportScheduleInfoYearly ()
{
// include basic options
// optional end date, optional intraday recurrence
// specific or relative day pattern
YearlyPattern = ReportSchedulelInfo.YearlyPatternType.SpecificDayOfYear,

// specific: Month/Day of every year
SpecificMonthOfYear = 3, // month of the year
SpecificDayOfMonth = 15, // day of the month

// relative: the Xth day-of-week for month N
RelativeWeekOfMonth = ReportSchedulelInfo.WeekOfMonthType.last, // week of month

RelativeDayOfWleek = ReportSchedulelInfo.DayOfWeekType.Friday, // day of week
RelativeMonthOfYear = 3 // month N

}

Email job
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newSchedule.SendReportInEmail = true; // enable email
newSchedule.EmailSubject = "Subject Text"; // email subject
newSchedule.EmailBody = "Hello World!"; // email body
newSchedule.EmailToList.Add ("email@company.com"); // to addresses
// newSchedule.EmailCCList.Add () ; // cc addresses
// newSchedule.EmailBccList.Add () ; // bcc addresses
Batch email

// batch addresses entity (must be in the batch report)
Entity batchAddresses = report.Entities.GetEntity ("entityName");

newSchedule. IsBatchReport = true; // enable batch
newSchedule.BatchEmailToList.Add ("supervisor@example.com") ; // summary recipients

// newSchedule.BatchEmailCcList.Add () ; // summary cc recipients
newSchedule.BatchEntity = batchAddresses.Name; // email address object
newSchedule.BatchField = batchAddresses.GetColumn ("Email") .Name; // email address field
newSchedule. IncludeReportAttachment = true; // include the report

Access existing schedule by job id

ReportScheduleInfo schedule = api.ReportScheduler.GetReportScheduleInfoByJobId ("jobId") ;
Update an existing schedule

api.ReportScheduler.UpdateExistingSchedule (newSchedule, "jobIdToUpdate");

Delete an existing schedule

api.ReportScheduler.DeleteSchedulerJob ("jobIdToDelete") ;

Managing Files and Folders

Initialize the manager class for the type of folder mgmt in use

// File System

ReportMgmtFileSystem manager = new ReportMgmtFileSystem (api.PagelInfo);

// Database

ReportMgmtMethod manager = new ReportMgmtMethod (api.PageInfo);

// Cloud drive

ReportMgmtCloud manager = new ReportMgmtCloud (api.Pagelnfo);

View the full reports tree

XmlDocument tree = new XmlDocument () { InnerXml = manager.GetReportListXml () };
View themes list by type

List<string> evThemes = manager.GetThemeList (ReportTheme.ReportThemeType.ExpressView.ToString()) ;

Get a specific theme (class depends on theme type)

ExpressViewTheme evTheme = (ExpressViewTheme)ReportTheme.GetTheme (
api.PageInfo, ReportTheme.ReportThemeType.ExpressView, "themeName") ;

View list of templates

List<string> templates = manager.GetTemplatelist () ;
Add a new folder

manager .AddFolder ("parentFolder", "newFolderName");
Move or rename a folder

manager.RenameFolder ("oldPath", "newPath");

Move or rename a report

manager.RenameReport ("oldPath", "newPath");
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Duplicate an existing report
api.ReportObjectFactory.Copy ("reportName", "newName");
Sawe a new report to disk

api.ReportObjectFactory.Copy (report, "reportName", null);

Introduction to REST

Many customers use the Exago API in order to provide procedural access. However, not everyone who embeds Exago
uses a .NET-based environment. For those people, the REST APl is the solution. REST web senices are a way to
provide access to API functions for any client capable of passing HTTP requests over a network.

Installing REST

To install REST, run the Exago Installer, then select the Exago Web Senice APL.

Click this button to install the

:‘,Exago Exago Web Service API

‘ “API

Choose a file path, IIS website, and a virtual path for the web senice. The installer should automatically create an
application in lIS for the web senice.

Set the application pool in lIS. Then grant it Full Control permissions to the web senice Config directory. See
Configuring IIS for Exago for detailed instructions.

In the Web Senice directory, edit appSettings.config and add the key ExagoRest with value True, to enable REST:
<add key="ExagoREST" value="True" />

Then, in the Config sub-directory, edit WWebReportsApi.xml and set the <apppath> to the file path of your main Exago
installation (the host application, not the web senice). (See Configuring Web Services for more info about the config
file).

Restart your web senver and you should be ready to test your installation. See Authentication for options for password-
protecting your web senice.

See Starting a REST Session to get started using the REST API.

The API

This is the documentation for the Exago REST API. This information will always reflect the latest available Exago version.
Changes are made periodically to the API. For details, please refer to the REST Updates.

The APl is a JSON API. For more information, see Using JSON.

Endpoints are documented with the HTTP request type and a URI sub-path:
POST /rest/sessions

Prepend the URL path to your web senice to get the full endpoint URL:
http://{myapp}/{exago web service}/rest/sessions

Curly braces, {}, are values that you must supply:

GET /rest/roles/{Id}

Usually the value to supply is found in JSON given by a request to the base endpoint. For example, to retrieve a particular
Role by its "Id", first run GET /rest/roles to see the roles available to you:
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"Id": "Admin"

"Id": "User"
]
Then to see detailed data on a Role, run GET /rest/roles/{ld} where {Id} is the value of its "Id" property (case sensitive):
GET /rest/roles/Admin

Some methods may accept optional URL parameters. Append any url parameters to the end of the endpoint URL using
the following format:

/rest/{endpoint}?{paraml }={valuel}&{param2}={value2}&{param3}={value3}
For all endpoints except /rest/sessions, you must append the session Id as a url parameter to the end of the URL:
VERB /rest/{endpoint}?sid={sid}

For more information, see Starting a REST Session.

The examples in this documentation use cURL ("cur"), which is a command-line tool for transferring data using various
protocols. Curl is compatible with Windows or Linux, and can be downloaded from . Ifcuris
installed on your machine, you can copy-and-paste the examples into a command line, replacing any item in {braces}
with your local variables, in order to test them out for yourself.

If you're using Google Chrome, we recommend the excellent Advanced Rest Client application for testing, available
from

Long examples may be broken into multiple lines in order to improve readability. The caret symbol (") tells the command
line to ignore the following linebreak. On Linux, replace the caret with a backslash (\).

curl http://{webservice}/rest/settings?sid={sid} *

noA

-H "Accept: application/json

noA

-H "Content-Type: application/json
-H "Authorization: Basic Og==" "
-X PATCH *

-d "{'ShowExpressReports':false}"

In some cases, the data package will be too long to comfortably fit into the command line. Instead, put the data into a
text file, and then supply the file path in the -d argument, prepending it with an @ sign:

-d QC:\\json\\requests\\textfile.txt

Absolute or relative paths are acceptable. On Windows, folder path delimiters are given by a double backslash: \\

Authentication

The REST API requires authorization to be accessed. To make an authorized request, the authorization header must be
supplied. There are two different authorization methods depending on your needs. Both rely on the usemame ("User ID")
and password found within the Exago configuration file currently being accessed.

Basic Authorization
When using basic authorization, the authorization header is constructed as follows:

1. The usemame and password are combined into a string "usemame:password".
2. The resulting string literal is encoded using Base64.
3. "Basic" and a space are placed before the encoded string.

For example, if the usemame is "Brian" and the password is "open sesame" then the authorization header would be:

Authorization: Basic QWxhZGRpbjpvcGVUIHN1c2FtzZQ==

The password is sent in clear text with each request. If this is a concem, the REST API should be deployed in an SSL
environment or the more secure ExagoKey authorization should be used.

A configuration with a blank User ID and password can be accessed using the following authorization header:
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Authorization: Basic Og==

ExagoKey Authorization

ExagoKey authorization uses the HMAC-SHA256 algorithm for authorization. When using ExagoKey authorization, the
authorization header is constructed as follows:

1. The string to sign is UTF-8 encoded, then signed with the UTF-8 encoded password using the HMAC-SHA256
algorithm.

2. The resulting signature is then encoded using Base64.

3. The usemame and a colon is put before the encoded signature.

4. "ExagoKey" and a space are placed before the username:encoded string literal.

For example, if the usemame is "Brian” and the password is "open sesame” then depending on the request the
authorization header might be something like:

Authorization: ExagoKey Brian:6HZES5tCWjsjbJY+VXQg3UzX1K/jeoGhbm25YDXiHWAE=

Using ExagoKey does not send the password with each request, making it more secure than Basic Authorization. To
ensure greater security the REST API should be deployed in an SSL environment.

ExagoKey String

The ExagoKey string that is to be signed is constructed using the following information from the request, in the following
order, with "\n" after each item (including the last one).

1. The HTTP Method, must be in uppercase.

2. The absolute request path, up to but not including the query string if one should exist. For example, if the request
is to "http://mysenver.com/exago/rest/sessions?config=myconfig" the absolute request path would be
"/exago/rest/sessions".

. The contents of the Content-Length header.

. The contents of the Content-Type header, or a string of zero length if no header exists.

The contents of the Content-MD5 header, or a string of zero length if no header exists.

The session ID, or a string of zero length if no session ID exists.

The contents of the XExago-Date header, or the contents of the Date header if the XExago-Date header does not

exist, or a string of zero length if neither header exists.

N o AW

NOTE. If a date is supplied, the REST API will reject any request that is older than 15 minutes from the supplied date.
The date supplied is in GMT (UTC).

Request Format

The REST API uses JSON. It will not accept data in any other format. In the case of an error, it may retum plain text, but
this is not session data. You must set the following headers on all requests:

o "Content-Type: application/json"
e "Accept: application/json"
o "Authorization: {type} {authstring}"

Most of the examples in this documentation omit the headers in order to improve readability; however they are required for
all requests.

Response Format

Successful requests retum HTTP status codes in the 200 range. WWhen you create a resource with POST, the API returns
the resource in the response body:

Status: 201 Created
Location: /{webservice}/rest/Entities/Employees

{

"Id": "Employees",
"Name" : "Employees",
"Schema" : "dbo",
"CategoryName": "",
"DataName" : "Employees",
"DataSourceId": "O0",
"DataType": "Table",
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You may get a plain text response in the case of errors or bad requests. The content will not contain any session data.
Responses have one of the following status codes:
200

The request was completed successfully. The document in the body, if any, is a representation of some resource. This
code is usually retumed for a successful GET request.

201

The request was completed successfully. A new resource has been created at the URL specified in the Location header
of the response. The document in the body, if any, is a representation of the resource created. This code is usually
retumed for a successful POST request.

204

The request was completed successfully. There is no content in the body. This code is usually retumed for successful
PATCH, PUT, and DELETE requests.

400

The request was bad on the client side. The document in the body, if any, is emor data describing the problem. This is
usually the result of using an invalid method type.

401

The request wasn't authorized to access the resource. The document in the body, if any, is error data describing the
problem.

404

The requested resource was not found. The document in the body, if any, is emror data describing the problem. Often this
is the result of a malformed URL request string.

409

The request caused a conflict between two resources. The document in the body, if any, is error data describing the
problem.

500

There was a problem on the sener side. The document in the body, if any, is error data describing the problem. Often this
is the result of a malformed JSON request package.

Request Data

The API retums and accepts JSON values, which can be strings, numbers, objects, arrays, true, false, or null. See
Using JSON for more information.

Each endpoint uses a unique JSON object for input and output of variables. The JSON is documented with each resource
in a table:

Name Type Writeable Description

Each row represents a property. The Name field is the name of the property. The Type field indicates what type of data it
accepts.

The Writeable field indicates whether this property can be written:

e no - this property is read-only

yes - this property can be written

yes ("value") - this property can be written; its default value is in parentheses

e required - this property must be written; it cannot be null

¢ required-create - this property must be written for all POST calls; it is read-only for all other calls

The Description field is any relevant information about the property.

Id Values

Most resources are identified by an "Id" property, which is an integer or string. The Id must be unique among the set of
resources. If you are permitted write-access to the Id, awid conflicting names.

Enumerations

Some properties can only accept one of a set of string or integer values (or sometimes null).
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Properties which accept enumerated values are indicated as having an "enum" type. The description field in its JSON
representation will link to the list of acceptable values, which can usually be represented by their string or equivalent
integer value. For example:

Name Type Writeable Description
DataType enum yes Parameter Type

Properties which accept constant string values are indicated as having an "const" type. The description field in its JSON
representation will link to the list of acceptable string values. For example:

Name Type Writeable Description
JoinType const yes Join Type

This Documentation

This documentation is broken down by section according to the use cases for different API elements. Usually a section
will represent a single endpoint and its use cases. To find out how to do something using the REST AP, first browse to
the relevant section for the element you want to use. Then check the table of contents for what actions you want to take;
Or read from top to bottom to gain a fuller understanding of the resource.

Check out Starting a REST Session to get started!

Using JSON

The Exago REST APl is JSSON-based. Data sent to the APl methods is formatted in JSON, and the methods return JSON
formatted response objects. In order to use the REST API you need to convert your data to, and from JSON.

What is JSON?

JSON is a data-interchange format that is designed to be text-based, and easy to read and parse. JSON objects
are formatted using the following rules:

1. Objects contain a collection of properties in "key": "value" format. Braces {} enclose objects.

2. Keys are strings, which are enclosed by single- (') or double-quotes (" ). Each key has a value, indicated by a
colon (:). Properties are separated by commas (,).

. Properties can accept sets of values using arrays, enclosed by brackets []. Values are separated by commas (,).

. Values can be strings, numbers, arrays, objects, true, false, or null.

5. The order of properties within an object doesn't matter.

NG

Example:

{

"users": [
{
"id": "358",
"username": "alex224",
"admin": true,

}
Note. Ellipses (...) indicate that one or more properties or objects have been omitted for clarity.

Using JSON with Code

JSON data usually has to be converted into a format that your code can understand. Most modemn programming
languages have JSON compatible libraries, if they are not built into the language.

To convert JSON strings into objects:

JavaScript (see at MDN)
var json obj = JSON.parse('{"user":{"id":"358"}}");
Python 3 (see at Pydoc)

json obj = json.loads('{"user":{"id":"358"}}")
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Using JSON
JSON Object Documentation

Although JSON objects can be formatted in a variety of ways, each endpoint requires an object with a specific set of
properties. The required format can be viewed in the documentation for each endpoint. Some properties are mandatory;
some are read-only; some are create-only, which means that they are required for POST calls, but read-only for other call
types; and some are optional. Accessing certain resources in an un-authorized state may only retumn a subset of data; in
general we recommend that all REST calls be authorized.

For example, the documentation for the JSON object above might read like the following:

Name Type Writeable Description

users 3:); of yes List of users belonging to the session
User JSSON

Name Type Writeable Description

id integer no This user's unique Id

username string required This user's login key

admin boolean  yes (false) Whether this user has admin privileges

Note. Read (-only) permissions indicate that the property cannot be edited with PATCH or PUT. This does not
indicate whether a DELETE call can be used on the object.

Using the API with cURL

Throughout the REST documentation there are examples which use cURL, a free command-line tool for using various
protocols. Download cURL at: . If you're using Google Chrome, the

browser extension is an excellent alterative. We recommend using either program to experiment with the
API and test your method calls.

Disclaimer: We cannot provide support for any third-party tools such as cURL or Advanced REST Client.

API calls using cURL require the following at a bare minimum: Three headers, "Accept: application/json", "Content-Type:
application/json", and your authorization header; The JSON data, which should be empty if the endpoint expects no data;
And the "verb" e.g. POST, GET, etc.

All cURL calls are formatted like the following:

curl http://{webservice}/rest/{endpoint}?sid={sid}&{paraml}={valuel}&{param2}={value2} *
-d "{json}" *

-H "Accept: application/json" *

-H "Content-Type: application/json" *

-H "Authorization: {type} {authstring}" *

-X {verb}

Note. Replace text in {braces} with the applicable data for your environment, method, and JSON. End-ofine carets ("
terminate each line to improve readability, but are not necessary.

For example, a new session call is formatted like the following:

curl http://{webservice}/rest/sessions *
_d nnooA

-H "Accept: application/json" *

-H "Content-Type: application/json" *
-H "Authorization: Basic Og==" "

-X POST

For an un-authenticated installation, you could copy and paste this example into a command line, replacing {websenice
path} with the path to your web senice, in order to test whether REST is working.

If it succeeds, it should retum data similar to the following:

{"AppUrl": "ExagoHome.aspx?d={appUrl}", "Id":"{sid}", "Page": "ExagoHome", "ApiAction":"Default", "Export
J ‘ »

Note that all the data was retumed on a single line. For improved readability, copy and paste this into a "pretty-printer"
(there are many free online solutions).
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"AppUrl": "ExagoHome.aspx?d={appUrl}",
"Id": "{sid}",
"Page": "ExagoHome",
"ApiAction": "Default",
"ExportType": null,
"ShowTabs": true,
"ShowErrorDetail": true,
"ReportSettings": {
"Id": null,
"ReportPath": null,
"SortsResource": null,
"FilterItems": null

To pass JSON with cURL, either insert it inline:

A

curl http://{webservice}/rest/sessions
-d "{'ReportSettings’ :{'ReportPath': 'Test\\TestReport'}}" ~
-H "Accept: application/json" *
-H "Content-Type: application/json" *
-H "Authorization: Basic Og==" "
-X POST

Or reference a text file containing the JSON object:

~

curl http://{webservice}/rest/sessions
-d @json.txt »
-H "Accept: application/json

noA

noA

-H "Content-Type: application/json
-H "Authorization: Basic Og==" "
-X POST

json.txt

"{'ReportSettings':{'ReportPath':'Test\\TestReport'}}"

List of REST Endpoints

The following REST endpoint paths are available. All calls require the following headers:

Content-Type: application/json
Accept: application/json
Authorization: {type} {authstring}

Irest/Sessions

e POST
o GET

Irest/Sessions/{sid}

o GET
o PATCH
o DELETE

All following calls require URL parameter: sid={sid}
Example
GET /rest/Settings?sid={sid}

Irest/Settings

o GET
e PATCH

Irest/Parameters

e POST
o GET
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Irest/Parameters/{ld}

o GET
o PATCH
o DELETE

Irest/Roles

o POST
o GET

Irest/Roles/{Id}

o GET
e PATCH

Irest/Roles/{ld}/Settings

o GET
e PATCH

Irest/Roles/{Id}/Folders

o GET
e PATCH

Irest/Roles/{ld}/Entities

o GET
e PATCH

Irest/Roles/{ld}/DataObjectRows

o GET
o PATCH

Irest/Folders/{Name}

e POST
o DELETE

Irest/Folders’'Rename

e POST
Irest/Reports/List

e GET
Irest/Reports/Execute/{Type}

e POST
Irest/DataSources

o GET
Irest/DataSources/{ld}

e POST
o GET
e PATCH

[rest/Entities

o POST
o GET

Irest/Entities/{ld}

o GET
e PATCH
e DELETE

Irest/Entities/{Id}/Fields
o GET

Irest/Entities/{Id}/Fields/{Field Id}

Tech Guide

159 of 168



Executing Reports with the API

o GET
o PATCH

Irest/Joins

e POST
o GET

Irest/Joins/{Id}

o GET
o PATCH
o DELETE

[rest/Functions

o POST
o GET

Irest/Functions/{Id}

o GET
e PATCH
e DELETE

Irest/ServerEvents
o GET
Irest/ServerEvents/{Id}
o GET
e DELETE

Executing Reports with the API

There are two different ways to use the Exago APIs to perform report execution. This guide discusses the main
differences and provides examples for both types in each API.

API Action is the most comprehensive way to run executions, and supports all types of reports. This is the only way to
run composite reports such as Dashboards and Chained Reports. This method launches an Exago session into the
browser via URL, and thus usually requires the use of an iFrame. This also means that all interactive Report Viewer or
ExpressView (v2016.3+) features are supported.

GetExecute executes reports on the back-end and retums bare HTML, JSON, CSV, or binary data. This only supports
simple report types, Advanced, Express, and CrossTab Reports. Using this method you do not have to launch any visible
instance of Exago for the user, and can simply use it as a calculation engine.

Note. GetExecute was previously referred to as Direct Execution.

Overview
Supported Report NET Supported SOAP REST Supported
Launch Method Types butput Types Supported Output Types
Output Types
Redirect browser . ) .
. Interactive Report Viewer, Dashboard Viewer,
API Action frame to Exago All types . . ’ ’
session URL ExpressView designer, or PDF, RTF, Excel, CSV
Data retumed direct] Advanced, Express, HTML, CSV, HTML, CSV, HTML, CSV,
GetExecute to calling method y Crosstab reports, PDF, RTF, Excel, PDF, RTF, PDF, RTF, Excel,
9 ExpressViews JSON Excel JSON

API Action

API sessions in Exago have a property called action type, which determines what part of Exago should be launched when
the session is opened. Action types include executing a report, loading a report into the editor, loading a report into the
scheduler, opening a section of the Ul, etc.

Note. API Action is also referred to as GetUriParamString, because this is the general term for the methods which
retumn the session redirect URL.

To tell the session to execute a report, set the action type to ExecuteReport.
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Actions which load reports, such as Execute or Edit, work on the active report object. This is another property that must
be set. This is done differently for each API: details are in the included examples.

NOTE. For security reasons, always set the action type and the active report explicitly. Although setting an active
report defaults to execute, if a report fails to load and an action has not been specified, Exago will launch into the full
Ul. This could cause users to have unintended levels of access.

Once you'\e finished setting the session variables, call GetUrlParamString(). This finalizes the session and creates a
single-use URL string. This is done differently for each API; details are in the included examples. The URL is used to
direct a browser window or iFrame to an Exago instance where the specified action takes place. The user can then
interact with the report like normal.

See the following sections for examples. Variable names and arguments are placeholders.
NET

First create an API session and load a report object.

// a .net api object is a specific session; methods act on that session
WebReports.Api.Api netApi = new WebReports.Api.Api (appPath);

Report myReport = (Report)netApi.ReportObjectFactory.LoadFromRepository (reportPath) ;
Set the desired output type.

myReport .ExportType = wrExportType.Html;

Then sawe the report object back to the API.
netApi.ReportObjectFactory.SaveToApi (myReport) ;

Set the API action to execute.

netApi.Action = wrApiAction.ExecuteReport;

Finally, call GetUrParamString to get the session URL.

// note: this terminates the session
string url = netApi.GetUrlParamString (homePage) ;

REST

When using the REST AP, the initialization call creates a session ID string, which is a required URL parameter in all
subsequent method calls. Note that the session URL is generated immediately, and altered dynamically as modifications
are made to the session.

To use REST, create the session and pass the session variables. Take note of the sessionld and UrlParamString.
POST /sessions

Payload:

"Page": homePage,

"ApiAction": "ExecuteReport",
"ExportType": "Html",
"ReportSettings":

{
"ReportPath": reportPath
}
}

Response (some params omitted):
{
"sid": sessionId,

"AppUrl": urlParamString
}

SOAP

When using the SOAP API, the initialization call creates a session ID string, which is a required parameter in all
subsequent method calls.
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First create an API object and initialize an API session.

// a soap api object is not a specific session; it's an accessor for the methods
WebServiceApi.Api soapApi = new WebServiceApi.Api();

// initialize a session and save the id to memory

string sessionId = soapApi.InitializeApi();

Set the active report.

// all methods require the session id parameter
soapApi.ReportObject Activate (sessionld, reportPath);

Set the API action to execute.
soapApi.SetAction (sessionld, (int)wrApiAction.ExecuteReport, null);
Finally, call GetUrlParamString to get the session URL.

string url = soapApi.GetUrlParamString (sessionId);

GetExecute

There are four provided GetExecute methods. Each retum a different data representation of the report. Not every API
supports every data type; see the Overview for details.

o GetExecuteHtml Typically used for web viewing

GetExecuteCsv Plain-text format readable by spreadsheet applications

o GetExecuteData Byte array of binary data

o GetExecuteJSON (v2076.3+) Typically used for asynchronous client-server communication

Since GetExecute does not require loading the Exago Ul, there is no need to call GetUrlParamString.

See the following sections for examples. Variable names and arguments are placeholders.

NET

First create an API session and load a report object.

// a .net api object is a specific session; methods act on that session
WebReports.Api.Api netApi = new WebReports.Api.Api (appPath) ;
Report myReport = (Report)netApi.ReportObjectFactory.LoadFromRepository (reportPath) ;

Then call the appropriate GetExecute method for the desired data type.

string reportHtml = myReport.GetExecuteHtml () ;

REST

When using the REST API, the initialization call creates a session ID string, which is a required URL parameter in all
subsequent method calls. Note that the session URL is generated immediately, and altered dynamically as modifications
are made to the session.

First create an API session. Take note of the session ID.
POST /sessions

Response (some params omitted):

{

"Id": sessionId

}

Then execute the selected report. Supported types are HTML, CSV, PDF, RTF, Excel, JSON.
POST /reports/execute/{type}?sid="sid"

Payload:
{

"ReportPath": reportPath
}
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Response (some params omitted):

{

"ExecuteData": rawReportData

SOAP

When using the SOAP API, the initialization call creates a session ID string, which is a required parameter in all
subsequent method calls.

First create an API object and initialize an API session.

// a soap api object is not a specific session; it's an accessor for the methods
WebServiceApi.Api soapApi = new WebServiceApi.Api();

// initialize a session and save the id to memory

string sessionlId = soapApi.InitializeApi();

Set the active report.

// all methods require the session id parameter
soapApi.ReportObject Activate (sessionld, reportPath);

Then call the appropriate Report_GetExecute method for the desired data type. Supported methods are
Report_GetExecuteHtml and Report_GetExecuteData.

string reportHtml = soapApi.Report GetExecuteHtml (sessionId);

JavaScript API

The Exago JavaScript "JS" API allows Exago functionality to be embedded directly into HTML div containers.

Divs can inherit code and styles from the host application. Since CSS cascades down to Exago, as well as up to the
parent app, this can allow you to maintain a single base of styles, rather than separate ones for the host app and for
Exago. And the Exago DOM is accessible from the host application, so custom scripting is possible without being
limited to Action Events.

Background

The JS API implements asynchronous calls to Exago functionality in the client browser. Besides the advantages of being
able to embed in divs and interact programmatically, the API also allows for multiple calls to happen without needing to
generate a new session for each one. As sessions are created only once per page load, this can increase the feeling of
responsiveness in the host application.

Because the JS API runs on the client-side, it is not standalone. You are still required to generate session objects with
either the .NET or REST APIs. Session objects must include any relevant user permissions and configuration
settings.

A parameter called the ApiKey encodes the session object in a string, which is passed from the sener-side API to the JS
API. The JS API then initializes a JS API object, which is analogous to an Exago user session.

NOTE: JS API objects are static and single-use. They cannot persist between page loads, and you cannot have multiple
JS API objects active on the same page.

The JS API object provides a set of functions that are used to implement elements of Exago functionality.

Setup and Configuration

These steps describe how to configure your environment to use the JS API, as well as how to implement it in an
application.

Create the Session

First you need to use the .NET or REST API to set up security and permissions for the session. Make all your
configuration changes here, as these settings cannot be changed once the JS API object is loaded.

Set the WebAppBaseUr property to the virtual directory where Exago Bl is installed:

.NET
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api.SetupData.WebAppBaseUrl = "http://server/Exago/";

REST
Do one of the following:
o PATCH /Rest/Settings?sid={sid}, Payload:
{ "WebReportsBaseUrl" : "http://server/Exago" }
* Add to the web senice config file ({(WebSenice}/Config/\WWebReportsApi.xml):

<webreportsbaseurl>http://server/Exago/</webreportsbaseurl>

The JS API has no concept of an Active Report or an AP/ Action, so do not set these as they will have no effect. The
action and report are specified by the individual JS function calls.

NOTE: A side-effect of this is that you cannot make per-session report changes in memory, since the JS API function
can only act on saved reports. You will need to save any changes to disk instead.

When the session is ready, get the ApiKey. This encodes the session settings to pass to the JS API.

.NET

return api.GetApiKey() ;

REST
GET "Rest/Sessions/{sid}", then get the ApiKey property from the response object:
{

"ApiKey": "encodedAlphanumericApiKey"
}

Example

// REST example using jQuery
$.ajax ({
method: "POST",
url: "http://localhost/webservice/rest/sessions",
dataType: "json",
contentType: "application/json; charset=utf-8",
headers: { "Authorization": "Basic Og==" },
success: function(data) {
LoadJsApi (data.ApiKey) ;
}
1

NOTE: This is NOT the UParamString / AppUrl.

JS API Object

Load the JS API library into the host web application via a script tag:
<script src="http://server/Exago/WrScriptResource.axd?s=ExagoApi"></script>

NOTE: wrScriptResource.axd is not a file on the file system - it is a virtual file that contains the necessary scripts
toload the API. "http://server/Exago" is the URL to the virtual path of your Exago web application.

Using the ApiKey, initialize a JS API object.
var api = new ExagoApi (ExagoBaseURL, ApiKey, onLoadCallback) ;

e ExagoBaseURL - URL to the installation of Exago Bl
o ApiKey - key generated when the session was created
o onlLoadCallback - function to execute once the JS API has been fully loaded and is ready for use

NOTE: ApiKeys are one-use. Multiple instances are not supported nor necessary. Functions can be called against the
object for the duration of the session.

Functions
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The following functions are available for loading and managing Exago functionality.

NOTE: Functions can only be used once the JS APl is fully loaded. Wait for the onLoadCallback to indicate that the API
is ready.

LoadFullUl(container)
Load the full User Interface in a div.

Parameter Description

container Div container to place the full Ul into

NOTE: The Full Ul being loaded will block almost all other actions, so while the Full Ul is displayed on screen, the host
application cannot perform any other actions such as executing reports or creating new reports.

ExecuteReport(container, exportType, reportPath, [udf], [successCallback], [errorCallback])

Execute a report to a specific output type in a defined container.

Parameter Description

container Div container to place the executed report into

exportType html|pdficsvexcel|rtf

spotpa e e

udf Optional: Report UDF information for use with folder management
successCallback Optional: Callback to execute when request has been completed
erorCallback Optional: Callback to execute in the event an error occurs

ExecuteStaticReport(exportType, reportPath, udf, successCallback, [errorCallback])

Execute a report, and retum its output to the successCallback function. Report is not interactive.

Parameter Description

exportType html|pdficsiexcel|rtfljson

worn RS

udf Report UDF information for use with folder management
successCallback Callback to execute when execution request retums
erorCallback Optional: Callback to execute in the event an error occurs

ScheduleReportWizard(container, reportPath, [udf], [errorCallback])

Open the schedule report wizard for a report.

Parameter Description
container Div container to place the scheduled report wizard into
Relative path to report to schedule
reportPath Example: "MyFolder\\MyReport"
udf Optional: Report UDF information for use with folder management
ermorCallback Optional: Callback to execute when the scheduler is not enabled and the

schedule wizard cannot be started

ScheduleReportManager(container, [errorCallback])
Open the schedule report manager.

Parameter Description
container Div container to place the scheduled report manager into

Optional: Callback to execute when the scheduler is not enabled and the
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errorCallback schedule manager cannot be started

LoadReportTree(successCallback, [errorCallback])

Load the report tree as JSON, retumed to the successCallback method.

Parameter Description
successCallback Callback to execute once the report tree has been loaded
enmorCallback Optional: Callback to execute in the event an error occurs (the error text is

passed as a parameter)

EditReport(container, reportPath, [udf], [errorCallback])

Load the report designer for a report.

Parameter Description
container Div container to place the report designer into
Relative path to report to edit
reportPath Example: "MyFolder\\MyReport"
udf Optional: Report UDF information for use with folder management
errorCallback Optional: Callback to execute if the report fails to load

NewReport(container, reportType)

Load the report designer for a new report.

Parameter Description
container Div container to place the report designer into
reportType advanced|express|dashboard|chained|expressview

Dispose ContainerContent(container)

Disposes the contents of a container and resets the system state to be aware of what containers are open.

Parameter Description

container Div container to dispose

IsAllowedReportType(reportType)

Returns whether or not a specified report type is allowed for the session.

Parameter Description

reportType advanced|express|dashboard|chained|expressview

GetAllowedReportTypes()

Retums an array of the report types allowed for this session.

Example

function RunReportJS() {
var container = document.getElementById ("ExagoDiv") ;
api.ExecuteReport (container, "html", "Examples\\ClientReport");

}
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NOTE: Container divs must be empty or disposed before loading. Additionally, you should specify size and position
constraints for each div.

div#ExagoDiv {
width: 1200px;
height: 600px;
position: relative;

}

Disposing Containers

It is important to properly dispose of containers when they are finished being used by explicitly calling
the DisposeContainerContent(container) method.

Optionally, an OnDisposeContainer callback can be defined that will execute when a container has been disposed either
implicitly or explicitly. This allows the host application to safely reset the container to whatever state necessary, or
remove the container from the page entirely. When a user encounters an error that prevents the requested action, ie.
ExecuteReport(...), the container will auto-dispose and execute the OnDisposeContainer callback if one is defined.

Example

api.OnDisposeContainer = function (container) {
container.parentElement.removeChild (container) ;
i

Application Logging
An administrator can configure how Exago handles logging in order to change or extend functionality.

Logging Defaults

By default Exago saves a log file called ‘WebReportsLog.txt’ to the application’s Temp path (specified in
‘WebReports.xml’). The logger maintains a lock on the file for the lifespan of the application. The log file cannot be edited
or deleted without restarting the application or releasing the lock.

There are three configurable verbosity levels for the logger. By default, Exago runs at the Info lewel.
Use the following administrative setting to set the log level or disable logging:
( Other Settings ) Write Log File

e Error — Only logs emmor messages in the application.
o Info — Logs SQL statements, number of rows retumed from each statement, and report execution information, as
well as all Error. Report execution information includes the following:

Execution start
Start time, userld, companyld, full report name, filter summary.
Execution end

End time, runtime, userld, companyld, full report name.

e Debug — Logs a variety of debugging information that can be used to time specific parts of the app, as well as all
Info and Error

log4net

The logger can load its configuration from a file and continually watch the file for changes. A config file can be used to
lock or unlock the log file, change the log file name and path, as well as customize and extend logging capability.

Note: A custom log configuration file will override the application's configuration settings.

To use a custom log configuration, create a file called ‘log4net.config’ in the Config directory of the Exago application. The
following shows a sample config file:
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<?xml version="1.0" encoding="UTF-8"?>
<log4net>
<appender name="RollingFileAppender" type="log4net.Appender.RollingFileAppender">
<file value="C:\Exago\Temp\WebReportsLog.txt" />
<encoding value="utf-8" />
<appendToFile value="true" />
<rollingStyle value="Size" />
<maxSizeRollBackups value="10" />
<maximumFileSize value="1MB" />
<staticLogFileName value="true" />
<lockingModel type="log4net.Appender.FileAppender+ExclusiveLock" />
<layout type="log4net.Layout.PatternLayout'>
<conversionPattern value="%date %-5level [$property{SessionId}] %message$newline" />
</layout>
</appender>
<!-- Setup the root category, add the appenders and set the default level -->
<root>
<level value="INFO" />
<appender-ref ref="RollingFileAppender" />
</root>
</log4net>

For more information and extensibility, see: . See the following examples for some simple modifications:

Change Lodfile Location

<file value="Path\To\Log.txt" />

Specifies the directory and filename for the log file.

Change Logging Level

<level value="INFO" />

Specifies the Exago logging level: ERROR, INFO, or DEBUG.

Unlock the Log File

<lockingModel type="log4net.Appender.FileAppender+ExclusiveLock" />

Configures the locking model in use for the log file. To temporarily disable the write lock, you can use:
log4net. Appender. FileAppender+MinimalLock

NOTE. This will result in a performance reduction until it is reset.
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